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Read This First

Manuals for This Printer

For particular functions, see the relevant parts of the manual.

% Setup Guide
Provides information about printer setup and options.

% Maintenance Guide
Provides information about paper, replacing supplies, and dealing with paper
jams and error messages.

% Software Guide (HTML) (this manual)
Provides basic information about installing the printer driver and software, us-
ing the printer in a network environment, and configuration and setup.
Also, provides information about configuring and monitoring printer status us-
ing software and a Web browser.

O Some functions cannot be used depending on your printer.
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Preparing for Printing

Quick Install

Windows 95/98/Me/2000/XP, Windows Server 2003, and Windows NT 4.0 users
can easily install this software using the CD-ROM provided.

Using Quick Install, the PCL printer driver and/or RPCS printer driver and Smart-
DeviceMonitor for Client is installed under network environment, and TCP/IP
port will be set.

b d | mportant
3 To install printer driver under Windows 2000/XP Professional, Windows Serv-

er 2003, and Windows NT 4.0, you must have an account that has Manage
Printers permission. Log on as an Administrator.

3 The Quick Install is not available when using this printer under USB connec-
tion. If you connect using USB, see p.53 “Installing the Printer Driver Using
USB”.

ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “ Setup.exe ” on the CD-ROM root directory.
B Select an interface language, and then click [OK].
The default interface language is English.

O click [Quick Install].
The software license agreement appears in the [License Agreement] dialog box.

B After reading the agreement, click [l accept the agreement], and then click
[Next].
B Select the printer model you want to use in the [Select Printer] dialog box.

For network connection via TCP/IP, select the printer whose IP address is dis-
played in [Connect To].

For parallel connection, select the printer whose printer port is displayed in
[Connect To].

ﬂ Click [Install].
The printer driver installation starts.

8 Click [Finish].

A message about restarting the computer may appear. Restart the computer
to complete installation.

G1307502_1.00 Copyright © 2005
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Preparing for Printing

g Click [Exit] in the first dialog box of the installer, and then take out the
CD-ROM.

3 To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

O Select a printer to whose IP address is displayed in [Connect To] to install
SmartDeviceMonitor for Client when using TCP/IP.

=l Reference

Quick Install is not available unless bidirectional communication between
the printer and computer is enabled via parallel connection. See p.73 “If Bi-
directional Communication is Disabled” for details about bidirectional com-
munication between printer and computer.
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Preparing for Printing

Confirming the Connection Method

This printer supports network and local connection.

Before installing the printer driver, check how the printer is connected. Follow the
driver installation procedure that is appropriate to the connection method.

Network Connection
This printer can be used as a Windows printing port or network printer.
Using this printer as the Windows printing port

Network connections can be established through Ethernet, IEEE 802.11b, and
IEEE 1394 (IP over 1394).

Available ports are determined based on the combination of Windows operating
system version and connection method used.

Ficioe A0 Nawl Ridos 10 Nawl
-TCRAP -TCRAIP
== PP
T standard TOPAP e~ Standard TCPAP
| J 4
Windows 95/08Me Windows 2000 Windows XP/ Windows NT 4.0
Sarver 2003 S
% Windows 95/98
Connection Method Available Ports
Ethernet/ IEEE 802.11b SmartDeviceMonitor for Client port
IEEE 1394 (IP over 1394) None
% Windows Me
Connection Method Available Ports
Ethernet/ IEEE 802.11b SmartDeviceMonitor for Client port
IEEE 1394 (IP over 1394) SmartDeviceMonitor for Client port

12



Preparing for Printing

R
°%

R
%

R
%

Windows 2000

Connection Method

Available Ports

Ethernet/ IEEE 802.11b

SmartDeviceMonitor for Client port
Standard TCP/IP
LPR port

IEEE 1394 (IP over 1394)

None

Windows XP

Connection Method

Available Ports

Ethernet/ IEEE 802.11b

SmartDeviceMonitor for Client port
Standard TCP/IP
LPR port

IEEE 1394 (IP over 1394)

SmartDeviceMonitor for Client port
Standard TCP/IP

Windows Server 2003

Connection Method

Available Ports

Ethernet/ IEEE 802.11b

SmartDeviceMonitor for Client port
Standard TCP/IP
LPR port

IEEE 1394 (IP over 1394)

SmartDeviceMonitor for Client port
Standard TCP/IP

Windows NT 4.0

Connection Method

Available Ports

Ethernet/ IEEE 802.11b

SmartDeviceMonitor for Client port
LPR port

IEEE 1394 (IP over 1394)

None

=l Reference

See the explanation of how to install the printer driver for each type of port.
For the SmartDeviceMonitor for Client port, see p.16 “Using the SmartDevice-
Monitor for Client Port”.

For the Standard TCP/IP port, see p.33 “Using the Standard TCP/IP Port”.

For the LPR port, see p.38 “Using the LPR Port”.
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Preparing for Printing

Using as a network printer

This printer can be used as the Windows network printer, the NetWare print serv-
er, or the NetWare remote printer.

Windows Sareer 2003
Windoes NT 4.0 Matans HMot#arn
Print Sanmr Prin Sarvar Flla Sarvar

¥ &8 8 8

Windows TSR ME WWindra 2000 Wlsdows XPY Winckows NT 4.0
Banvar 2000

=l Reference

See the explanation of how to install the printer driver for each type of network
printer.

For the Windows network printer, see p.43 “Using as the Windows Network
Printer”.

For the NetWare print server and remote printer, see p.50 “Using as the Net-
Ware Print Server/Remote Printer”.

Local Connection

Local connections can be established via parallel, USB, IEEE 1394 (SCSI print),
and Bluetooth connections.

Windows operating system version determines the available connection meth-
ods.

¢ Windows 95:

* Parallel connections
e Windows 98:

e Parallel connections
e Windows 98 SE/Me:

e USB, Parallel, and Bluetooth connections
e Windows 2000:

* USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections
e Windows XP:

e USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections
e Windows Server 2003:

14



Preparing for Printing

e USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections
e Windows NT 4.0:

* Parallel connections

=} Feference

See the explanation of how to install the printer driver for each method of
connection.

For the USB connection, see p.53 “Installing the Printer Driver Using USB”.
For the parallel connection, see p.59 “Printing with Parallel Connection”.

For the IEEE 1394 (SCSI print) connection, see p.64 “Installing the Printer
Driver Using IEEE 1394 (SCSI print)”.

For the Bluetooth connection, see p.68 “Printing with Bluetooth Connec-
tion”.
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Preparing for Printing

Using the SmartDeviceMonitor for Client
Port

Installing SmartDeviceMonitor for Client

b d | mportant

O To install SmartDeviceMonitor for Client under Windows 2000/XP Profession-
al, Windows Server 2003, and Windows NT 4.0, you must have an account
that has Manage Printers permission. Log on as an Administrator.

3 Install SmartDeviceMonitor for Client before installing the printer driver when
using the SmartDeviceMonitor for Client port.

I] Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [SmartDeviceMonitor for Client/Admin].
B The SmartDeviceMonitor for Client installer starts.

B Click [SmartDeviceMonitor for Client], and then click [Next >].
The SmartDeviceMonitor for Client installer starts.

ﬂ The software license agreement appears in the [License Agreement] dialog
box. After reading through its contents, click [Yes] to accept it.

B Follow the instructions on the display to install SmartDeviceMonitor for
Client.

B ciick [ok.
If you are required to restart the computer after installing SmartDeviceMonitor
for Client, restart the computer.

3 To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

16



Preparing for Printing

O SmartDeviceMonitor for Client supports the following languages: Czech,
Danish, German, English, Spanish, French, Italian, Hungarian, Dutch, Nor-
wegian, Polish, Portuguese, Finnish, Swedish, Chinese Simple and Chi-
nese Traditional.

Installing the PCL or RPCS Printer Driver (TCP/IP)

b d | mportant

3 To install this printer driver under Windows 2000/XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

ﬂ Quit all applications currently running.

Fd insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

O click [PCLRPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement], and then click [Next].

B Select the printer driver you want to use in the [Printer Program] dialog
box.

You can select several printer drivers.

ﬂ Select the printer model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

B Double-click the printer name to display the printer settings.

3 The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

ﬂ Click [Port:], and then click [Add].
[[D Click [SmartDeviceMonitor], and then click [New Port...].
@ click [TCP/IP], and then click [Search].
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A list of printers using TCP/IP appears.

[EJ Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify address], and then enter the IP address
or host name of the printer.

Under Windows 95/98/Me, you cannot add an IP address partially similar to
the one already used. For example, if “192.168.0.2” is in use, “192.168.0.2xx”
cannot be used. Similarly, if “192.168.0.20” is in use, “192.168.0.2” cannot be
used.

[B Check that the port of the selected printer is displayed in [Port:].

[I] Set a user code, if necessary.

This allows a SmartDeviceMonitor for Admin user to display and check statis-
tics about the number of sheets which each user prints. For details, see
SmartDeviceMonitor for Admin Help.

Up to 8 numeric characters can be entered. No alphabetic characters or sym-
bols are available.
iE Select the [Default Printer] check box to configure the printer as default.

0@ click [Finish].
Installation starts.

[ﬂ Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation.

=l Reference

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run. If
you still want to install the printer driver, install using [Add Printer]. See p.71
“If a Message Appears during Installation”.

Installing the PCL or RPCS Printer Driver (IPP)

b d | mportant

3 To install printer driver under Windows 2000/XP Professional, Windows Serv-
er 2003, and Windows NT 4.0, you must have an account that has Manage
Printers permission. For this, log on as an Administrators or Power Users
group member.

ﬂ Quit all applications currently running.

Fd insert the CD-ROM into the CD-ROM drive.
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The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

8 Select an interface language, and then click [OK].
The default interface language is English.

E] Click [PCL/RPCS Printer Drivers].
B The software license agreement appears in the [License Agreement] dialog

box.
After reading the agreement, click [l accept the agreement], and then click [Next].

B Select a printer driver you want to use in the [Printer Program] dialog box.
You can select several printer drivers.

ﬂ Select the printer model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

8 Double-click the printer name to display the printer settings.

3 The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

B ciick [Port:], and then click [Add].

[E] Click [SmartDeviceMonitor], and then click [New Port...].

@ click [ippy.

[EJ In the [Printer URL] box, enter “http://printer's address/printer” as the

printer's address.

If the server authentification is issued, to enable SSL( a protocol for encrypted
communication), enter “https://printer's address/printer” (Internet Explorer
5.01, or a higher version must be installed). Create the IPP port in SmartDe-
viceMonitor for Client.

(example IP address: 192.168.15.16)

http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter “http://printer's address/ipp” as the printer's address.
[B Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box
becomes the IPP port name.

[I] Click [Detailed Settings] to make necessary settings.
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For information about the settings, see SmartDeviceMonitor for Client Help.
iE Check that the port of the selected printer is displayed in [Port:].

[E Set a user code, if necessary.

This allows a SmartDeviceMonitor for Admin user to display and check the
number of sheets each user prints. For details, see SmartDeviceMonitor for
Admin Help.

Up to 8 numeric characters can be entered. No alphabetic characters or sym-
bols can be entered.

[ﬂ Select the [Default Printer] check box to configure the printer as default.

[B Click [Finish].
Installation starts.

[E] Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation.

3 To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

= Reference

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run. If
you still want to install the printer driver, use [Add Printer]. See p.71 “If a
Message Appears during Installation”.

Installing the PostScript 3 Printer Driver (Windows 95/98/Me -
TCP/IP)

ﬂ Quit all applications currently running.

B3 insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

8 Select an interface language, and then click [OK].
The default interface language is English.
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O The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B click [Next).

B Click [Local Printer], and then click [Next].
A dialog box for selecting the printer manufacturer and model name appears.

ﬂ Select the name of the printer whose driver you want to install, and then
click [Next].

B In the [Available ports:] box, click [Printer Port], and then click [Next].

ﬂ Change the printer name if you want, and then click [Next].
Select the [Yes] check box to configure the printer as default.

[[D Specify whether or not to print a test page, and then click [Finish].
[I] On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

[E] Click the icon of the printer you want to use. On the [File] menu, click
[Properties].

[B On the [Details] tab, click [Add Port...].
[I] Click [SmartDeviceMonitor] in the [Other] list, and then click [OK].

B click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.

[[ﬂ Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify address], and then enter the IP address
or host name of the printer.

You cannot add an IP address partially similar to the one already used. For
example, if “192.168.0.2” is in use, “192.168.0.2xx” cannot be used. Similarly,
if “192.168.0.20” is in use, “192.168.0.2” cannot be used.

W click [oK].

[B Check that the selected port is highlighted in [Printer to the following port],
and then click [OK].
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[D Restart the computer to complete installation.

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 95/98/Me - IPP)

I] Quit all applications currently running.

Fd insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

O The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B click [Next).

B Click [Local Printer], and then click [Next].
A dialog box for selecting the printer manufacturer and model name appears.

ﬂ Select the name of the printer whose driver you want to install, and then
click [Next].

B In the [Available ports:] box, click [Printer Port], and then click [Next].

ﬂ Change the printer name if you want, and then click [Next].
Select the [Yes] check box to configure the printer as default.

[[D Specify whether or not to print a test page, and then click [Finish].

[I] On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

[E] Click the icon of the printer you want to use. On the [File] menu, click
[Properties].
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[B On the [Details] tab, click [Add Port...].

[E] Click [SmartDeviceMonitor] in the [Other] list, and then click [OK].

B click [ippy.

[[ﬂ In the [Printer URL] box, enter “http://(printer's address)/printer” as the

printer's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Explorer
5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter “http://(printer's address)/ipp” as the printer's address.

[ﬂ Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box
becomes the IPP port name.

[EJ Click [Detailed Settings] to configure proxy server, IPP user name, and oth-
er settings. Make these settings, and then click [OK]. For details, see
Help on the CD-ROM.

3 For information about the settings, see SmartDeviceMonitor for Client
Help.

0 click [ok].

Eﬁ] Check that the selected port is highlighted in [Printer to the following port],
and then click [OK] .

Ei] Restart the computer to complete installation.

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 2000 - TCP/IP)

® @ | mportant
O Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

ﬂ Quit all applications currently running.
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B3 insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

8 Select an interface language, and then click [OK].
The default interface language is English.

O The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

A click [Next 1.

B Click [Local printer], and then click [Next >].

ﬂ Click [Add Port...].

8 Click [SmartDeviceMonitor], and then click [Next >].

ﬂ Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.

[E] Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify address], and then enter the IP address
or host name of the printer.

[i] Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

[B Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[B Click [Next >].
[I] Specify whether or not to print a test page, and then click [Next >].

iE Click [Finish].
The printer driver installation starts.

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows 2000 - IPP)

® @ | mportant
O Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.
B Select an interface language, and then click [OK].
The default interface language is English.

3 The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B click [Next >].

B Click [Local printer], and then click [Next >].

ﬂ Click [Add Port...].

8 Click [SmartDeviceMonitor], and then click [Next >].

B click prey.

[E] In the [Printer URL] box, enter “http://(printer's address)/printer” as the

printer's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Explorer
5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter “http:/(printer's address)/ipp” as the printer's address.

[i] Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the name of any existing port.
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If a name is not specified here, the address entered in the [Printer URL] box
becomes the IPP port name.

[B Click [Detailed Settings] to configure proxy server, the IPP user name and
other settings. Specify the necessary settings, and then click [OK].

For information about the settings, see SmartDeviceMonitor for Client Help.
[B Click [OK].

[E] Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

[B Change the printer name if you want, and then click [Next >].
[E Click [Next >].
[ﬂ Specify whether or not to print a test page, and then click [Next >].

[ click [Finish].
The printer driver installation starts.

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003 - TCP/IP)

b d | mportant

O Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe”on the CD-ROM root directory.
B Select an interface language, and then click [OK].
The default interface language is English.

O The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
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Add Printer Wizard starts.
B Click [Next >].
B Click [Local printer], and then click [Next >].
ﬂ Click [Create a new port:].
B Click [SmartDeviceMonitor], and then click [Next >].

ﬂ Click [TCP/IP], and then click [Search].
A list of printers using [TCP/IP] appears.

[E] Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify address], and then enter the IP address
or host name of the printer.

[i] Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

[B Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[B Click [Next >].
[I] Specify whether or not to print a test page, and then click [Next >].

B click [Finish].
The printer driver installation starts.

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003 - IPP)

b d | mportant
O Installing this printer driver requires Administrators permission. Log on using

an account that has Administrators permission.
ﬂ Quit all applications currently running.

Fd insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.
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B Select an interface language, and then click [OK].
The default interface language is English.

O The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

B Click [Next >].

B Click [Local printer], and then click [Next >].

ﬂ Click [Create a new port:].

B Click [SmartDeviceMonitor], and then click [Next >].

B click pippy.

[[D In the [Printer URL] box, enter “http://(printer's address)/printer” as the

printer's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Explorer
5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter “http://(printer's address)/ipp” as the printer's address.

[i] Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box
becomes the IPP port name.

[E] Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

B click [ok].

[I] Check that the name of the printer driver you want to install is selected,
and then click [Next >].

iE Change the name of the printer if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[E Click [Next >].
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[ﬂ Specify whether or not to print a test page, and then click [Next >].

[B Click [Finish].
The printer driver installation starts.

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows NT 4.0 -
TCP/IP)

b d | mportant
O Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

ﬂ Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

8 Select an interface language, and then click [OK].
The default interface language is English.

O The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Click [Next].
(3 click [Add Port:].
ﬂ Click [SmartDeviceMonitor], and then click [New Port...].

B click [TcPaP], and then click [Search].
A list of printers using [TCP/IP] appears.

ﬂ Select the printer you want to use, and then click [OK].
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Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify address], and then enter the IP address
or host name of the printer.

[[D Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

[i] Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[B Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

[B Restart the computer to complete installation.

3 A user code can be set after the printer driver installation . For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows NT 4.0 - IPP)

S @ | mportant

O Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.
8 Select an interface language, and then click [OK].
The default interface language is English.

O The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

A click [Next].
B Click [Add Port:].
ﬂ Click [SmartDeviceMonitor], and then click [New Port...].
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B click prr).
ﬂ In the [Printer URL] box, enter “http://(printer's address)/printer’as the
printer's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Explorer
5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter “http://(printer's address)/ipp” as the printer's address.

[[D Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box
becomes the IPP port name.

[I] Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

B ciick [ok].

[B Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

[I] Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

iE Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

[[ﬂ Restart the computer to complete installation.

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Changing the Port Settings for SmartDeviceMonitor for Client

Follow the procedure below to change the SmartDeviceMonitor for Client set-
tings, such as TCP/IP timeout, recovery/parallel printing, and printer groups.

Windows 95/98:

I] Open [Printers] window from [Start] menu.
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ﬂ In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

B Click the [Details] tab, and then click [Configure Port].
The [Port Settings] dialog box appears.

Windows 2000 / Windows NT 4.0:

ﬂ Open [Printers] window from [Start] menu.

ﬂ In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

B On the [Ports] tab, click [Configure Port].
The [Port Settings] dialog box appears.

Windows XP, Windows Server 2003:

I] On the [Start] menu, point to [Settings], and then click [Printers].

ﬂ In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

B Click the [Details] tab, and then click [Configure Port].
The [Port Settings] dialog box appears.
* For TCP/IP, timeout setting can be configured.

3 If no settings on the [Recovery/Parallel Printing] tab are available, follow
the procedure below.

@ Click [Cancel] to close the [Port Configuration:] dialog box.

@ Start SmartDeviceMonitor for Client, and then right-click the Smart-
DeviceMonitor for Client icon on the taskbar.

® Click [Extended Features Settings], and then select the [Set Recovery/Par-
allel Printing for each port] check box.

@ Click [OK] to close the [Extended Features Settings] dialog box.
* User, proxy, and timeout settings can be configured for IPP.
=l Feference

For information about these settings, see SmartDeviceMonitor for Client
Help.
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Using the Standard TCP/IP Port

Installing the PCL or RPCS Printer Driver

b d | mportant

3 To install printer driver under Windows 2000/XP Professional, and Windows
Server 2003, you must have an account that has Manage Printers permission.
Log on as an Administrators or Power Users group member.

ﬂ Quit all applications currently running.

Fd insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

O click [PCLRPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement], and then click [Next].

B Select a printer driver you want to use in the [Printer Program] dialog box.
You can select several printer drivers.

ﬂ Select the printer model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

B Double-click the printer name to display the printer settings.

3 The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

ﬂ Click [Port:], and then click [Add].

[0 click [Standard TCP/IP], and then click [New Port...

Configure the Standard TCP/IP port settings, and then see Windows Help if
[Standard TCP/IP Port] does not appear.

[I] Click [Next] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

[E] Enter the printer name or IP address in the [Printer Name or IP Address] box.
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The [Port Name] text box automatically obtains a port name. Change this name
if necessary.

When screen for Device selection appears, select “RICOH NetworkPrinter
Driver C Model”.

[B Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
The installation start dialog box reappears.

[E] Check that the port of the selected printer is displayed in [Port:].
iE Configure the default printer as necessary.

[E Click [Finish].
The printer driver installation starts.

[ﬂ Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation.

3 To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

=l Reference

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run. If
you still want to install the printer driver, use [Add Printer]. See p.71 “If a
Message Appears during Installation”.

Installing the PostScript 3 Printer Driver (Windows 2000)
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O Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.
B Select an interface language, and then click [OK].
The default interface language is English.
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O The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B click [Next >].

B Click [Local printer], and then click [Next >].

t click [Add Port...].

B click [Standard TCPAP], and then click [New Port....

g Click [Next] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

[[D Enter the printer name or IP address in the [Printer Name or IP Address] box,
and then click [Next>].

When screen for Device selection appears, select “RICOH NetworkPrinter
Driver C Model”.

[I] Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

[EJ Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

[B Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[I] Click [Next >].
iE Specify whether or not to print a test page, and then click [Next >].

0@ click [Finish].
The printer driver installation starts.

3 A user code can be set after the printer driver installation . For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003)
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O Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.
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I] Quit all applications currently running.

Fd insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

3 The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B click [Next >].

B Click [Local printer], and then click [Next >].

ﬂ Click [Create a new port:].

B Click [Standard TCP/IP] in [Create a new Port], and then click [Next].

B ciick [standard TCPAP], and then click [OK].

[E] Click [Next] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

[I] Enter the printer name or IP address in the [Printer Name or IP Address] box,
and then click [Next >].

When screen for Device selection appears, select “RICOH NetworkPrinter
Driver C Model”.

[EJ Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

[B Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

[I] Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[B Click [Next >].
[B Specify whether or not to print a test page, and then click [Next >].

W click [Finish].
The printer driver installation starts.
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O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Using the LPR Port

Installing the PCL or RPCS Printer Driver

b d | mportant

3 To install this printer driver under Windows 2000/XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

ﬂ Quit all applications currently running.

Fd insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement], and then click [Next].

E Select a printer driver you want to use in the [Printer Program] dialog box.
You can select several printer drivers.

ﬂ Select the printer model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

B Double-click the printer name to display the printer settings.

3 The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

g Click [Port:], and then click [Add].

[[TJ Click [LPR Port], and then click [New Port...].
If [LPR Port] does not appear, see Windows Help and install it.

[I] Enter the printer's IP address in the [Name or address of server providing Ipd]
box.
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[B Enter “Ip” in the [Name of printer or print queue on that server] box, and then
click [OK].

The port is added.
[B Check that the port of the selected printer is displayed in [Port:].
[E] Configure the default printer as necessary.

iE Click [Finish].
The printer driver installation starts

[E Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation.

= Reference

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run. If
you still want to install the printer driver, use [Add Printer]. See p.71 “If a
Message Appears during Installation”.

Installing the PostScript 3 Printer Driver (Windows 2000)
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O Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.
8 Select an interface language, and then click [OK].
The default interface language is English.

O The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B click [Next >].
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E Click [Local printer], and then click [Next >].
ﬂ Click [Add Port...].
8 Click [LPR Port], and then click [New Port...].

g Enter the printer's IP address in the [Name or address of server providing Ipd]
box.

[[D Enter “Ip” in the [Name of printer or print queue on that server] box, and then
click [OK].

[I] Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

[B Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[B Click [Next >].
[I] Specify whether or not to print a test page, and then click [Next >].

B click [Finish].
The printer driver installation starts.

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003)
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O Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

I] Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

40



Preparing for Printing

O The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Click [Next >].

B Click [Local Printer], and then click [Next >].

ﬂ Click [Create a new port:].

B Click [LPR Port] in [Create a new Port], and then click [Next >].

g Enter the printer's IP address in the [Name or address of server providing Ipd]
box.

[E] Enter “Ip” in the [Name of printer or print queue on that server box], and then
click [OK].

[i] Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

[B Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[B Click [Next >].
[I] Specify whether or not to print a test page, and then click [Next >].

B click [Finish].
The printer driver installation starts.

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows NT 4.0)
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O Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

ﬂ Quit all applications currently running.

Fd insert the CD-ROM into the CD-ROM drive.
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The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

8 Select an interface language, and then click [OK].
The default interface language is English.

O The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Click [Next].
(3 click [Add Port:].
ﬂ Select [LPR Port], and then click [OK].

8 Enter the printer's IP address in the [Name or address of server providing Ipd
box] box.

ﬂ Enter “Ip” in the [Name of printer or print queue on that server] box, and then
click [OK].

[[D Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

[I] Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[E] Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

[B Restart the computer to complete installation.

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Using as the Windows Network Printer

Installing the PCL or RPCS Printer Driver

To use the print server, install the printer driver by selecting “Network printer
server”, and then select the Windows 2000/XP, Windows Server 2003, or Win-
dows NT 4.0 shared printer.

This section assumes that the client has already been configured to communi-

cate with a Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 print

server. Do not begin the following procedure before the client is set up and con-

figured correctly.

S @ | mportant

3 To install printer driver under Windows 2000/XP Professional, Windows Serv-
er 2003, and Windows NT 4.0, you must have an account that has Manage
Printers permission. For this, log on as an Administrators or Power Users
group member.

O3 If you print with a print server connected to the printer using the SmartDevice-
Monitor port, Recovery Printing and Parallel Printing cannot be used from the
client.

3 If you print with a Windows XP or Windows Server 2003 print server, notifica-
tion functions of SmartDeviceMonitor may not be used with the client.

3 If you print with a Windows NT 4.0 print server, install the printer driver before
you connect the print server to the printer.
ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.
B Select an interface language, and then click [OK].
The default interface language is English.

O click [PCLRPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement], and then click [Next].

B Select a printer driver you want to use in the [Printer Program] dialog box.
You can select several printer drivers.
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ﬂ Select the [Printer Name:] check box to select the printer models you want
to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

8 Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

ﬂ Click [Port:], and then click [Add].

[[D Click [Network Printer], and then click [OK].

[I] Double-click the computer name you want to use as a print server in the
[Browse for Printer] window.

[B Select the printer you want to use, and then click [OK].
[B Check that the port of the selected printer is displayed in [Port:].

[I] Configure the user code as necessary.

For an RPCS printer driver, a user code can be set after the printer driver in-
stallation. For information about user code, see the printer driver Help.

iE Select the [Default Printer] check box to configure the printer as default.

[E Click [Finish].
The printer driver installation starts.

[ﬂ Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation.

=l Reference

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run. If
you still want to install the printer driver, use [Add Printer]. See p.71 “If a
Message Appears during Installation”.

Installing the PostScript 3 Printer Driver (Windows 95/98/Me)
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3 If you print from a print server connected to the printer using the SmartDevice-
Monitor port, the client cannot use Recovery Printing and Parallel Printing.

I] Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
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The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

8 Select an interface language, and then click [OK].
The default interface language is English.

O The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Click [Next].
E Click [Network Printer], and then click [Next].
ﬂ Click [Browse].

8 Double-click the computer name you want to use as a print server in the
[Browse for Printer] window.

ﬂ Select the printer you want to use, and then click [OK].
[[D Check the location of the selected printer is shown, and then click [Next].

[i] Change the printer name if you want, and then click [Next].
Select the [Yes] check box to configure the printer as default.

[B Specify whether or not to print a test page, and then click [Finish].
[B Restart the computer.

3 A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 2000)
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3 Installing a printer driver requires Administrators permission. Log on using an
account that has Administrators permission.

3 If you print from a print server connected to the printer using the SmartDevice-
Monitor port, the client cannot use Recovery Printing and Parallel Printing.

I] Quit all applications currently running.
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B3 insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

8 Select an interface language, and then click [OK].
The default interface language is English.

O The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

A click [Next].
B Click [Network printer], and then click [Next].
ﬂ Click [Next].

B Double-click the computer name you want to use as a print server in the
[Shared printers] window.

g Select the printer you want to use, and then click [Next].
[[D The printer driver installation starts.

[i] Click [Next>].

Select the [Yes] check box to configure the printer as default.
[El Click [Finish].

Restart the computer to complete installation.

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003)
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O Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

46



Preparing for Printing

3 If you print from a print server connected to the printer using the SmartDevice-
Monitor port, the client cannot use Recovery Printing and Parallel Printing.

3 If you print with a Windows XP or Windows Server 2003 print server, Smart-
DeviceMonitor notification functions may not be possible for the client.

ﬂ Quit all applications currently running.

Fd insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

3 The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Click [Next].
B Click [Network printer] and then click [Next].
ﬂ Click [Next].

B Double-click the computer name you want to use as a print server in the
[Shared printers] window.

ﬂ Select the printer you want to use, and then click [Next].
[[U The printer driver installation starts.

@ click [Next >].
Select the [Yes] check box to configure the printer as default.

[B Click [Finish].
Restart the computer to complete installation.

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows NT 4.0)

® @ | mportant
O Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

3 If you print from a print server connected to the printer using the SmartDevice-
Monitor port, the client cannot use Recovery Printing and Parallel Printing.

3 To print from a Windows NT 4.0 print server, install the printer driver before
you connect the print server to the printer.

ﬂ Quit all applications currently running.

B3 insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

3 The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

A click [Next].
B Click [Network printer], and then click [Next].
ﬂ Click [Next].

8 Double-click the computer name you want to use as a print server in the
[Shared printers] window.

g Select the printer you want to use, and then click [Next].
[[U Check the location of the selected printer is shown, and then click [Next].
[I] Change the printer name if you want, and then click [Next].

[B Specify whether or not to print a test page, and then click [Finish].
Restart the computer to complete installation.
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O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Using as the NetWare Print Server/Remote
Printer

This explains how to set up the Windows computer used as the NetWare client.

® @ | mportant

3 To install this printer driver under Windows 2000/XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

The following explanation assumes NetWare Client is installed on the client com-
puter and the NetWare server environment is correctly set up. Install all neces-
sary client applications before following this procedure.

Set up the printer driver while logging on to the NetWare file server.
The following values are used in the example:

e Operating system: Windows 98

* NetWare version: 4.1

* File server name: CAREE

* Queue name: R-QUEUE

) insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

8 Click [PCL/RPCS Printer Drivers].

ﬂ The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement], and then click [Next].

B Select the printer driver you want to use in the [Printer Program] dialog
box.

You can select several printer drivers.

B Select the [Printer Name] check box to select the printer models you want
to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

ﬂ Double-click the printer name to display the printer settings.
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The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

8 Click [Port:], and then click [Add].
ﬂ Click [Network Printer], and then click [OK].

[[D Double-click the name of the NetWare file server on the network tree.
The created queue is displayed.

[I] Select the print queue, and then click [OK].
[E] Check that the port of the selected printer is displayed in [Port:].

B click [Finish].
The printer driver installation starts.

[I] Click [Finish] in the [Component selection] dialog box.
iE Click [Finish] in the [Introduction complete] dialog box.

[[ﬂ In the [Printers] window, open the printer properties.
Under Windows XP or Windows Server 2003, open the printer properties from
the [Printers and Faxes] window.

[ﬂ On the [Printer Settings] tab, clear the [Form Feed] and [Enable Banner] check
boxes.

Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, click
the [NetWare setting] tab.

Do not select these check boxes since they are automatically selected by the
printer driver. If you select the check boxes, the printer may not print correctly.

[B Click [OK] to close the printer properties dialog box.

(3 The protocol is set to inactive as default. Enable it using Web Image Mon-
itor or Telnet

When using the PostScript 3 Printer Driver
Follow the procedure below to set up the PostScript 3 printer driver.

I] In the [Printers] or [Printers and Faxes] window, open the printer properties.

B Click the [PostScript] tab.

O When using Windows 2000/XP or Windows NT 4.0, click the [Device Set-
tings] tab, and then proceed to step to clear the check box.
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E click [Advanced].

ﬂ Clear the [Send CTRL+D before job] and [Send CTRL+D after job] check boxes,
and then click [OK].

B Click [OK] to close the printer properties dialog box.

Form Feed

Do not use NetWare to configure form feed. Form feed is controlled by the printer
driver on Windows. If NetWare form feed is configured, the printer may not print
properly.

Follow the procedure below to disable form feed according to the operating sys-
tem used:

e Under Windows 95/98/Me, clear the [Form feed] check box on the [Printer Set-
tings] tab in the printer properties dialog box.

e Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, clear
the [Form feed] check box on the [NetWare Settings] tab in the printer properties
dialog box.

Banner Page

Do not use NetWare to configure a banner page.

Follow the procedure below to disable banner pages according to the operating
system used:

e Under Windows 95/98/Me, clear the [Enable banner] check box on the [Printer
Settings] tab in the printer properties dialog box.
e Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, clear

the [Enable banner] check box on the [NetWare Settings] tab in the printer prop-
erties dialog box.

Printing after Resetting the Printer

Printer to print server connection requires 30 - 40 seconds to resume after the
printer is reset. During this period, jobs may be accepted (depending on Net-
Ware specifications) but not printed.

To print after resetting the printer as the remote printer, check on the print server
that the remote printer is disconnected, or wait for two minutes before trying to
print.
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Installing the Printer Driver Using USB

This section explains how to install printer drivers using USB.

S @ | mportant
O Make sure that printer is connected to the computer's USB ports using the
USB interface cable.

Before installing, check that only the operating system is running on the comput-
er and no print jobs are in progress.

The printer drivers can be installed from the CD-ROM provided with this printer.

Windows 98 SE/Me - USB
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O Installation via USB is not possible under Windows 95/98. Upgrade to Win-
dows 98 SE/Me.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.
ﬂ Check that the power of the printer is off.

ﬂ Connect the printer and computer using the USB cable.

8 Turn on the power of the printer.

The plug and play function starts and the [New Hardware Found], [Device Driver
Wizard], or [Add New Hardware Wizard] dialog box appears, depending on the op-
erating system.

O click [Next >].

B Click [Search for the best driver for your device. {Recommended}.], and then click
[Next >].

B Select the [Specify a location:] check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

[l insert the CD-ROM into the CD-ROM drive.
O When Auto Run starts, click [Exit].

O To disable Auto Run, press the [ Shift] key when inserting the CD-ROM into
the drive and keep it pressed until the computer finishes reading from the
CD-ROM.

B Specify the location where USB Printing Support is located, and then
click [Next >].
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If the CD-ROM drive is D, the source files of USB Printing Support are stored
in the following location:

D:\DRIVES\RPCS\WIN98_ME

ﬂ Check the location, and then click [Next].
USB Printing Support is installed.

[[D Click [Finish].

If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the “USB001” port is added to the [Printers]
window.

ﬂ] Click [Next >].

[B Click [Search for the best driver for your device. {Recommended}.], and then click
[Next >].

[B Select the [Specify a location:], check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

[ insert the CD-ROM into the CD-ROM drive.
O When Auto Run starts, click [Exit].

O To disable Auto Run, press the [Shift] key when inserting the CD-ROM into
the drive and keep it pressed until the computer finishes reading from the
CD-ROM.

iE Specify the location where the source files of the printer driver is stored,
and then click [Next >].

If the CD-ROM drive is D, the source files of the printer driver are stored in the
following location:

* RPCS
D:\DRIVES\RPCS\WIN98_ME\(Language)\DISK1

e PCL 5c
D:\DRIVES\PCL5C\WIN98_ME\(Language)\DISK1

« PCL6
D:\DRIVES\PCL6\WIN98_ME\(Language)\DISK1

e PostScript 3
D:\DRIVES\PS3\WIN98_ME\(Language)\DISK1

[E Check the location, and then click [Next].
Add Printer Wizard starts.

[ﬂ Click [Finish].
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Installation is complete. If installation is successful, the icon of the printer con-
nected to the “USB001” port is added to the [Printers] window.

3 The number after “USB” varies depending on the number of printers con-
nected.

3 Itis not necessary to reinstall USB Printing Support when connecting a dif-
ferent printer via USB interface when USB Printing Support is installed.

O Afterinstalling USB Printing Support, if the printer driver is not installed, fol-
low the plug-and-play instructions of the printer.

3 Install the printer driver from the CD-ROM provided with the printer.

Windows 2000 - USB
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3 Installing a printer driver requires Administrators permission. Log on using an
account that has Administrators permission.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the CD-ROM provided.

[I Check that the power of the printer is off.
8 Connect the printer and computer using the USB cable.

B Turn on the power of the machine.
Found New Hardware Wizard starts, and USB Printing Support is installed au-
tomatically.

ﬂ Click [Next] in the [Found New Hardware Wizard] dialog box.

B Select the [Search for a suitable driver for my device (recommended)] check box,
and then click [Next].

E Select the [Specify location] check box, and then click [Next].

d insert the CD-ROM into the CD-ROM drive.
O When Auto Run starts, click [Exit].

O To disable Auto Run, press the left [ Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

8 Specify the location where the source files of the printer driver is stored.
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If the CD-ROM drive is D, the source files of the printer driver are stored in the
following location:

« RPCS
D:\DRIVES\RPCS\WIN2K_XP\(Language)\DISK1

e PCL 5c
D:\DRIVES\PCL5C\WIN2K_XP\(Language)\DISK1

e PCLG
D:\DRIVES\PCLB\WIN2K_XP\(Language)\DISK1

* PostScript 3
D:\DRIVES\PS3\WIN2K_XP\(Language)\DISK1

g Check the printer driver location, and then click [OK].
[ click [Next].

@ click [Finish].

If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the “USB001” port is added to the [Printers]
window.

O The number after “USB” varies depending on the number of printers con-
nected.

Windows XP, Windows Server 2003 - USB

b d | mportant

O Installing a printer driver requires Administrators permission. Log on using an
account that has Administrators permission.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

The printer drivers can be installed from the CD-ROM provided with this printer.
If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the CD-ROM provided.

I] Check that the power of the printer is off.

ﬂ Connect the printer and computer using the USB cable.

B Turn on the power of the machine.

Found New Hardware Wizard starts, and USB Printing Support is installed au-
tomatically.

ﬂ In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].
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B To disable Auto Run, press the left [ Shift] key when inserting the CD-
ROM into the drive and keep it pressed until the computer finishes read-

ing from the CD-ROM.

3 If Auto Run starts, click [Cancel], and then [Exit].

B Select the [Include this location in the search] check box under [Search for the
best driver in these location], and then click [Browse] to select the printer driv-

er location.

If the CD-ROM drive is D, the source files of the printer driver are stored in the

following location:
* RPCS

D:\DRIVES\RPCS\WIN2K_XP\(Language)\DISK1

e PCL 5c

D:\DRIVES\PCL5C\WIN2K_XP\(Language)\DISK1

* PCL6

D:\DRIVES\PCLB\WIN2K_XP\(Language)\DISK1

* PostScript 3

D:\DRIVES\PS3\WIN2K_XP\(Language)\DISK1

ﬂ Check the printer driver location, and then click [Next].

8 Click [Continue].
ﬂ Click [Finish].

If installation is successful, the icon of the printer connected to the “USB001”
port is added to the [Printers] window.

3 The number after “USB” varies depending on the number of printers con-

nected.

Troubleshooting USB

Problem

Solutions

The printer is not recognized auto-
matically.

Turn off the power of the printer, reconnect the USB cable,

and then turn it on again.

S/
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Windows has already configured
the USB settings.

Open Windows' Device Manager, and then, under [Univer-
sal Serial Bus controllers], remove any conflicting devices.
Conflicting devices have a yellow [!] or [?] icon by them.
Take care not to accidentally remove required devices.
For details, see Windows Help.

3O When using Windows 2000/XP or Windows Server
2003, an erroneous device is displayed under [USB
Controller] in the [Device Manager] dialog box.
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Printing with Parallel Connection

To use a printer connected using a parallel interface, click [LPT1] when installing
the printer driver.

Installing the PCL or RPCS Printer Driver

b d | mportant

3 To install this printer driver under Windows 2000/XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.
B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement], and then click [Next].

E Select a printer driver you want to use in the [Printer Program] dialog box.
You can select several printer drivers.

ﬂ Select the [Printer Name] check box to select the printer models you want
to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

8 Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

ﬂ Check that [LPT1:] is shown in [Port:].
[[D Select the [Default Printer] check box to configure the printer as default.

@ click [Finish].
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The printer driver installation starts.

[EJ Click [Finish] in the installation completion dialog box.

3 To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

=l Reference

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run. If
you still want to install the printer driver, use [Add Printer]. See p.71 “If a
Message Appears during Installation”.

Installing the PostScript 3 Printer Driver (Windows 95/98/Me)

ﬂ Quit all applications currently running.

Fd insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

O The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B click [Next].

B Click [Local Printer], and then click [Next].
A dialog box for selecting the printer manufacturer and model name appears.

ﬂ Select the name of the printer whose driver you want to install, and then
click [Next].

B In the [Available ports:] box, click [Printer Port], and then click [Next].

g Change the printer name if you want, and then click [Next].
Select the [Yes] check box to configure the printer as default.

[[D Specify whether or not to print a test page, and then click [Finish].
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[i] Restart the computer to complete installation.

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 2000)

b d | mportant

O Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.
B Select an interface language, and then click [OK].
The default interface language is English.

O The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Click [Next].

B Click [Local Printer], and then click [Next].
A dialog box for selecting the printer manufacturer and model name appears.

ﬂ Select the name of the printer whose driver you want to install, and then
click [Next].

B Specify whether or not to print a test page, and then click [Finish].

ﬂ Restart the computer to complete installation.

3 A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003)

® @ | mportant
3 Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

ﬂ Quit all applications currently running.

B3 insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

3 The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B click [Next].
[3 click [Local Printer], and then click [Next].

ﬂ Select the port you want to use, and then click [Next].
A dialog box for selecting the printer manufacturer and model name appears.

B Select the name of the printer whose driver you want to install, and then
click [Next].

ﬂ Change the printer name if you want, and then click [Next].
[E] Specify whether or not to print a test page, and then click [Finish].

[i] Restart the computer to complete installation.

3 A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows NT 4.0)

® @ | mportant
O Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

ﬂ Quit all applications currently running.

B3 insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

3 The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B click [Next].

B Select the port you want to use, and then click [Next].
A dialog box for selecting the printer manufacturer and model name appears.

ﬂ Select the name of the printer whose driver you want to install, and then
click [Next].

8 Change the printer name if you want, and then click [Next].
ﬂ Click [Next].
[E] Specify whether or not to print a test page, and then click [Finish].

[i] Restart the computer to complete installation.

3 A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the Printer Driver Using IEEE 1394
(SCSI print)

The printer drivers can be installed from the CD-ROM provided with this printer.
® @ | mportant
3 Quit all applications currently running, and do not print during installation.

3 Do not connect IEEE 1394 or USB devices to the computer or turn on another
printers during installation.

O Before uninstalling the printer driver, check that the IEEE 1394 interface cable
is disconnected from the computer.

0 SCSI print must be set to “active” from the control panel. For details, see
p.179 “Host Interface Menu”.

3 This printer can receive print data from one computer at a time only. An mes-
sage may appear if jobs from different computers collide.

O If jobs collide, the first received is printed first.

3 When the printer driver is properly installed, connecting or disconnecting the
optional IEEE 1394 cable causes the printer icon to change.

Windows 2000

O If [Found New Hardware Wizard] appears every time the computer is started or
the cable is connected, disable the device. To install another printer driver af-
ter setting the “1394_00n” port, click [1394_00] as a port during the printer
driver installation.

3 Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

O The optional 1394 interface unit can be used only with Service Pack 1 (SP1)
or higher.

ﬂ Connect the printer and computer using the IEEE 1394 interface cable.

ﬂ Click [Next] in the [Found New Hardware Wizard] dialog box.

B When the message “This wizard will complete the installation for this
Device: Unknown” appears, click [Specify a location], and then click [Next
>].

ﬂ When the message “Locate Driver Files” appears, select the [Optional
search locations] check box, and then click [Specify a location], and then click
[Next >].
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B To disable Auto Run, press the left [ Shift] key when inserting the CD-
ROM into the drive and keep it pressed until the computer finishes read-
ing from the CD-ROM.

If Auto Run starts, click [Cancel], and then [Exit].
ﬂ Click [Browse].

ﬂ Select the printer driver you want to use.

If the CD-ROM drive is D, the source files of the printer driver are stored in the
following location:

* RPCS
D:\DRIVES\RPCS\WIN2K_XP\(Language)\DISK1

e PCL 5c
D:\DRIVES\PCL5C\WIN2K_XP\(Language)\DISK1

« PCL6
D:\DRIVES\PCLB\WIN2K_XP\(Language)\DISK1

e PostScript 3
D:\DRIVES\PS3\WIN2K_XP\(Language)\DISK1

B Click [Open].
B ciick [ok;.

[[D Follow the instructions.

When installation is complete, the printer connected to “1394_00n” appears
in the [Printers] window. (“n” shows the number of printers connected.)

3 If the printer driver has already been installed, the printer icon is added to
the [Printers] window. In this case, printer driver installation is not neces-
sary.

O3 If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see “Printer Does Not Print”, Mainte-
nance Guide.

3 If you do not want to install the printer when Found New Hardware Wizard
starts under an operating system that supports SCSI print, disable the de-
vice by following the procedure below.

® When the [Found New Hardware Wizard] dialog box appears, click [Next >].

@ When the message “This wizard will complete the installation for this
Device: Unknown” appears, select the [Search for a suitable driver for my
device [recommended]] check box, and then click [Next >].

® When the message “Please choose your search and installation option.”
appears, clear all check boxes from [Search for the best driver in these loca-
tions.], and then click [Next >].
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@ When the message “Driver Files Search Results” appears, select the
[Disable the device. The Add/Remove Hardware Wizard in the control Panel can
be able to complete the driver installations.] check box, and then click [Fin-
ish].

Windows XP, Windows Server 2003

b d | mportant
O SCSI print must be set to “active” from the control panel. For details, see
p.179 “Host Interface Menu”.

3 Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

3 This printer can receive print data from one computer at a time only. If a job
from a computer collides with other data, a message may appear on the com-
puter.

3 To install another printer driver after setting the “1394_00n” port, click
[1394_00] as a port during the printer driver installation.

O When the printer driver is properly installed, connecting or disconnecting the
optional IEEE 1394 cable causes the printer icon to change.

ﬂ Connect the printer and computer using the IEEE 1394 interface cable.

When the [Found New Hardware Wizard] dialog box appears, check that [This wiz-
ard helps you install software for: (Unknown)] is displayed.

B Select the [Install from a list on specific location (Advanced)] check box, and
then click [Next >].

BWhen the message “Please choose your search and installation op-
tion.” appears, select the [Search for the best driver in these locations.] check
box, and then select the [Include this location in the search:] check box.

ﬂ To disable Auto Run, press the left [Shift] key when inserting the CD-
ROM into the drive and keep it pressed until the computer finishes read-
ing from the CD-ROM.

3 If Auto Run starts, click [Cancel], and then [Exit].

B Specify the location where the source files of the printer driver is stored,
and then click [Next].
If the CD-ROM drive is D, the source files of the printer driver are stored in the
following location:

e RPCS
D:\DRIVES\RPCS\WIN2K_XP\(Language)\DISK1
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e PCL 5c
D:\DRIVES\PCL5C\WIN2K_XP\(Language)\DISK1

e PCLG
D:\DRIVES\PCLB\WIN2K_XP\(Language)\DISK1

* PostScript 3
D:\DRIVES\PS3\WIN2K_XP\(Language)\DISK1

When installation is complete, the printer connected to “1394_00n” appears
in the [Printers and Faxes] window. (“n” shows the number of printers connect-
ed.)

B Follow the instructions.

O3 If the printer driver has already been installed, the printer icon is added to
the [Printers and Faxes] window. In this case, printer driver installation is not
necessary.

3 Even if the printer driver is already installed, the message “ Found New
Hardware Wizard” may appear when the printer and the computer are con-
nected using the IEEE 1394 interface cable for the first time. If it does, in-
stall the printer driver.

O3 If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see “Printer Does Not Print”, Mainte-
nance Guide.

3 If you do not want to install the printer when Found New Hardware Wizard
starts under an operating system that supports SCSI print, disable the de-
vice by following the procedure below

@® When the [Found New Hardware Wizard] dialog box appears, check that
[This wizard helps you install software for: Unknown] displayed, select [Install
from a list on specific location (Advanced)] check box, and then click [Next >].

@ When the message “Please choose your search and installation option.”
appears, clear all check boxes from [Search for the best driver in these loca-
tions.], and then click [Next >].

® When the message “The wizard could not find the software on your
computer for.” appears, click [OK].

@ When the message “Cannot Install this Hardware” appears, select the
[Don't prompt again to install the software] check box, and then click [Finish].
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Printing with Bluetooth Connection

Supported Profiles

“ SPP, HCRP

A maximum of two Bluetooth adaptor or Bluetooth-equipped computers
can be connected at the same time using the Bluetooth interface: one by
SPP, one by HCRP.

When connecting more than one Bluetooth adaptor or Bluetooth-equipped
computer at the same time, the first device that establishes connection is
selected. When selecting the connection between the other devices, can-
cel the first established connection.

Conditions for bidirectional communications
e SPP connection does not support bidirectional communications.
e HCRP connection supports bidirectional communications.

< BIP

Only one Bluetooth adaptor or Bluetooth-equipped computer can be con-
nected via BIP.

Only JPEG images that can be printed using BIP.

User codes are disabled for BIP.
You cannot print if print functions are restricted.

Some printers do not support BIP.

Printing with Bluetooth Connection

To install the printer driver, follow the procedure used to install parallel interface.

b d | mportant

3 To install the printer driver under Windows 2000/XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

O System requirements vary depending on the Bluetooth standard and specifi-
cations. For details, see the manuals provided with each product.

3 For information about setting up Bluetooth under other operating systems or
using it with different utilities, see the manuals provided with those operating
systems or utilities.

[I Start 3Com Bluetooth Connection Manager.
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ﬂ Check that the printer you want to use appears in 3Com Bluetooth Con-
nection Manager.

B On the [Tool] menu, click [COM port].

ﬂ Check that the message “Bluetooth Serial Client (COMx) “ appears un-
der Client Ports. (X indicates the COM port number used by Bluetooth.)

B ciick [Close].

B On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].
B click the [Ports] tab.

[E] Under [Port], select the [COMx:] check box. X indicates the COM port num-
ber used by Bluetooth.
@ click [ox;.
Close the [Printers] window.
% If a dialog box appears while transmitting a print job, reestablish network connec-
tion as follows:
@ Select the printer you want to use in the [Printers and Faxes] box.
@ Click [Connect].

O To always use the same printer, select the [Always use for this connection]
check box.

= Reference

For details, see the manuals provided with the Bluetooth adaptor or
computer equipped with Bluetooth.

Configuring Security Mode Settings

I] Start 3Com Bluetooth Connection Manager.

8 On the [Tools] menu, click [Security Mode].
The [Security Mode] dialog box appears.

B Select the security mode in the [Security Mode:] list.
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If you click [High], or [Custom], and specify [Link] in the [Custom Settings] dialog
box, enter the Bluetooth password. For information about entering the pass-
word, see p.70 “Printing in the Security Mode”.

For all other security modes and custom settings, no password is required.

O Forinformation about each mode, see the manuals provided with the utility.

ﬂ Click [OK].
Close the [Security Mode] dialog box.
=l Feference

For details about the security mode, see 3Com Bluetooth Connection Man-
ager Help. For details about the password entry which is required to trans-
mit print jobs, see p.70 “Printing in the Security Mode”.

Printing in the Security Mode

ﬂ Send the print job to the printer in use.

Depending on the computer configuration, the [Connect] dialog box may ap-
pear. If it does, use it to establish the network connection.

8 The [Authentication] dialog box appears.

B Enter the Bluetooth password, and then click [OK].

As the Bluetooth password, enter the last four digits of the printer's serial num-
ber. You can find the serial number on the label on the back of the printer. For
example, if the serial number is 00A0-001234, the Bluetooth password is
1234.

ﬂ The print job is sent.

O The Bluetooth password differs for each printer and cannot be changed.
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If a Message Appears during Installation

Message number 58 or 34 indicates the printer driver cannot be installed using
Auto Run. Install the printer driver using [Add Printer] or [>Install Printer].

For Windows 95/98/Me, Windows 2000 and Windows NT 4.0:

I] On the [Start] menu, point to [Settings], and then click [Printers].
ﬂ Double-click the Add Printer icon.

B Follow the instructions in Add Printer Wizard.

3 If the printer driver is on a CD-ROM, the location of the RPCS printer driver
is either \DRIVERS\RPCS\WIN9X_ME, \DRIVERS\RPCS\WIN2K_XP, or
\DRIVERS\RPCS\NTA4. If the installer starts, click [Cancel] to quit.

For Windows XP Professional and Windows Server 2003:

I] On the [Start] menu, click [Printers and Faxes].
El Click [Add a printer].

B Follow the instructions in Add Printer Wizard.

3 If the printer driver is on a CD-ROM, the location of the RPCS printer driver
is \DRIVERS\RPCS\WIN2K_XP. If the installer starts, click [Cancel] to quit.

For Windows XP Home Editions:

I] On the [Start] menu, click [Control Panel].
ﬂ Click [Printers and Other Hardware].

8 Click [Printers and Faxes].

E] Click [Install Printer].

B Follow the instructions in Add Printer Wizard.

3 If the printer driver is on a CD-ROM, the location of the RPCS printer driver
is \DRIVERS\RPCS\WIN2K_XP. If the installer starts, click [Cancel] to quit.
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Making Option Settings for the Printer

Make option settings for the printer using the printer driver when bidirectional
communication is disabled.

=l Reference

For details about making option settings for the printer, see p.73 “If Bidirec-
tional Communication is Disabled”.

Conditions for Bidirectional Communication

Bidirectional communication allows information about paper size and feed direc-
tion settings to be automatically sent to the printer. You can check printer status
from your computer.

* Bidirectional communication is supported by Windows 95/98/Me/2000/XP,
Windows Server 2003, and Windows NT 4.0.

* If you use the RPCS printer driver and bidirectional communication is enabled
under Windows 2000, the [Change Accessories] tab is unavailable.

O The RPCS printer driver supports bidirectional communications and updates
the printer status automatically.

O The PCL printer driver supports bidirectional communications. You can up-
date printer status manually.

O The PostScript 3 printer driver does not support bidirectional communications.
To support bidirectional communication, the following conditions must be met:

% When connected with parallel cables
e The computer must support bidirectional communication.
¢ The printer must support bidirectional communication.
* The interface cable must support bidirectional communication.

* The printer must be connected to the computer using the standard parallel
cables and parallel connectors.

* Under Windows 2000, [Enable bidirectional support] must be selected, and
[Enable printer pooling] must not be selected on the [Port] tab with the RPCS
printer driver.

< When connected with the network

* The printer must support bidirectional communication.

¢ SmartDeviceMonitor for Client included on the CD-ROM must be installed,
and TCP/IP must be used.
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¢ Under Windows 2000, [Enable bidirectional support] must be selected, and
[Enable printer pooling] must not be selected on the [Port] tab with the RPCS
printer driver.

¢ In addition to the above, one of the following conditions must also be met:

e The SmartDeviceMonitor for Client port and the TCP/IP protocol must
be used.

* The standard TCP/IP port must be used without changing the default
port name (for Windows 2000/XP and Windows Server 2003).

* Microsoft TCP/IP print IP address must be specified for use (for Win-
dows NT 4.0).

e |PP port name must include the IP address when using the IPP protocol.

« When connected with IEEE 1394
e The computer must support bidirectional communication.

* The printer must be connected to the IEEE 1394 connector of a computer
using the IEEE 1394 interface cable.

¢ [Activate] must be selected in the SCSI print of IEEE 1394 and [Activate]
must be selected in the Bidi-SCSI print.

e Under Windows 2000/XP or Windows Server 2003, [Enable bidirectional sup-
port] must be selected, and [Enable printer pooling] must not be selected on
the [Port] tab with RPCS printer driver.

< When connected with USB

The printer must be connected to the computer's USB port using the USB in-
terface cable.
The computer must support bidirectional communication.

3 Install SmartDeviceMonitor for Client from the CD-ROM provided.

If Bidirectional Communication is Disabled

Set up option settings when bidirectional communications are disabled.

O Under Windows 2000/XP and Windows Server 2003, Manage Printers per-
mission is required to change the printer properties in the [Printers] folder. Log
on as an Administrators or Power Users group member.

O Under Windows NT 4.0, Full Control permission is required to change the
printer properties in the [Printers] folder. Log on as an Administrators or Power
Users group member.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.
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ﬂ Click the icon of the printer you want to use.
8 On the [File] menu, click [Properties].

ﬂ Click the [Accessories] tab.

If options in the [Change Accessories] tab are disabled, bidirectional connection
is enabled. In this case, no change is necessary for option settings.

3 If you are using the RPCS printer driver, click the [Change Accessories] tab.
3 If you are using the PS printer driver, click the [Device Settings] tab.

B Select options installed from the [Option] area, and then make the neces-
sary settings.

E Select the total amount of the memory in [Total Memory:], when the option-
al SDRAM module is added.

ﬂ Under [Paper source tray settings], click and highlight the tray to be used,
and then select the appropriate size, position, and type for the tray. Se-
lect the [Tray locking] check box to exclude the tray from the targets of au-
tomatic tray selection.

B Click [OK] to close the printer properties dialog box. Click the [Defaults]
tab, and then click [Change Accessories] to display the option selection.
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PCL - Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

There are two methods to open the printer properties dialog box.
Making printer default settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

® @ | mportant
3 You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

EI Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].
ﬂ Make the necessary settings, and then click [OK].

3 With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

=l Feference
For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties di-
alog box from that application. The following explains how to make settings for
the WordPad application provided with Windows 95/98/Me.

ﬂ On the [File] menu, click [Print].
The [Print] dialog box appears.

EI Select the printer you want to use in the [Name] list, and then click [Prop-
erties].

The printer properties dialog box appears.
B Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.

G1307502_1.00 Copyright © 2005
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(3 The procedure to open the printer properties dialog box may vary depend-
ing on the application. For details, see the manuals provided with the ap-
plication you use.

3 With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

3 Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

= Feference
For details, see the printer driver Help.

Windows 2000 - Accessing the Printer Properties

Making printer default settings - the printer properties

® @ | mportant

3 To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission by
default.

O You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

I] On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].
O Settings you make here are used as the default settings for all applications.
O Do not make a setting for [Form to Tray Assignment].
=l Feference
For details, see the printer driver Help.
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Making printer default settings - Printing Preferences

S @ | mportant
O You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

8 On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].
O Settings you make here are used as the default settings for all applications.
=l Feference
For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings for
the WordPad application provided with Windows 2000.

3 The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the applica-
tion you use.

O Any settings you make in the following procedure are valid for the current ap-
plication only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

ﬂ On the [File] menu, click [Print...].
The [Print] dialog box appears.

EI Select the printer you want to use in the [Select Printer] list.

B Make the necessary settings, and then click [Apply] to start printing.
=l Feference
For details, see the printer driver Help.
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Windows XP, Windows Server 2003 - Accessing the Printer
Properties

Making printer default settings - the printer properties

S @ | mportant

O To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission by
default.

3 You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

[I On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

O Settings you make here are used as the default settings for all applications.
3 Do not make a setting for [Form to Tray Assignment].
= Feference
For details, see the printer driver Help.

Making printer default settings - Printing Preferences

® @ | mportant
3 You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].
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O Settings you make here are used as the default settings for all applications.
=l Feference
For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings for
the WordPad application provided with Windows XP.

O The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the applica-
tion you use.

O Any settings you make in the following procedure are valid for the current ap-
plication only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

B on the [File] menu, click [Print...].

The [Print] dialog box appears.

PJ Select the printer you want to use in the [Select Printer] list.

B Make the necessary settings, and then click [Apply] to start printing.
=l Feference
For details, see the printer driver Help.

Windows NT 4.0 - Accessing the Printer Properties

Making printer default settings - the printer properties

® @ | mportant

3 To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

I] On the [Start] menu, point to [Settings], and then click [Printers].
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The [Printers] window appears.
ﬂ Click the icon of the printer you want to use.

8 On the [File] menu, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].
(O Settings you make here are used as the default settings for all applications.
Do not make a setting for [Form to Tray Assignment].
=l Feference
For details, see the printer driver Help.

Making printer default settings - Default

b d | mportant

3 To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

3 You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

[I On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

PJ Click the icon of the printer you want to use.

B On the [File] menu, click [Document Defaults].
The [Default] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].
O Settings you make here are used as the default settings for all applications.
=l Feference
For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties di-
alog box from that application. The following explains how to make settings for
the WordPad application provided with Windows NT 4.0.
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3 The procedure to open the printer properties dialog box may vary depending
on the application. For details, see the manuals provided with the application
you use.

O With some applications, the printer driver settings are not used, and the appli-
cation's own default settings are applied.

3 Any settings you make in the following procedure are valid for the current ap-
plication only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

ﬂ On the [File] menu, click [Print].

The [Print] dialog box appears.

EI Select the printer you want to use in the [Name] list, and then click [Prop-
erties].

The printer properties dialog box appears.

8 Make the necessary settings, and then click [OK].

E] Click [OK] to start printing.
=)} Reference
For details, see the printer driver Help.
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RPCS - Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

There are two dialog box types of the printer properties dialog box.

“Multi-tab” is used as an example in this manual. For details about changing the
dialog box types, see the printer driver Help.

« Multi-tab
This dialog box type is designed for users who often change print settings to
perform various printing operations.

% Custom Setting
This dialog box type is designed for users who rarely change print settings.
This type of dialog box may vary depending on the installed options.

Making printer default settings
To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

b d | mportant
3 You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

O With some applications, the printer driver settings are not used, and the appli-
cation's own default settings are applied.

I] On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].

O When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK],
the printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].
=l Feference
For details, see the printer driver Help.
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Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties di-
alog box from that application. The following explains how to make settings for
the WordPad application provided with Windows 95/98/Me.

O The procedure to open the printer properties dialog box may vary depending
on the application. For details, see the manuals provided with the application
you use.

O With some applications, the printer driver settings are not used, and the appli-
cation's own default settings are applied.

O Any settings you make in the following procedure are valid for the current ap-
plication only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

I] On the [File] menu, click [Print].

The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Prop-
erties].

The printer properties dialog box appears.

B Make the necessary settings, and then click [OK].

ﬂ Click [OK] to start printing.
=l Feference
For details, see the printer driver Help.

Windows 2000 - Accessing the Printer Properties

Making printer default settings - the printer properties

b d | mportant

 To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission by
default.

3 You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
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The [Printers] window appears.
EI Click the icon of the printer you want to use.

8 On the [File] menu, click [Properties].
The printer properties dialog box appears.

O When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK],
the printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].
O Settings you make here are used as the default settings for all applications.
O Do not make a setting for [Form to Tray Assignment].
=l Feference
For details, see the printer driver Help.

Making printer default settings - Printing Preferences

b d | mportant

O You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

I] On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].
O Settings you make here are used as the default settings for all applications.
=l Feference
For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings for
the WordPad application provided with Windows 2000.
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(3 The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the applica-
tion you use.

O Any settings you make in the following procedure are valid for the current ap-
plication only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

ﬂ On the [File] menu, click [Print...].

The [Print] dialog box appears.

EI Select the printer you want to use in the [Select Printer] list.

8 Make the necessary settings, and then click [Apply] to start printing.
=l Feference
For details, see the printer driver Help.

Windows XP, Windows Server 2003 - Accessing the Printer
Properties

Making printer default settings - the printer properties

b d | mportant

O To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission by
default.

3 You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

[I On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

PJ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

3 When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK],
the printer properties dialog box appears.
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ﬂ Make the necessary settings, and then click [OK].
O Settings you make here are used as the default settings for all applications.
3 Do not make a setting for [Form to Tray Assignment].
= Feference
For details, see the printer driver Help.

Making printer default settings - Printing Preferences

S @ | mportant

3 You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

EI Click the icon of the printer you want to use.

8 On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].
O Settings you make here are used as the default settings for all applications.
=l Feference
For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings for
the WordPad application provided with Windows XP.

O The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the applica-
tion you use.

O Any settings you make in the following procedure are valid for the current ap-
plication only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.
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ﬂ On the [File] menu, click [Print...].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Select Printer] list.

B Make the necessary settings, and then click [Apply] to start printing.
=l Feference
For details, see the printer driver Help.

Windows NT 4.0 - Accessing the Printer Properties

Making printer default settings - the printer properties

S @ | mportant

O To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

[I On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

O When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK],
the printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].
O Settings you make here are used as the default settings for all applications.
O Do not make a setting for [Form to Tray Assignment].
=l Feference
For details, see the printer driver Help.
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Making printer default settings - Default

S @ | mportant

3 To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

I] On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

B On the [File] menu, click [Document Defaults...].
The [Default] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].
O Settings you make here are used as the default settings for all applications.
=l Referencs
For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties di-
alog box from that application. The following explains how to make settings for
the WordPad application provided with Windows NT 4.0.

3 The procedure to open the printer properties dialog box may vary depending
on the application. For details, see the manuals provided with the application
you use.

O With some applications, the printer driver settings are not used, and the appli-
cation's own default settings are applied.

O Any settings you make in the following procedure are valid for the current ap-
plication only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

I] On the [File] menu, click [Print].

The [Print] dialog box appears.
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ﬂ Select the printer you want to use in the [Name] list, and then click [Prop-
erties].

The printer properties dialog box appears.
8 Make the necessary settings, and then click [Apply].

ﬂ Click [OK] to start printing.
=} Feference
For details, see the printer driver Help.
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PostScript 3 - Setting Up for Printing

Windows 95/98/Me - Accessing the Printer Properties

There are two methods to open the printer properties dialog box.
Making printer default settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

® @ | mportant
3 You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

3 With some applications, the printer driver settings are not used, and the appli-
cation's own default settings are applied.

[I On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

8 Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

B Click [OK].
=l Feference
For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties di-
alog box from that application. The following explains how to make settings for
the WordPad application provided with Windows 95/98/Me.

O The procedure to open the printer properties dialog box may vary depending
on the application. For details, see the manuals provided with the application
you use.

3 With some applications, the printer driver settings are not used, and the appli-
cation's own default settings are applied.
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3 Any settings you make in the following procedure are valid for the current ap-
plication only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

ﬂ On the [File] menu, click [Print].

The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Name] list, and then click [Prop-
erties].

The printer properties dialog box appears.

8 Make the necessary settings, and then click [OK].

E] Click [OK] to start printing.
=} Feference
For details, see the printer driver Help.

Windows 2000 - Accessing the Printer Properties

Making printer default settings - the printer properties

S @ | mportant

3 To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission by
default.

3 You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

[I On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

O Settings you make here are used as the default settings for all applications.
3 Do not make a setting for [Form to Tray Assignment].
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=l Feference
For details, see the printer driver Help.

Making printer default settings - Printing Preferences

b d | mportant
3 You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

[I On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

8 Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

O Settings you make here are used as the default settings for all applications.
=l Feference
For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings for
the WordPad application provided with Windows 2000.

O The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the applica-
tion you use.

O Any settings you make in the following procedure are valid for the current ap-
plication only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

K on the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

B Make the necessary settings, and then click [Print] to start printing.
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=l Feference
For details, see the printer driver Help.

Windows XP, Windows Server 2003 - Accessing the Printer
Properties

Making printer default settings - the printer properties

® @ | mportant

3 To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission by
default.

O You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].
O Settings you make here are used as the default settings for all applications.
3 Do not make a setting for [Form to Tray Assignment].

=l Feference
For details, see the printer driver Help.

Making printer default settings - Printing Preferences

b d | mportant

O You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

I] On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.
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ﬂ Make the necessary settings, and then click [OK].

O Settings you make here are used as the default settings for all applications.
=l Feference
For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings for
the WordPad application provided with Windows XP.

O The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the applica-
tion you use.

O Any settings you make in the following procedure are valid for the current ap-
plication only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

K on the [File] menu, click [Print...].

The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

B Make the necessary settings, and then click [Print] to start printing.
=l Feference
For details, see the printer driver Help.

Windows NT 4.0 - Accessing the Printer Properties

Making printer default settings - the printer properties

® @ | mportant

3 To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

3 You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.
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ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears .

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].
O Settings you make here are used as the default settings for all applications.
O Do not make a setting for [Form to Tray Assignment].
=l Feference
For details, see the printer driver Help.

Making printer default settings - Default

S @ | mportant

O To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

3 You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

[I On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

B On the [File] menu, click [Document Defaults].
The [Default] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

O Settings you make here are used as the default settings for all applications.
=l Feference
For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.
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To make printer settings for a specific application, open the printer properties di-
alog box from that application. The following explains how to make settings for
the WordPad application provided with Windows NT 4.0.

3 The procedure to open the printer properties dialog box may vary depending
on the application. For details, see the manuals provided with the application
you use.

O With some applications, the printer driver settings are not used, and the appli-
cation's own default settings are applied.

O Any settings you make in the following procedure are valid for the current ap-
plication only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

ﬂ On the [File] menu, click [Print].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Name] list, and then click [Prop-
erties].

The printer properties dialog box appears.
8 Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.

=l Feference
For details, see the printer driver Help.

Mac OS - Setting Up for Printing
Making paper settings from an application

ﬂ Open the file you want to print.

g On the [File] menu, click [Page Setup].

B Check that the printer you want to use is displayed in [Format for:], and
then select the paper size you want to use in [Paper].
Under Mac OS X, select the paper size in [Paper Size].

3 If the printer you want to use is not displayed in [Format for:], select the print-
er you want to use.
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= Reference

The [Page Setup] dialog box varies depending on the application you use.
For details, see the manuals provided with the Mac OS.

ﬂ Configure the settings, and then click [OK].

Setting up for printing from an application

ﬂ Open the file you want to print.
ﬂ On the [File] menu, click [Print].

8 Check that the printer is selected in the [Printer] list, and then make the
printer settings.

ﬂ Configure the settings, and then click [OK].

97



Other Print Operations

Printing a PDF File Directly

You can send a PDF file directly to this printer to print, without opening the ap-
plication it was created in.

b d | mportant

3 This is possible for Adobe PDF files only.

3 You can use this function more conveniently with the attached hard disk.
O PDF files of versions 1.3, 1.4, and 1.5 are supported.

3 Transparency and JBIG2 which are functions of version 1.4 are not support-
ed.

O Functions of 1.5 file format are not supported.

Using DeskTopBinder Lite

PDF files added with DeskTopBinder Lite can be sent directly to this printer for
printing.

® @ | mportant

3 The RPCS printer driver must be installed.

O PDF Direct Print is not available with some versions of DeskTopBinder Lite.
Use DeskTopBinder Lite installed from the CD-ROM provided with this print-
er.

3 PDF Direct Print settings can be made from PDF Direct Print properties.

3 You must configure the port before you can use DeskTopBinder Lite.
=l Feference
For details, see DeskTopBinder Lite Help.

Installing DeskTopBinder Lite
Follow the procedure below to install DeskTopBinder Lite.

ﬂ Quit all applications currently running.

Fd insert the CD-ROM into the CD-ROM drive.
The installer starts.

O Auto Run may not work under certain operating system settings. In this
case, launch “Setup.exe” located on the CD-ROM root directory.

B Select an interface language, and then click [OK].

G1307502_1.00 Copyright © 2005
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ﬂ Click [DeskTopBinder Lite] , and then click [Next].

B Follow the instructions on the display to install DeskTopBinder Lite.

If you are required to restart the computer after installing DeskTopBinder Lite,
restart the computer and continue the configuration.

DeskTopBinder Lite Enhancements

Follow the DeskTopBinder Lite enhancement procedure to print PDF files direct-
ly.

ﬂ On the [Start] menu, click [Programs], [DeskTopBinder], and [Extended Features
Wizard].

B When [Extended Features Wizard] appears, select [Start], and then click [Next]
repeatedly until the [Printing Functions3] screen appears.

B On the [Printing Functions3] screen, click [Add] to display [PDF Direct Print
Properties].

ﬂ Select Driver for This Machine, click [OK], and then click [Next] repeatedly
until [Finish] is displayed.
Click [Finish].

Function Palette

The Function palette contains buttons for functions that are already configured
through DeskTopBinder Lite enhancement. Using these buttons, you can print
Windows files, preview printouts, convert images, and register scanners for doc-
uments without having to open DeskTopBinder Lite. You can also use these
functions simply by dragging a target file to the button corresponding to the re-
quired function and dropping it there.

ﬂ On the [Start] menu, click [Programs], [DeskTopBinder], and [Function Palette].

An icon for the Function palette is added to the task bar displayed at the bot-
tom right of the screen.

ﬂ Right-click the icon that is added to the task bar, and then click [Proper-
ties] to display the Properties screen.

B Click the [Contents] tab, select the [PDF Direct Printing] check box at the cen-
ter, and then click [OK].

The [Properties] screen closes and the [PFD Direct Printing] icon is added to the
palette.

PDF Direct Printing

Use the method below to print PDF files directly.
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ﬂ Drag the PDF file you want to print to the PDF Direct Printing icon in the
palette and drop it there.

ﬂ [Output File List-PDF Direct Print] is displayed.
Highlight the PDF you want to print, and then click [OK].
The PDF file is printed.

Printing PDF Password-Protected Documents
Follow the procedure below to print password-protected PDF files.

[I In the Windows [Start] menu, click [Programs], [DeskTopBinder], and [Extend-
ed Features Wizard].

EI When [Extended Features Wizard] appears, select [Start], and then click [Next]
repeatedly until the [Printing Functions3] screen appears.

8 On the [Printing Functions3] screen, click [Properties...] to display [PDF Direct
Print Properties].

ﬂ Select the [Use PDF Password] check box at the bottom right of the screen,
and then click [OK].

Click [Next] repeatedly until [Finish] appears.
Click [Finish] to close the [Extended Features Wizard] screen.

B Move the PDF file you want to print to the PDF Direct Printing icon on
the palette using a drag-and-drop operation.

B [Output File List-PDF Direct Print] is displayed.
Select the PDF file you want to output to make it reverse video, and then click
[OK].

ﬂ The [PDF Direct Print Properties] screen opens.

Enter the password for the PDF file you want to print in the [PDF Password] field
at the bottom right of the screen, and then click [OK].

The password-protected PDF file is printed.

b d | mportant

O Before printing a password-protected PDF file, perform one of the follow-
ing:
* Enter the PDF password in the PDF Direct Printing Properties screen

e Specify a PDF password by selecting [Change Password] in the [PDF Con-
figuration] menu on the control panel of this machine
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3 If a [Group Password] for the [PDF Configuration] menu is assigned to either
DeskTopBinder Lite or the control panel of this machine, a same group

password needs to be assigned to the other.

PDF Direct Print Properties

ot Comi i A e |
TT;;:".:'L. — “-ﬂ:ﬂ, i -9
I = 10
[« T |
' = 12
= Ly . i v el B
4 s EmaE THEH —_— .
e e
l—__fﬁ
E — i W) e |

1. Configuration Name
Displays the plug-in configuration name (up to 63 single byte characters)

2. Change Icon
Change the icon displayed on the tool bar.

3. Printer Name
Displays a list of RPCS drivers that support PDF direct printing.

4. Duplex
Print on both sides of sheets.

5. Layout
Print multiple pages on a single sheet.

6. Punch
Punch holes in output sheets.

7. Staples

Staple together output sheets.

8. “Display this dialog box before printing” Dialog box
Appears in PDF direct printing mode if this check box is selected.

9. Orientation
Specify the original's orientation.

10. Number of Copies
Specify the number of copies to print.

11. Collate
Use to sort prints.
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12. Range
Specify the print area on each page.

13. Color/Black and White
Specify color or black-and-white printing.

14. Resolution
Specify a print resolution.

15. PDF Password

If the PDF file is password-protected, enter the password in this field. Otherwise, the file
cannot be printed.

16. Group Password

If a group password is assigned to DeskTopBinder Lite and this machine, enter the
group password in this field. Otherwise, printing cannot start.

Using Commands

Under Windows and UNIX, you can print PDF files directly, using commands
such as “ftp” and “Ipr”.

= Reference

For details about printing using commands under Windows, see p.285 “Print-
ing Files Directly from Windows”.

For details about printing using commands under UNIX, see UNIX Supple-
ment.
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Unauthorized Copy Control

You can embed patterns and text when printing to prevent unauthorized copying
of the document. Unauthorized Copy Control consists of [Data security for copying]
and [Mask type].

b d | mportant

3 This function is designed to discourage copying confidential documents; it
does not prevent unauthorized use of information.

Using [Data security for copying]

You can embed a pattern by setting in the printer driver.
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« Setting [Data security for copying] in the Printer Driver

e Select the [Data security for copying] checkbox. You can also enter the text
in the [Text] box.

* You cannot select the [Mask type] checkbox at the same time.
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% Printing a document using [Data security for copying]

1 2 3

=

A0

1. The print preview of the pattern and the text you set is displayed.

2. The document is copied to the machine that the Copy Data Security unit
is installed.

3. The document is blanked by gray overprint.
=l Feference
For details about setting [Data security for copying], see Printer Driver Help.
!
3 Only the RPCS printer driver is supported.
3 You cannot partially embed a pattern and text in a document.
O Use 182 x 257 mm (7'/4 x 10'/2) or larger paper.
O Use ordinary or recycled paper that has at least 70% whiteness.

O Duplex printing may interfere with the function due to text and patterns be-
ing visible through the paper.
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Using [Mask type]

You can embed patterns and text in a document by setting in the printer driver to
prevent unauthorized copying.
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« Setting [Mask type] in the Printer Driver
e Select a pattern from [Mask type], and then enter text in the [Text] box.

3 You can set only [Text], but [Mask type] and [Text] must be set together.

« Printing a Document Using [Mask type]

1 2 3
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1. The print preview of the pattern and the text you set is displayed.
2. The document is copied to the copier or the multifunction machine.
3. The pattern and the text you set appear.

=l Feference
For details about setting [Mask type], see Printer Driver Help.
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H
3 Only the RPCS printer driver is supported.
3 You cannot partially embed patterns and text strings in a document.

O The results of copying may vary depending on the machine model and setting
conditions.

O Printing with background patterns and text may be slower than normal print-
ing.

Important Notice

* Ricoh does not provide warranty regarding the appearance of print patterns
and other copy protection features. The appearance of the print patterns and
the performance of Unauthorized Copy Control may vary depending on the
quality of paper used and the machine model and settings.

* Ricoh takes no responsibility for any damages sustained in connection with
use of or inability to make use of Unauthorized Copy Control print patterns.
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Sample Print

Use this function to print the first set of a multiple-set print job. After checking the
results, the remaining sets can be printed using the control panel. This function
can protect you from printing a large quantity of misprints.

b d | mportant
O To use this function, the hard disk must be installed on the printer.

O The number of pages the printer can save varies depending on the contents
of the print images. At most, the printer can save 100 jobs or 9,000 pages for
Sample Print and Locked Print. At most, the printer can store up to 1,000 pag-
es for 1 job.

3 If you turn off the power, the job saved on the hard disk will be deleted.

O Sample Print files will not appear on the display panel if they have already
been executed or deleted using the Web browser before you select “Sample
Print“ from the control panel.

O Sample Print files printed or deleted using Web Image Monitor, after you se-
lect [Sample Print] using the control panel will appear on the display panel.
However, an error message will appear if you try to print or delete those Sam-
ple Print files.

3 You can identify the file you want to print by the user ID and the time when the
job was stored.

O3 If the first set of the Sample Print file is not as you expected and you do not
want to print the remaining sets, delete the Sample Print file using the control
panel or Web Image Monitor.

3 The job in the printer is deleted automatically after all Sample Print files are
printed.

3 Follow the procedure below to use this function with the PCL or RPCS printer
driver under Windows. If you want to use this function under Mac OS, see
p.300 “Using PostScript 3.

= Feference
For details about settings for the printer driver, see the printer driver Help.

Files specified for Sample Print can be printed or deleted using Web Image
Monitor. For details, see Web Image Monitor Help.

Printing the First Set

ﬂ From an application, select a command to print.
The [Print] dialog box appears.
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ﬂ Select the printer you want to use in the [Name] list, and then click [Prop-
erties].

The printer properties dialog box appears.
Ed in the [Job Type:] box, click [Sample Print].
ﬂ In the [User ID:] box, enter a user ID using up to eight alphanumeric char-
acters.
This is used to identify the user. The user ID can be entered using up to eight
alphanumeric (a-z, A-Z, 0-9) characters.
B Execute a command to print.
The job is saved on the hard disk.
B Check the print job, and then use the control panel to print the remaining
sets or delete them.
=l Feference
p.108 “Printing the Remaining Sets
p.109 “Deleting a Sample Print File”

”

Printing the Remaining Sets

ﬂ Press the [Menu] key.
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The [Menu] screen appears.

B Press the [4A]) or [ V] key to display [Sample Print], and then press the [#
Enter) key.

B Press the [A] or [ V] key to display [Print One File], and then press the [#
Enter) key.

The user ID and the time when the job was stored appear.

ﬂ Press the [4A]) or [ V] key to display the file you want to print, and then
press the [# Enter] key.
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The number of remaining sets appears.
To cancel printing, press the [Escape] key.

B Press the [# Enter) key. To change the number of sets you want to print,
press the [A] or [ V] key and select the number of sets, and then press
the [# Enter] key.

The "Go to Menu, then ->[Esc] to print" message appears. Then the document
selection screen reappears.

After the job is printed, the job saved on the hard disk is deleted.

B Press the [Online] key.
The initial screen appears.

Deleting a Sample Print File
Deleting a selected file only

ﬂ Press the [Menu] key.
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The [Menu] screen appears.

ﬂ Press the [4A] or [ V] key to display [Sample Print], and then press the [#
Enter] key.

B Press the [4A] or [ V] key to display [Delete One File], and then press the [#
Enter] key.

The user ID and the time when the job was stored appear.

ﬂ Press the [A] or [ V] key to display the file you want to delete, and then
press the [# Enter] key.

To cancel deleting a Sample Print file, press the [Escape] key.

B Check the file you want to delete is displayed, and then press the [# En-
ter] key.

B Press the [Online) key.
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The initial screen appears.

Deleting all files

ﬂ Press the [Menu] key.
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The [Menu] screen appears.

B Press the [A] or [ V] key to display [Sample Print], and then press the [#
Enter] key.

B Press the [A] or [ V] key to display [Del. All Files], and then press the [#
Enter] key.
The user ID and the time when the job was stored appear.

ﬂ Press the [4A] or [ Y] key to confirm deleting all files, and then press the
[# Enter) key.
To cancel deleting a Sample Print file, press the [Escape] key.

B Press the [# Enter] key.

E Press the [Online) key.
The initial screen appears.

Checking the Error Log

When a print job is not saved on the hard disk, it remains in the error log and can
be checked using the control panel.

b d | mportant

O The latest 30 error files are stored in the error log. If a new error file is added
when there are 30 error files already stored, the oldest file is deleted. Howev-
er, if the oldest error file is a sample print file, it is not deleted, but stored in-
stead in the sample print error log until the number of sample print error files
reaches 30.

3 If you turn off the power, the logs will be deleted.
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ﬂ Press the [Menu] key.
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The [Menu] screen appears.

B Press the [4A]) or [ V] key to display [Sample Print], and then press the [#
Enter) key.

B Press the [A] or [ V] key to display [Error File(s)], and then press the [#
Enter) key.

The user ID and the time when the job was stored appear.

ﬂ Press the [A] or [ V] key to check the log.

To print error files, either print or delete the file saved on the hard disk, and
then print the file from the computer again.

B When you finish checking the error log, press the [Escape] key.
The Sample Print job selection screen appears.

B Press the [Online) key.
The initial screen appears.
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Locked Print

Use this function to print confidential documents. Documents will not be printed
automatically unless a password is entered using the control panel.

b d | mportant
3 To use this function, the hard disk must be installed on the printer.

O The number of pages the printer can save varies depending on the print im-
age content. At most, the printer can store 30 jobs or 1,100 pages for Sample
Print and Locked Print. At most, the printer can store a maximum of 1,000
pages for a single job.

3 If you turn off the power, the job saved on the hard disk will be deleted.

3 Locked Print files will not appear on the display panel if they have already
been printed or deleted using Web Image Monitor before you select [Locked
Print] using the control panel.

O Locked Print files printed or deleted using Web Image Monitor after you have
selected [Locked Print] using the control panel will still appear on the display
panel. However, an error message will appear if you try to print or delete those
Locked Print files.

3 Print jobs are not saved on the hard disk in the following cases. You can check
the error log for jobs not saved.

* When there are 30 Sample Print and Locked Print jobs saved on the hard
disk.

* When the total number of pages saved on the hard disk exceeds 1,000
pages.

O You can identify the file you want to print by the user ID and the time when the
job was stored.

O After the Locked Print file is printed, the job in the printer is deleted automati-
cally.

3 Follow the procedure below to use this function with the PCL or RPCS printer
driver under Windows. If you want to use this function under Mac OS, see
p.300 “Using PostScript 3”.

=l Feference
For details about settings for the printer driver, see the printer driver Help.

Files specified for Locked Print can be printed or deleted using Web Image
Monitor. For details, see Web Image Monitor Help.

Sending Print Job to the Printer

ﬂ From an application, select a command to print.
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The [Print] dialog box appears.

EI Select the printer you want to use in the [Name] list, and then click [Prop-
erties].

EJ in the [Job Type:] box, click [Locked Print].

ﬂ In the [User ID:] box, enter a user ID using up to eight alphanumeric char-
acters.
This is used to identify the user. The user ID can be entered using up to eight
alphanumeric (a-z, A-Z, 0-9) characters.

B In the [Password:] box, enter a four to eight digit password (0-9).

B Execute a command to print.
The job is saved on the hard disk.
ﬂ Enter the password using the control panel, and then specify whether to
print or delete the job.
=l Feference
p.113 “Entering a Password”
p.114 “Deleting a Locked Print File”

Entering a Password

ﬂ Press the [Menu] key.
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The [Menu] screen appears.

ﬂ Press the [A) or [ V] key to display [Locked Print], and then press the [#
Enter] key.

B Press the [A] or [ V] key to display [Print One File], and then press the [#
Enter] key.

The user ID and the time when the job was stored appear.
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ﬂ Press the [4A] or [ V] key to display the file you want to print, and then
press the [# Enter] key.

B Enter the password. Press the [4A] or [ V] key to enter the leftmost digit
of the password, and then press the [# Enter] key.

E The next digit appears.

ﬂ Repeat steps to enter all the digits of the password, and then press the
[# Enter]) key.

To cancel printing, press the [Escape] key.

8 Check that the file you want to print is displayed, and then press the [#
Enter) key.

ﬂ Press the [# Enter] key.

The " Go to Menu, then ->[Esc] to print " message appears. Then the docu-
ment selection screen reappears.

After the job is printed, the job saved on the hard disk is deleted.

[[D Press the [Online] key.
The initial screen appears.

Deleting a Locked Print File
Deleting a selected file only

I] Press the [Menu] key.
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The [Menu] screen appears.

EI Press the [A) or [ V] key to display [Locked Print], and then press the [#
Enter) key.

8 Press the [A] or [ Y] key to display [Delete One File], and then press the [#
Enter) key.
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The user ID and the time when the job was stored appear.

ﬂ Press the [A] or [ V] key to display the file you want to delete, and then

press the [# Enter] key.

To cancel deleting a Locked Print file, press the [Escape] key.

B Check that the file you want to delete is displayed, and then press the [#

Enter] key.

B Press the [Online] key.
The initial screen appears.

Deleting all files

[I Press the [Menu] key.
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The [Menu] screen appears.

ﬂ Press the [A) or [ V] key to display [Locked Print], and then press the [#

Enter] key.

B Press the [A] or [ V] key to display [Del. All Files], and then press the [#

Enter] key.

The user ID and the time when the job was stored appear.

ﬂ Press the [4A] or [ V] key to confirm deleting all files, and then press the

[# Enter]) key.

To cancel deleting a Locked Print file, press the [Escape] key.

B Press the [# Enter] key.

B Press the [Online] key.
The initial screen appears.
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Checking the Error Log

When a print job is not saved on the hard disk, it remains in the error log and can
be checked using the control panel.

® @ | mportant

3 The latest 50 error files are stored in the error log. If a new error file is added
when there are 50 error files already stored, the oldest file is deleted. Howev-
er, if the oldest error file is a sample print file, it is not deleted, but stored in-

stead in the sample print error log until the number of sample print error files
reaches 20.

3 If you turn off the power, the logs will be deleted.

I] Press the [Menu] key.
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The [Menu] screen appears.

B Press the [A] or [ V] key to display [Locked Print], and then press the [#
Enter] key.
The user ID and the time when the job was stored appear.

B Press the [A] or [ V] key to display [Error File(s)], and then press the [#
Enter) key.

ﬂ Press the [A] or [ V] key to check the log.
To print error files, either print or delete the file saved on the hard disk, and
then print the file from the computer again.

B When you finish checking the error log, press the [Escape] key.
The Locked Print job selection screen appears.

E Press the [Online) key.
The initial screen appears.
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Hold Print

Use this function to print documents that have been temporarily stored in this
printer by performing either the control panel or computer operation.

b d | mportant
3 To use this function, the hard disk must be installed on the printer.

O The number of pages the printer can save varies depending on the print im-
age content. At most, the printer can store 100 jobs or 1,000 pages for Hold
Print and Stored Print. At most, the printer can store a maximum of 9000 pag-
es for a single job.

 The saved documents sent to the printer are not deleted unless you select
[Auto Del. Temp] or [Auto Del. Stored]. For details, see “Auto Del. Temp” or “Auto
Del. Stored”.

3 Hold Print files will not appear on the display panel if they have already been
printed or deleted using Web Image Monitor before you select Hold Print us-
ing the control panel.

3 Hold Print files printed or deleted using Web Image Monitor after you have se-
lected [Hold Print] using the control panel will still appear on the display panel.
However, an error message will appear if you try to print or delete those Hold
Print files.

3 Print jobs are not saved on the hard disk in the following cases. You can check
the error log for jobs not saved.

e When there are 30 Hold Print and Stored Print jobs saved on the hard disk.
* When the total number of pages saved on the hard disk exceeds 1,000
pages.

3 You can identify the file you want to print by the user ID and the time when the
job was stored.

3 After the Hold Print file is printed, the job in the printer is deleted automatically.

3 Follow the procedure below to use this function with the PCL printer driver or
RPCS printer driver under Windows. If you want to use this function under
Mac OS, p.300 “Using PostScript 3”.

=l Feference
For details about settings for the printer driver, see the printer driver Help.

Files specified for Hold Print can be printed or deleted using Web Image Mon-
itor. For details, see Web Image Monitor Help.

Hold Print Job to the Printer

[I From an application, select a command to print.
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The [Print] dialog box appears.

EI Select the printer you want to use in the [Name] list, and then click [Prop-

erties].

Ed in the [Job Type:] box, click [Hold Print].

ﬂ In the [User ID:] box, enter a user ID using up to eight alphanumeric char-

acters.

This is used to identify the user. The user ID can be entered using up to eight
alphanumeric (a-z, A-Z, 0-9) characters.

You can assign a filename to a saved document, but it is not mandatory.

B Execute a command to print.

The job is saved on the hard disk.

=l Reference
p.113 “Entering a Password”

p.114 “Deleting a Locked Print File”

Print Using the Control Panel

ﬂ Press the [Menu] key.

Farry Feerl
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The [Menu] screen appears.

ﬂ Press the [A] or [ V] key to display [Hold Print], and then press the [# En-

ter] key.

B Press the [A] or [ V] key to display [Print One File], and then press the [#

Enter] key.

The user ID and the time when the job was stored appear.
To cancel printing, press the [Escape] key.

ﬂ Press the [A) or [ V] key to display the file you want to print, and then

press the [# Enter] key.
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The " Go to Menu, then ->[Esc] to print " message appears. Then the docu-
ment selection screen reappears.

After the job is printed, the job saved on the hard disk is deleted.

B Press the [Online] key.
The initial screen appears.

Deleting a Hold Print File

Deleting a selected file only

ﬂ Press the [Menu] key.
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The [Menu] screen appears.

g Press the [A] or [ V] key to display [Hold Print], and then press the [# En-
ter] key.

B Press the [4A] or [ V] key to display [Delete One File], and then press the [#
Enter) key.
The user ID and the time when the job was stored appear.

ﬂ Press the [A] or [ V] key to display the file you want to delete, and then
press the [# Enter] key.
To cancel deleting a Hold Print file, press the [Escape] key.

B Check that the file you want to delete is displayed, and then press the [ #
Enter) key.

E Press the [Online) key.
The initial screen appears.
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Deleting all files

I] Press the [Menu] key.
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The [Menu] screen appears.

ﬂ Press the [A] or [ V] key to display [Hold Print], and then press the [# En-
ter] key.

B Press the [A] or [ V] key to display [Del. All Files], and then press the [#
Enter] key.
The user ID and the time when the job was stored appear.

ﬂ Press the [4A] or [ V] key to confirm deleting all files, and then press the
[# Enter] key.
To cancel deleting a Hold Print file, press the [Escape] key.

B Press the [# Enter] key.

B Press the [Online) key.
The initial screen appears.

Checking the Error Log

When a print job is not saved on the hard disk, it remains in the error log and can
be checked using the control panel.

® @ | mportant

3 The latest 30 error files are stored in the error log. If a new error file is added
when there are 30 error files already stored, the oldest file is deleted. Howev-
er, if the oldest error file is a sample print file, it is not deleted, but stored in-
stead in the sample print error log until the number of sample print error files
reaches 30.

3 If you turn off the power, the logs will be deleted.
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ﬂ Press the [Menu] key.
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The [Menu] screen appears.

B Press the [A] or [ V] key to display [Hold Print], and then press the [# En-
ter] key.
The user ID and the time when the job was stored appear.

B Press the [A] or [ V] key to display [Error File(s)], and then press the [#
Enter] key.

ﬂ Press the [A] or [ V] key to check the log.

To print error files, either print or delete the file saved on the hard disk, and
then print the file from the computer again.

B When you finish checking the error log, press the [Escape] key.
The Locked Print job selection screen appears.

B Press the [Online) key.
The initial screen appears.
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Stored Print

This function stores documents in the machine. Printing is then possible using a
control panel or computer operation.

b d | mportant
3 To use this function, the hard disk must be installed on the printer.

O The number of pages the printer can save varies depending on the print im-
age content. At most, the printer can store 100 jobs or 1,000 pages for Hold
Print and Stored Print. At most, the printer can store a maximum of 9000 pag-
es for a single job.

 The saved documents sent to the printer are not deleted unless you select
[Auto Del. Temp] or [Auto Del. Stored]. For details, see “Auto Del. Temp” or “Auto
Del. Stored”.

O Stored Print files will not appear on the display panel if they have already been
printed or deleted using Web Image Monitor before you select Stored Print us-
ing the control panel.

O Stored Print files printed or deleted using Web Image Monitor after you have
selected [Stored Print] using the control panel will still appear on the display
panel. However, an error message will appear if you try to print or delete those
Stored Print files.

3 Print jobs are not saved on the hard disk in the following cases. You can check
the error log for jobs not saved.

e When there are 30 Stored Print and Stored Print jobs saved on the hard
disk.

e When the total number of pages saved on the hard disk exceeds 1,000
pages.

O You can identify the file you want to print by the user ID and the time when the
job was stored.

O After the Stored Print file is printed, the job in the printer is deleted automati-
cally.

3 Follow the procedure below to use this function with the PCL printer driver or
RPCS printer driver under Windows. If you want to use this function under
Mac OS, p.300 “Using PostScript 3”.

= Feference
For details about settings for the printer driver, see the printer driver Help.

Files specified for Stored Print can be printed or deleted using Web Image
Monitor. For details, see Web Image Monitor Help.
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Stored Print Job to the Printer

ﬂ From an application, select a command to print.
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Name] list, and then click [Prop-
erties].

B In the [Job Type:] box, click [Save to Printer].
ﬂ In the [User ID:] box, enter a user ID using up to eight alphanumeric char-

acters.

This is used to identify the user. The user ID can be entered using up to eight
alphanumeric (a-z, A-Z, 0-9) characters.

You can assign a password and filename to a saved document, but both are
not mandatory.
B Execute a command to print.
The job is saved on the hard disk.
=l Feference
p.113 “Entering a Password”
p.114 “Deleting a Locked Print File”

Print Using the Control Panel

ﬂ Press the [Menu] key.
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The [Menu] screen appears.

8 Press the [A] or [ V] key to display [Stored Print], and then press the [#
Enter) key.

B Press the [A] or [ V] key to display [Print One File], and then press the [#
Enter) key.
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The user ID and the time when the job was stored appear.
To cancel printing, press the [Escape] key.

ﬂ Press the [A) or [ V] key to display the file you want to print, and then
press the [# Enter] key.

The " Go to Menu, then ->[Esc] to print " message appears. Then the docu-
ment selection screen reappears.

If a password is assigned to the document, a password entry screen appears.
Enter the password.

B Press the [Online] key.
The initial screen appears.

Deleting a Stored Print File
Deleting a selected file only

ﬂ Press the [Menu] key.
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The [Menu] screen appears.

ﬂ Press the [A] or [ V] key to display [Stored Print], and then press the [#
Enter] key.

B Press the [4A] or [ V] key to display [Delete One File], and then press the [#
Enter] key.
The user ID and the time when the job was stored appear.

ﬂ Press the [A] or [ V] key to display the file you want to delete, and then
press the [# Enter] key.
To cancel deleting a Stored Print file, press the [ Escape] key.

B Check that the file you want to delete is displayed, and then press the [#
Enter) key.
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If a password is assigned to the document, a password entry screen appears.
Enter the password.

E Press the [Online) key.
The initial screen appears.

Deleting all files

ﬂ Press the [Menu] key.
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The [Menu] screen appears.

B Press the [A] or [ V] key to display [Stored Print], and then press the [#
Enter) key.

B Press the [A] or [ V] key to display [Del. All Files], and then press the [#
Enter) key.

The user ID and the time when the job was stored appear.

ﬂ Press the [4] or [ V] key to confirm deleting all files, and then press the
[# Enter]) key.

To cancel deleting a Stored Print file, press the [ Escape] key.

B Press the [# Enter] key.

If a password is assigned to the document, a password entry screen appears.
Enter the password.

B Press the [Online] key.
The initial screen appears.

Checking the Error Log

When a print job is not saved on the hard disk, it remains in the error log and can
be checked using the control panel.
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b d | mportant

O The latest 30 error files are stored in the error log. If a new error file is added
when there are 30 error files already stored, the oldest file is deleted. Howev-
er, if the oldest error file is a sample print file, it is not deleted, but stored in-
stead in the sample print error log until the number of sample print error files
reaches 30.

3 If you turn off the power, the logs will be deleted.

ﬂ Press the [Menu] key.

The [Menu] screen appears.

B Press the [A] or [ V] key to display [Stored Print], and then press the [#
Enter) key.
The user ID and the time when the job was stored appear.

B Press the [A] or [ V] key to display [Error File(s)], and then press the [#
Enter] key.

ﬂ Press the [A] or [ V] key to check the log.

To print error files, either print or delete the file saved on the hard disk, and
then print the file from the computer again.

B When you finish checking the error log, press the [Escape] key.
The Locked Print job selection screen appears.

B Press the [Online] key.
The initial screen appears.

126



Other Print Operations

Form Feed

This message appears when the paper tray is empty, or when the paper in the
paper tray is not of the same size or form as that specified by the printer driver.
You can form feed using tray.

[I Press the [Form Feed] key, and then select the paper tray on the screen.

EI Press the [# Enter] key.
The job is printed from the selected tray.
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Canceling a Print Job

You can cancel printing from either the printer or a client computer. Since can-
celing procedures vary depending on the print job status, check the job status
and cancel printing according to the following procedure.

Windows - Canceling a Print Job

® @ | mportant
O When the printer is connected to multiple computers, be careful not to acci-
dentally cancel other users' print jobs.

If the print job you want to cancel is being printed

[I Check if the print job you want to cancel is currently being printed.

While the print job may not be being printed, the printer is receiving data if the
Data In indicator is lit or blinking.

8 Press the [Job Reset] key.
The [Job Reset?] screen appears.

B Select the current job or all jobs (including the current job) using the [4 ]
or [ V] key.

It is also possible to annul the cancellation. Printing resumes if you select [Re-
sume Print], and then press the [# Enter] key.

ﬂ Press the [# Enter] key.
A confirmation message appears.
Printing resumes if you press the [Escape] key after the message appears.

B Press the [# Enter] key.

The job is canceled. When the cancellation procedure is complete, a mes-
sage appears.

3 A print job that contains a large volume of data may take considerable time
to cancel.

3 If printing resumes after being canceled, the period of time set for [I/O Tim-
eout] is too short. Set a longer period of time for [I/O Timeout] on the [Host
Interface] menu.
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If the print job you want to cancel is not being printed

ﬂ Double-click the printer icon on the Windows task tray.

A window appears showing all print jobs that are currently queuing to be print-
ed. Check the current status of the job you want to cancel.

You can also open the print job queue window by double-clicking the printer
icon in the [Printer] window.

EI Select the name of the job you want to cancel.

B On the [Document] menu, click [Cancel Printing].

O When this printer is used as a network printer, other users' print jobs cannot
be canceled from a client computer.

3 Clicking [Purge Print Documents] on the [Printer] menu deletes all currently
queued print jobs. However, when this printer is used as a network printer,
print jobs from other users' computer cannot be canceled from a client
computer.

3 When the print job you selected starts printing, it takes some time before
the print job disappears from the printer window.

Mac OS - Canceling a Print Job

b d | mportant
O When the printer is connected to multiple computers, be careful not to acci-
dentally cancel other users' print jobs.

If the print job you want to cancel is being printed

I] Check if the print job you want to cancel is currently being printed.

While the print job may not be being printed, the printer is receiving data if the
Data In indicator is lit or blinking.

B press the [Job Reset] key.
[Job Reset?] screen appears.

B Select the current job or all jobs (including the current job) using the [4A ]
or [ V] key.
It is also possible to annul the cancellation. Printing resumes if you select [Re-
sume Print], and then press [# Enter] key.

ﬂ Press the [# Enter] key.
A confirmation message appears.
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Printing resumes if you press the [Escape] key after the message appears.

B Press the [# Enter] key.

The job is canceled. When the cancellation procedure is complete, a mes-
sage appears.

3 A print job that contains a large volume of data may take considerable time
to cancel.

3 To secure enough time for sending a command to cancel printing, set a
long period of time in [I/O Timeout] on the [Host Interface] menu.

If the print job you want to cancel is not being printed

ﬂ Double-click the printer icon on the desktop.

A window appears showing all print jobs that are currently queuing to be print-
ed. Check the current status of the job you want to cancel.

Under Mac OS X, start Print Center.
ﬂ Select the name of the job you want to cancel.

8 Click the pause icon, and then click the trash icon.

O When this printer is used as a network printer, other users' print jobs cannot
be canceled from a client computer.
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Caution During Printing

Staple and Punch Position

By installing the 2 tray finisher or booklet finisher, you can staple one set at a time
when printing multiple copies. See the Help files of the printer driver for details
about print methods.

H
O The printer cannot staple paper fed from the bypass tray.
b d | mportant

O To use these functions, at least 320 MB of RAM, or the hard disk must be in-
stalled on the printer.

O Staple output depends on print and feed direction. The following table shows
possible staple positions:

+ Staple Position
e 2 tray finisher

Dif:?m ﬁmn Staple Position
A'A A A
Portrait e
D A A A
= ‘A A A
Landscape] A A A
A
AAAA
Partrait ,
‘A A A
[
‘A A A,
Landscape| ‘A A A
n
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¢ Booklet finisher

Dil::;jun ﬁﬂilun Staple Position
A AA A
Portrait | .
D A A A
- A A A
Landscape| A A A
A
A A A AA
Portrait . 1P
— A A A A
-— ' A
.A A. A
Landscape .
._A_ ,A. A
A A

O When two-sided printing is selected, adjust the staple position to the bind-

ing direction.

3 If you are punching at the same time, specify the same side.
O The paper sizes and number of pages that can be stapled are displayed

below.

e 2 tray finisher
Paper Size Staple Capacity
A3, 11" x 17”, B4, Legal, 8" x 13", 8'/2” x 30
13”, 81/, x 137, 8K
50

A4, B5, Letter, 7'/4” x 10'/»", 16K

¢ Booklet finisher

A4, B5, Letter

Paper Size Staple Capacity
A3, 11" x 177, B4, Legal 25
50

If “2 at center” is selected, maximum of 10 pages can be stapled.
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Punching

Used to punch holes in pages.

Y Limitation_|

3 The printer cannot punch paper fed from the bypass tray.

O To use this function, the 2 tray finisher or booklet finisher must be installed on

the printer.

O Punch positions depend on print and feed direction. The following table shows
possible punch positions:

« Punch Position

Fesad Print Punch Position

Daraction| direction 2 holes 3 holas 4 holas
Poet | LA A, A A A A

- Landscapa ‘_ﬁ. 'ﬁ‘ A
Forrait | A A A

[/
Landscapel . A | A A A: i

O When duplex print is selected, adjust the punch position to the binding di-

rection.

O Paper sizes that can be punched are displayed below.

% 2 tray finisher

Type Feed Direction Paper Size
0 A4, A5, B5, 16K, Letter
e
2 holes L A3, B4, A4,B5,8K, 11"x 17",
e

16K, Legal, Letter, 77/4” x

101/21” 81/2” X 131!, 81/4” X 13!1,

8” X 13!!
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Type Feed Direction Paper Size
D A4, B5, 16K, Letter
F
NA 3 holes
= A3, B4, 8K, 11" x 17"
e
] A4, B5, 16K, Letter
e
EU 4 holes
= A3, B4, 8K, 11" x 17”
F
L A4, B5, A5, 16K, Letter
e
Northern EU 4 holes o A3, B4, A4, B5, 8K, 16K, 11
. x 177, Legal, 8 /2" x 13", 8
7,7 x 137, 8" x 137, Letter,
74" x 101/y”
«» Booklet finisher
Type Feed Direction Paper Size
K A4, Letter
e
NA 2 holes
= A3, A4, B5, 11" x 17", Legal,
- Letter
U A4, Letter
e
NA 3 holes
o A3, 11" x 17
e
[ A4
F
EU 2 holes
= A3, B4, A4, 11" x 17", Legal,
« Letter
[ A4
e
EU 4 holes
= A3
F
U A4, B5, Letter
e
Northern EU 4 holes
(Y A3, B4, A4, 11" x 17", Legal,
« Letter
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Collate

The Collate function allows you to print while sorting printouts into page-ordered
sets, such as when printing multiple copies of meeting materials.

= Feference
For details about collate and job separation, see the printer driver Help.

« Collate
Output can be assembled as sets in sequential order.

3300

% Shift Collate
This function requires the optional 2 Tray Finisher. This function offsets prints,
allowing you to easily identify separate jobs.

NE

For printing methods, see the printer driver Help.

¥ d |mportant

O To use these functions, at least 320 MB of RAM, or the hard disk must be in-
stalled on the printer.

3 Up to 150 pages can be sorted using RAM. If the hard disk drive is installed,
up to 1,000 pages can be sorted.

Spool Printing

With Spool Printing, the print data is saved in the hard disk before printing. To
use this function, set it from the menu. See p.240 “spoolsw”.

¥ d |mportant

3 Do not turn off the printer or the computer when a print job is being spooled
and the Data In indicator is blinking. The print job will remain in the hard disk
and be printed when the printer is turned on. The setting can be changed us-
ing the “spoolsw clear job” command on the telnet

O The Spool Printing function is available when the hard disk is installed.
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3 The Spool Printing function is available for data received using diprint, lpr, ipp,
ftp, and smb.

3 When using diprint, the Spool Printing function cannot be used with bidirec-
tional communication.

3 The domain reserved for spool printing is about 1 GB.

3 When Spool Printing is on, the size of a single print job cannot exceed 500
MB.

3 When sending print jobs spooled from several computers, up to one diprint
job, 10 Ipr jobs, one ipp job, one ftp job, and one smb job can be spooled. Jobs
exceeding this spooling capacity cannot be executed. It is necessary to wait
to add new jobs.

3 First pages takes longer to print when using spool printing.

3 With Spool Printing, the computer is freed from print processing earlier, even
when processing a large amount of data.

3 Spool jobs stored in the printer can be viewed or deleted using Web Image
Monitor.

= Reference

For information about the “spoolsw clear job” command on the telnet, see
p.240 “spoolsw”.

Setting Spool Printing

Spool printing settings can be made using telnet or Web Image Monitor.

* Using Web Image Monitor
In the[Device Settings] on the [Configuration] menu, click [System].
For details, see Web Image Monitor Help.

¢ Using telnet
Enter “spoolsw spool on”.
For details, see p.240 “spoolsw”.

Checking or deleting spooled jobs using Web Image Monitor

Follow the procedure below to check or delete spooled jobs using Web Image
Monitor.

ﬂ Open a Web browser.

B Enter “http: //(printer's address)/” in the address bar to access the print-
er whose settings you want to change.

Top Page of Web Image Monitor appears.

B Click [Login].
The dialog box for entering the user name and password appears.
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ﬂ Enter the user name and password, and then click [OK].
For details about the password, consult your network administrator.

B In the menu area, click [Job].
A submenu will appear.

B On the [Printer] menu, click [Spool Printing].
A list of spooled jobs appears.

ﬂ To delete a job, select the check box of the job you want to delete, and
then click [Delete].
The selected job is deleted.

B Quit Web Image Monitor.
=l Feference
For details, see Web Image Monitor Help.

Cover

Using this function, you can insert cover fed from a different tray to the body of
the document, and print on them.

b d | mportant

3 To use this function, Collate must be set. Rotating Collate can not be set.

 The cover sheets should be the same size and orientation as the body of the
paper.

O If Auto Tray Select is set as the paper feed tray for the body paper, the paper
will be delivered from a tray containing paper from a tray containing paper in
the portrait direction. Therefore, if the cover paper is set to landscape orien-
tation, the orientation cover and body will be different.

=l Feference
For printing methods, see the printer driver Help.
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Slip Sheets

% Inserting a slip sheet between each page

% Inserting a slip sheet between OHP transparencies

ey
D

1H =11

3 Collate cannot be set when using slip sheets.
3 Slip sheets cannot be inserted while duplex and cover printing.
3 The slip sheet should be the same size and orientation as the main paper.

Memory Capacity and Paper Size

Printable paper sizes and print resolutions vary depending on memory capacity.

Also, printing may or may not be supported in the same condition under certain
printing modes. This machine contains the standard 256 MB of memory, but par-
ticular printing conditions may require more memory.
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+ Typical memory requirements for correct printing

Resolution Paper size One-sided printing Duplex printing
Mainly text | Mainly photo- | Mainly text | Mainly photo-
graph graph
1200 dpi x A3 (297 x Standard +64 MB rec- | Standard +256 MB rec-
1200 dpi 457) (256 MB) ommended | (256 MB) ommended
DLT (11" x
177)
B4 (257 x Standard +128 MB rec-
367) (256 MB) ommended
A4 (210 x +64 MB rec-
297)/Letter ommended
(812" x 11"
Legal (8'/2 x
147)
B5 (182 x Standard
257) (256 MB)
A5 (148 x
210)
1200 dpi x A3 (297 x Standard Standard Standard +64 MB rec-
600 dpi 457) (256 MB) (256 MB) (256 MB) ommended
DLT (11" x
177)
B4 (257 x Standard
367) (256 MB)
A4 (210 x
297)/Letter
(81" x 117

Legal (8'/> x
14”)

B5 (182 x
257)

A5 (148 x
210)
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Resolution Paper size One-sided printing Duplex printing
Mainly text | Mainly photo- | Mainly text | Mainly photo-
graph graph

600 dpix 600 | A3 (297 x Standard Standard Standard Standard
dpi 457) (256 MB) (256 MB) (256 MB) (256 MB)
300dpix300 [ pLT (117 x
dpi 17”)

B4 (257 x

367)

A4 (210 x

297)/Letter

(812" x 11"

Legal (8'/2 x

147)

B5 (182 x

257)

A5 (148 x

210)

O Two-sided printing is not possible on 12” x 18", postcard-size sheets, and
for long printing.

O3 If the bypass tray is used for printing, any duplex printing instruction is reset
regardless of memory capacity, and the document is printed in one-sided
mode.
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Direct Printing from a Digital Camera (PictBridge)

What is PictBridge?

You can connect a PictBridge-compatible digital camera to this machine using a
USB cable. This allows you to print photographs taken using the digital camera
directly by operating the digital camera.

BALIESS

Before you can use this function, the printer requires the following options:
e USB host interface board
e Camera direct print card
O Check your digital camera is PictBridge-compatible.
=l Feference
For details about installing these options, see the Setup Guide.

O Up to 600 images can be sent from the digital camera to the printer during one
print transaction. If an attempt is made to send more images, an error mes-
sage is sent to the camera and printing fails.

O Since printing conditions are specified on the digital camera, specifiable pa-
rameters depend on the particular digital camera. For details, see your digital
camera's manual.

3 This function is compatible with USB 1.1.

G1307502_1.00 Copyright © 2005
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PictBridge Printing

Follow the procedure below to start PictBridge printing on this machine.
I] Check the printer and the digital camera are both switched on.

B Connect a USB cable between the optional USB host interface board in-
stalled on the print and the digital camera.

The Data In indicator on the printer blinks for several seconds and "PctBrdg"
is displayed on the printer. This indicates the printer recognizes the digital
camera as a PictBridge device.

O Some digital cameras require settings for manual PictBridge operation. For
details, see your digital camera's manual.

B On your digital camera, select the images you want to print, and specify
the printing conditions.

O Since printing conditions are specified on the digital camera, specifiable
parameters depend on the particular digital camera. For details, see the
digital camera's manual.

ﬂ The printer receives settings from the digital camera and starts printing.

® @ | mportant

3 Do not disconnect the USB cable while data is being sent. If you do, print-
ing will fail.

=l Feference
To stop data printing, see p.128 “Canceling a Print Job”.
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What Can Be Done on This Machine

This machine can perform the following functions using its PictBridge feature.
The settings available for these functions are as follows:
¢ Index printing
e Trimming
¢ Date and file name printing
* Paper size
* Image print size
¢ Multiple-image printing
* Printing quality
¢ Color matching
e Form printing
e Camera memo printing
b d | mportant
O This machine does not support the following settings:
e DPOF printing
* Margin-less printing
* Paper type specification

O The setting parameters and their names may vary depending on the digital
camera. For details, see your digital camera's manual.

Index Printing

Paper Size Horizontal | Paper orien-
images x tation
vertical im-

ages (in)

A3 (297 x 12" x 16” L)

420) 16" x 12" [

A4 (210 x 8" x 12" U

497) 12" x 8” =

A5 (148 x 5" x 8" I

210) P =

Letter (8'/2"x | 8" x 10 )

1 1”) 10!) X 8!) D
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Paper Size Horizontal | Paper orien-
images x tation
vertical im-
ages (in)
B4 (257 x 10" x 14" [
367) 14" x 10” [

O Index printouts vary depending on the orientation of the paper placed on the
specified size tray.

O Depending on the digital camera, a form feed may be inserted after one set of
images belonging to one type ends.

Trimming

Use this function to print only the inside of the trimming area specified on the dig-
ital camera.

" - Trimming area

Date and File Name Printing

Use this function to print the date and/or file name under the image.
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"' In the above figure, "aaaaa" indicates the file name and "bbbbb" indicates the date.

Use this function to print on paper with the size specified on the digital camera.

Paper Size
Paper size name Actual size
2L (5" x 77) L 178 mm x 127 mm (5
in. x7in.)
Postcard 148 mm x 100 mm
100 mm x 150 mm - | 150 mm x 100 mm
4"x 6" 152.4 mm x 101.6
mm (4 in. X 6 in.)
8"x 10" L 254 mm x 203.2 mm

(8in.x10in.)

Letter (8 /o x 11)

279.4 mm x 216 mm
(8 /2 x11)

11" x 17" 431.8 mm x 279.4
mm (11in. x 17in.)

A3 420 mm x 297 mm
A4 297 mm x 210 mm
A5 210 mm x 148 mm
A6 148 mm x 105 mm
B4 364 mm x 257 mm
B5 L 257 mm x 182 mm
B6 182 mm x 128 mm

"I Specify Undefined Size for the 2L (5" x 7"), 100 mm x 150 mm, 4" x 6", 8" x 10", AB,

B5, and B6 sizes.
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O For details about methods of specifying undefined sizes, see Maintenance

Guide.

Image Print Size

Use this function to print images with the size specified on the digital camera.

"I -~ Image size specified on the camera
You can specify the following image print sizes:

Fixed size

325"x25"

5"x25"

6||X4||

7IIX5II

-10||X8|l

254 mm x 178 mm

110 mm X 74 mm

89 mm x 55 mm

148 mm x 100 mm

8cmx 6cm

10cm x 7 cm

13cm x 9cm

15ecmx 10 cm

18 cm x 13 cm

21cmx 15¢cm

24 cm x 18 cm
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3 An error occurs if the specified size is larger than the actual paper size.

Print Number of Pages

Use this function to print multiple images on the specified paper.

P

)

The number of images that can be printed on one page is as follows:

A

Paper size Number of images
that can be specified
2L (5" x7") 2,4,8,9
Postcard 2,4
100 mm x 150 mm 2,4
4" x 6" 2,4,8,9
8" x 10" 2,4,8,9, 16, 25, 32

Letter (8'/2" x 117)

2,4,8,9, 16, 25, 32

117" x 177

2,4,8,9,16, 25, 32,
49, 64

A3 2,4,8,9,16, 25, 32,
49, 64

A4 2,4,8,9,16, 25, 32

A5 2,4,8,9,16

A6 2,4,8

B4 2,4,8,9,16, 25, 32,
49

B5 2,4,8,9,16,25

B6 2,4,8,9

The number and arrangement of images that can be specified are as follows:
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Number of | Vertical im- | Paper orien-
images ages x hori- tation
zontal
images
2 2x1 E
4 2x2 =
8 4x2 E
9 3x3 =
16 4x4 =
25 5x5 =
32 8 x4 D
36 6x6 [y
49 7x7 =
64 8x8 =

O A form feed may be inserted between images depending on the digital camera
in use.

O Printing in the specified way may not be possible depending on the specifica-
tion for the number of images to be printed.
Printing Quality

Use this function to print images at the selected printing quality.
If you select [Default] or [Normal], the printer prints at 1200 dpi x 600 dpi (1 bit); if

you select [Fine], the printer prints at 1200 dpi x 1200 dpi (1 bit).
Color Matching

Use this function to optimize colors when printing images.

If you select [Default] or [OFF], the printer prioritizes gradation for color matching,
if you select [ON], the printer prioritizes saturation.

Form Printing

Use this function to print images in a predetermined layout format.
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Camera Memo Printing

Use this function to print text data together with an image if it is attached to the
image.
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Exiting PictBridge

Follow the procedure below to quit PictBridge mode.
I] Check the control panel of this machine is displaying the "Ready" state.

B Disconnect the USB cable from the machine.

® @ | mportant
3 Do not disconnect the USB cable while data is being sent to the printer. If
you do, printing will fail.
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Troubleshooting

Symptom

Remedy

PictBridge cannot be
used.

Follow the steps be-
low:

1. Disconnect and
then reconnect the
USB cable.

2. Check the Pict-
Bridge configuration
is correct.

3. Disconnect the
USB cable, switch
off the printer and
then switch it on
again. Check the
printer is ready, and
then reconnect the
USB cable.

When more than one
digital camera is
connected, the print-
er does not recog-
nize the second and
subsequent digital
cameras.

Only one digital
camera can be con-
nected to the printer.
Do not connect more
than one digital cam-
era.

Printing is impossi-
ble.

You can specify up
to 600 images to be
printed in one print
transaction. To print
more images, use
more than one print
transaction.
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Other Reference Information

For further details about printing on this machine, see the following:
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Making Printer Settings Using the Control Panel

Menu Chari

This section explains how to change the default settings of the printer and pro-

vides information about the parameters included in each menu.

% Sample Print

O Appear only when the hard disk is installed.

3 For details, see p.107 “Sample Print”.

< Locked Print

O Appear only when the hard disk is installed.

O For Details, see p.112 “Locked Print”.

< Hold Print

O Appear only when the hard disk is installed.

O For Details, see p.117 “Hold Print”.

< Stored Print

O Appear only when the hard disk is installed.

O For Details, see p.122 “Stored Print”.

«+ Paper Input

Menu

Bypass Size

Tray Paper Size

Paper Type

Aut. Tray Select

Tray Priority

% List/Test Print

Menu

Config.P/Er.Log

Config. Page

Error Log

Menu List

G1307502_1.00
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Menu

Color Demo Page

PCL Config.Page

PS Config. Page

PDF Config.Page

Hex Dump

Operations Test

Maintenance

Menu

Color Calibrate

Color Regist.

Image Density

Registration

Plain Paper

Thick Paper

Specisal Paper

Del. All Temp

Del. All Stored

HD Format

4C. Graphic Mode

Fuser Temperat.

Replacmnt Alert

Date/Time

WL.LAN Signal

WL.LAN Defaults

Key Repeat

Erase All Mem.

System

Menu

Prt. Err Report

Auto Continue

Memory Overflow

Copies

Printer Lang.
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Menu

Sub Paper Size

Page Size

Edge-Edge Print

Def.Print Lang.

Duplex

Blank Pages

Output Tray

Job Separation

Energy Saver 1

Energy Saver 2

Auto Reset Time

Auto Del. Temp

Auto Del. Stored

Unit of Measure

B&W Page Detect

Spool Printing

Letterhead Mode

Bypass Priority

Tray Switching

RAM Disk

Notify by E-malil

O Auto Del. Temp, Auto Del. Stored and [Spool Printing] appears when the

hard disk is installed.

(3 [RAM Disk] will not appear when the hard disk is installed.

+ Host Interface

Menu

I/0 Buffer

I/O Timeout

Network Setup

IEEE 1394 Setup

IEEE 802.11b
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O [IEEE 1394 Setup] appears when the optional IEEE 1394 interface board is

installed.

O [IEEE 802.11b] appears when the optional IEEE 802.11b interface unit is in-

stalled.

< PCL Menu

Menu

Orientation

Form Lines

Font Source

Font Number

Point Size

Font Pitch

Symbol Set

Courier Font

Ext. A4 Width

Append CR to LF

Resolution

PS Menu

Menu

Data Format

Resolution

Color Setting

Color Profile

PDF Menu

Menu

PDF: Change PW

PDF Group PW

Resolution

Color Setting

Color Profile
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% Language

Menu

English

German

French

ltalian
Dutch
Swedish

Norwegian

Danish

Spanish

Finnish

Portuguese
Czech
Polish

Hungarian
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Paper Input Menu

This section explains about paper settings on the Paper Input menu such as pa-
per sizes and types on each tray.

Changing the paper input menu

Tray locking
Follow the procedure below to lock/unlock trays.

ﬂ Press the [Menu] key.

& Fom el ke Ty
£ __J3%%
e Job Rt Monu O
0 " T % O

The [Menu] screen appears.

B Press the [A] or [ V] key to display [Paper Input], and then press the [#
Enter) key.

B Press the [A) or [ V] key to display [Aut. Tray Select], and then press the
[# Enter] key.

ﬂ Press the [A] or [ V] key to display the tray to unlock, and then press
the [# Enter] key.

B Press the [4A ] or [ Y] key to display [Off], and then press the [ # Enter] key.
Wait for two seconds. The [Paper Input] screen appears.

E Press the [Online) key.
The initial screen appears.

Tray priority

Follow the procedure below to change the tray priority.
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ﬂ Press the [Menu] key.

o Fom feerl Dl o
=£0__J3v%
e Job R Moy O
05 7 % O ©

The [Menu] screen appears.

B Press the [A] or [ V] key to display [Paper Input], and then press the [#
Enter]) key.

El press the [A]) or [ V] key to display [Tray Priority], and then press the [#
Enter]) key.

ﬂ Press the [A] or [ Y] key to select a tray you want to use.

B Press the [# Enter] key.
Wait for two seconds. The [Paper Input] screen appears.

B Press the [Online] key.
The initial screen appears.

Paper Input menu parameters
This section explains about parameters that can be set on the Paper Input menu.

% Bypass Size
You can specify the paper size for Bypass tray.
For details about the size of paper loaded in the bypass tray, see “Paper and
Other Media Supported by This Printer”, Maintenance Guide.

% Tray Paper Size
Paper size for tray 2, 3, 4
When you select sizes that are not indicated on the paper size dial of tray 1,
tray 2 or tray 3, you should set the dial to “¥”, and then select the paper size
here.
For details about the size of paper loaded in each tray, see “Paper and Other
Media Supported by This Printer”’, Maintenance Guide.

3 Only the installed trays appear on the display panel.
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Paper Type

If you use various types of paper, select the paper type for tray 1, tray 2, tray
3, tray 4 or bypass tray.

For details about types of paper loaded in each tray, see “Paper and Other
Media Supported by This Printer’, Maintenance Guide.

% Tray1,2,3,4
Plain Paper, Recycled Paper, Special Paper, Color Paper, Letterhead,
Preprinted

% Bypass Tray
Plain Paper, Recycled Paper, Special Paper, Color Paper, Letterhead,
Preprinted, Transparency, Thick Paper

3 Default : Plain Paper
O Only the installed trays appear on the display panel.

Aut. Tray Select
If you select [Auto Tray Select], paper trays can be selected according to the
printer driver-specified paper size and type. Default is [On].

Tray Priority
You can set a tray to be checked first when [Auto Tray Select] is selected in [Pa-
per Source] from the printer driver.

e Tray 1, Tray 2, Tray 3, Tray 4
O Default : Tray 1
3 Only installed trays appear on the display panel.

3 Itis recommended that you load paper of the size and orientation you use
most frequently in the tray selected in [Tray Priority].
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List/Test Print Menu

You can print lists of configurations on printer or the paper printings.
Also, you can check the types and characters of all the printable fonts.

Printing a Configuration Page

Follow the procedure below to print the configuration page.

S @ | mportant

3 The configuration page is printed on A4 or Letter (8 '/» x 11) size paper, so
load them in the same paper tray.

ﬂ Press the [Menu] key.

i Fom fee Dl o
£ __J3%%
e Job Rt Monu O
0 T H e @

The [Menu] screen appears.

8 Press the [ Y] or [A ] key to display [List/Test Print], and then press the [#
Enter) key.

B Press the [ Y] or [ A] key to display [Config. Page], and then press the [#
Enter]) key.

The configuration page is printed. The test print menu screen returns on com-
pletion of printing.

ﬂ Press the [Online] key.
The initial screen appears.

Interpreting the configuration page

% System Reference

« Printer ID
The serial number assigned to the board by its manufacturer is displayed.
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< Firmware Version

e Firmware
The version number of the printer controller firmware is displayed.

* Engine
The version number of the printer engine firmware is displayed.

* NCS
The version number of the network interface firmware is displayed.

% Pages Printed
The total number of pages printed by the printer to date is displayed.

+ Total Memory
The total amount of SDRAM installed on the printer is displayed.

+ Controller Option
The items are displayed when the controller options are installed.

+ Printer Language
The version number of the printer language is displayed.

% Options
The options installed are displayed.

Consumption Status
The amount of toner remaining is displayed.

Paper Input
Settings made on the [Paper Input] menu are displayed.
=l Feference

For details, see p.158 “Paper Input Menu”.

Maintenance
Settings made on the [Maintenance] menu are displayed.

= Reference
For details, see p.165 “Maintenance Menu”.

System
Settings made on the [System] menu are displayed.

=l Feference
For more information, see p.171 “System Menu”.

Host Interface

Settings made on the [Host Interface] menu are displayed.

When DHCP is active on the network, the IP address, subnet mask and gate-
way address appear in parentheses on the configuration page.
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=l Feference
For details, see p.179 “Host Interface Menu”.
% PCL Menu
Settings made on the [PCL Menu] are displayed.
=l Feference
For details, see p.186 “PCL Menu”.
% PS Menu
Settings made on the [PS Menu] are displayed.
=l Feference
For details, see p.189 “PS Menu”.
% PDF Menu
Settings made on the [PDF Menu] are displayed.
=l Feference
For details, see p.191 “PDF Menu”.

« Interface Information
Interface information is displayed.

List/Test menu parameters

This section explains about parameters that can be set on the List/Test menu.

% Config.P/Er.Log
You can print the configuration page and error log.

% Config. Page
You can print the current configuration of the printer.

+ Error Log
You can print an error report.

+« Menu List
You can print a menu list showing all available menus.

« Color Demo Page
Select this to print the color sample.

% PCL Config.Page
You can print the current PCL configuration.

% PS Config. Page

You can print an resident PS3 font and the Disk Directory List which shows

the hard disk.
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% PDF Config.Page
You can print an resident PS3 font and the Disk Directory List which shows
the hard disk.

% Hex Dump
You can print the data sent by the computer using Hex Dump.

% Operations Test
Use this to check the printer and its options for operability, including paper
feed and output, as well as 2 Tray Finisher (optional) punching and stapling.
Only settings of installed options are displayed. If a specified function fails, the
printer displays a message and stops printing. If the test is successful, the
printer prints black frames.
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Maintenance Menu

You can set printing conditions such as density and calibration, and printer man-
agement such as formatting the hard disk unit.

Changing the maintenance menu
This section explains changing the maintenance menu using examples.

HD Format

Follow the procedure below to format the hard disk unit after initial setup.

ﬂ Press the [Menu] key.

s Fam Feerd Ol P
£0C__JS%%
o JobRem Monu O,__\
=0 T T % ©

The [Menu] screen appears.

ﬂ Press the [ Y] or [ 4] key to display [Maintenance], and then press the [#
Enter] key.

B Press the [ V] or [ 4] key to display [HD Format], and then press the [# En-
ter] key.

ﬂ Read the HD format confirmation message, and then press the [# Enter)
key to start formatting.
The hard disk unit is formatted, and the rebooting message appears.

BTurn off the printer's power. After a few seconds, turn the power on
again.

The hard disk unit is now formatted and ready to use.
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3 If the [HD Format] button is not displayed, the hard disk unit is not properly
installed. Reinstall the hard disk unit. For details about the hard disk unit,
see Setup Guide. If you cannot install it properly even after attempting re-
installation, contact your sales or service representative.

Displaying the signal strength

Follow the procedure below to check the IEEE 802.11b (wireless LAN) signal on
the [Maintenance] menu.

I] Press the [Menu] key.

i Form e Dl i
£0__JO%%
e JobRen Monu Of_\
0T T % G

The [Menu] screen appears.

EI Press the [ Y] or [ 4] key to display [Maintenance], and then press the [#
Enter) key.

8 Press the [ Y] or [ A ] key to display [WL.LAN Signal], and then press the [#
Enter) key.

Check the display for result.

ﬂ Press the [Escape] key.
The initial screen appears.

O If [WL.LAN Signal] is not displayed, [IIEEE 802.11b] has not been selected for
[LAN Type] in [Network Setup] on the [Host Interface] menu. Select [IEEE
802.11b] for [LAN Type], and then check that [WL.LAN Signal] is displayed on
the [Maintenance] menu again.

O Signal status can be measured in [Infrastructure] under [Comm. Mode] of the
wireless LAN. If [Ad hoc] or [802.11 Ad hoc] is selected in [Comm. Mode], sig-
nal status cannot be measured. To measure signal status, select [Comm.
Mode] in [Infrastructure] under [IEEE 802.11b] on the [Host Interface] menu.

O Every time you press the [# Enter] key, the signal is updated.
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O The signal is rated [Good] if signal strength is 76%-100%, [Fair] if 41%-75%,
[Poor] if 21%-40%, and [Unavailable] if 0%-20%. If the signal is unstable or
unavailable, remove any obstructions or move the printer to a place to re-
ceive the signal.

O Using wireless devices or microwave sources nearby will affect the signal
transmission.
Resetting the IEEE 802.11b (Wireless LAN) Settings

Follow the procedure below to reset the wireless LAN setting on the [Maintenance]
menu.

b d | mportant

3 [Comm. Mode], [Channel], [Trans. Speed], [WEP Setting], and [SSID] can be select-
ed on the [Host Interface] menu.

I] Press the [Menu] key.

i Form e Dl i
£0__JO%%
e JobRen Monu Of_\
0T T % G

The [Menu] screen appears.

EI Press the [ Y] or [ 4] key to display [Maintenance], and then press the [#
Enter) key.

8 Press the [ Y] or [A] key to display [WL.LAN Defaults], and then press the
[# Enter]) key.

ﬂ Press the [# Enter] key.
The wireless LAN setting is reset.
After about three seconds, the initial screen appears.

Maintenance menu parameters

This section explains about parameters that can be set on the Maintenance
menu.
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Color Regist.

Color deviation on printouts may occur as a result of printing on thick paper,
moving the machine, or repetitive continuous printing. Use the color deviation
compensation function to obtain correct printouts. For details about the color
deviation compensation method, see Maintenance Guide.

Color Calibrate

Subtle changes to color gradation may occur for a number of reasons - such
as repetitive continuous printing or changing toner(s). Use this function to re-
store normal color gradation. For details about color gradation adjustment,
see Maintenance Guide.

O Under normal circumstances, color gradation is unnecessary.

Image Density
You can select the print image density.

e -3t03
=l Feference
For details, see “Adjusting the Image Density”, Maintenance Guide.

Registration
You can adjust the starting position of the printing page.

« Prt. Test Sheet
You can print the registration sets sheet.

e Tray 3, Tray 4, Duplex.BackSide

3 Only the installed trays appear on the display panel.

% Adjustment
You can select the start position for printing on a page.

e Vert.: Tray 3, Vert.: Tray 4, Vert.:Dup.Back

3 Only the installed trays appear on the display panel.

Plain Paper
Specify a type of plain paper for each of the following trays:
Tray 1, Tray 2, Tray 3, Tray 4, Bypass Tray

¢ Thin
e Normal

(O Default: Normal
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Thick Paper

Set the thick paper configuration.

Thick Paper 1, Thick Paper 2, Thick Paper 3, Thick Paper 4

Only the bypass tray can accept thick paper.

For details, see “Type of Paper and Other Media”, Maintenance Guide.

Special Paper

Specify a type of special paper for each of the following trays:

Tray 1, Tray 2, Tray 3, Tray 4, Bypass Tray

For information about the types of ordinary paper, see the Maintenance
Guide.

Special Paper1, Special Paper2, Special Paper3, Special Paper4

For details, see “Type of Paper and Other Media”, Maintenance Guide.

Del. All Temp

This appears on the menu only when the hard disk is installed. Use this func-
tion to delete document data for sample printing or confidential document
printing all at once.

Del. All Stored
This appears on the menu only when the hard disk is installed. Use this func-
tion to delete saved document data all at once.

HD Format
Appears when the hard disk is installed. If the format is necessary, use p.165
“HD Format”.

WL.LAN Signal
You can check the signal strength when using wireless LAN.

=l Reference

For details about displaying the signal strength, see p.166 “Displaying the
signal strength”.

4C.Graphic Mode

Use this menu item to select a quantity of overlap between the colors CMYK
when printing. If characters or ruled lines blur, selecting “Text Priority” may im-
prove the situation. In general, select “Photo Priority”.

¢ Text Priority
¢ Photo Priority

O Default: Photo Priority

Fuser Temperat.

Use this menu item to select a temperature at which the fuser will be fixed to
paper being printed.

In general, select “600dpi Norm. Ppr”.
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* 600dpi Thin Ppr
¢ 600dpi Norm. Ppr
e 1200dpi

3 Default: 600dpi Thin Ppr

% Replacmnt Alert
Use this function to specify when to warn the user about replacing supplies.

* Notify Sooner
* Normal
* Notify Later

O Default: Normal

< Date/Time
Use this to set the date and time.

< WL.LAN Signal
You can check the signal strength when using wireless LAN. The menu ap-
pears when the 802.11b interface unit is installed.

« WL.LAN Defaults

Reset the wireless LAN to default. The menu appears when the 802.11b in-
terface unit is installed.

% Key Repeat
The default setting [On] enables the user to scroll through menu items and
settings by holding the key down; the [Off] setting requires the user to press
the key for each Cursor/Scroll movement.

« Erase All Mem.
Use this menu item to erase all data stored in the hard disk drive and and
RAM. Erasing all data takes some time, but use this function to prevent infor-
mation leakage when disposing the machine.
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System Menu

You can set basic functions required to use the printer. The printer can be used
on factory default, but the configuration can be changed depending on the con-
dition of the user. The changed condition holds even if the printer is turned off.

Changing the system menu
Follow the procedure below to change the settings for Energy Saver Timer.

ﬂ Press the [Menu] key.

0o oe

Farm Frexd ki e
ol m—
Job R Monu O

——— Pt
O %% % ®

LT R T ]

G

The [Menu] screen appears.
B Press [4A] or[¥] key to display [System], and then press the [ # Enter] key.

B Press [A] or [ V] key to display [Energy Saver 2], and then press the [# En-
ter] key.

ﬂ Press the [4A]) or [ V] key to display [E. Saver2 Timer], and then enter [# En-
ter] Key

B Press [A]) or [ V] key to select the lead time needed to switch to the En-
ergy Saver mode.

E Press the [# Enter] key.
Wait for two seconds. The [Energy Saver 2] screen appears.

ﬂ Press the [Online] key.
The initial screen appears.

System menu parameters

This section explains about parameters that can be set on the System menu.
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Prt. Err Report
You can select [On] or [Off] to have an error report printed when a printer error
Or memory error occurs.

o Off
¢ On

O Default: Off

Auto Continue
You can make the Auto Continue setting. When set to on, printing continues
after a system error occurs.

o Off

¢ |Immediate
e 1 minute

e 5 minutes

¢ 10 minutes
e 15 minutes
O Default: Off

0 When set to on and certain errors occur, the current job may be canceled,
and the printer automatically perform the next queued job.

Memory Overflow
You can specify whether or not to print a memory overflow error report.

¢ Do not print
¢ Error Info.

3 Default: Do not print

Copies

You can specify the number of pages to print.

This setting is disabled if the number of pages to print is specified by com-
mand or the printer driver.

* 1-999

Printer Lang.

You can specify the printer language.
¢ Auto Detect

* PCL

e PS

* PDF
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O Default: Auto Detect

Sub Paper Size

You can select [Off] or [Auto] to enable the Sub Paper Size function. When
you select [Auto], the printer switches to the available paper (A4 or Letter) if
the currently specified paper is not loaded. When you select [0ff], the printer
uses any size paper in the current specified paper tray.

o Off
e Auto

O Default: Off

Page Size

You can specify the default paper size.

12x18,11x 17,8 Vo x 14,8 Vo x 11,5 /2 x 8 /5,7 /4 x 10 /2,8 x 13, 8 /5
x 13, 8 /4 x 13, A3 (297 x 420), B4 JIS (257 x 364), A4 (210 x 297), B5 JIS
(182 x257), A5 (148 x 210), A6 (105 x 148), 8K (267 x 390), 16K (195 x 267),
9'ox 41,7 ,%x37/s,C6 Env (229 x 162), C6 Env (114 x 162), DL Env (110
x 220), Custom Size.

O Default:
¢ Metric version: A4
* Inch version: 8 /2 x 11

3 The initial paper size is applied when the paper size is not specified in the
print data.

O JIS stands for “Japanese Industrial Standard”.

Edge-Edge Print

You can print on the complete area of a sheet leaving no border on any edge.
o Off

e On

O Default: Off

Def.Print Lang.
You can specify the initial printer language if the machine cannot detect the
printer language.

« PCL
« PS
« PDF
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O Default: PCL

++ Duplex
You can specify whether or not to print on both sides of a sheet.
* Off
* Short Edge Bind
* Long Edge Bind
O Default: Off
3 This menu appears only when the optional duplex unit is installed.

+« Blank Pages
You can specify whether or not to print blank pages.

* Print
¢ Do not print

O Default: Print

% Output Tray
Specify the output tray that is selected by priority if the output tray is not ex-
plicitly specified.

% Job Separation
Specify whether to perform shift for each job on the output tray (2 Tray Finish-
er) equipped with the shift function.

e On
o Off

O Default: Off

% Energy Saver 1
You can specify whether or not to switch Energy Saver 1.
e On
o Off

O Default: Off

3 When the printer switches to the Energy Saver 1 mode, the machine
changes to Energy Saver 1 on completion of printing. It is not as energy
saving as Energy Saver 2, but returns to print in 30 seconds. Also, there
will be no change to the display panel.
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< Energy Saver 2
You can specify how many minutes for the energy saver mode.

R
°%

E. Saver2 On/Off
You can specify whether or not to switch E. Saver2.

¢ On
o Off
O Default: On

O When the printer switches to the Energy Saver 2 mode, the Power indi-
cator goes off, while the online indicator stays lit.

E. Saver2 Timer
You can select the lead time needed to switch to the Energy Saver 2 mode.
The Energy Saver 2 mode reduces electric power consumption.

e 5 minutes

¢ 15 minutes

¢ 30 minutes

e 45 minutes

* 60 minutes

O Default: 60 minutes

3 When the printer switches to the Energy Saver 2 mode, the Power indi-
cator goes off, while the Online indicator stays lit and [Energy Saver 2
Mode] appears.

«+ Auto Reset Time
Specify whether to revert to the initial configuration at certain interval. This
also specifies the interval to reset the configuration.

R
%

R
%

Auto Reset
¢ On
o Off

O Default: On

Reset Time
* 10t0 999 sec by 1 sec.

O Default: 60 sec
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+ Auto Del. Temp
Specify whether to automatically delete temporarily saved documents (Sam-
ple Print, Locked Print and Hold Print data), such as sample print documents
or confidential documents. Also specify the time period to elapse before dele-
tion.

+ Auto Delete
Select whether to delete the document automatically.

e On
o Off

O Default: Off

% Hours to Delete
Specify how much time will elapse before the document is automatically
deleted.

O Default: 8 hours
O These items are only displayed when the hard disk drive is installed.

« Auto Del. Stored
Specify whether to automatically delete saved documents (Stored Print data).
Also specify the elapse time in days before deletion.

% Auto Delete
Select whether to delete the document automatically.

e On
o Off

O Default: Off

+ Days to Delete
Specify the number of days to elapse before the document is automatically
deleted.

O Default: 3 days

 These items are only displayed when the optional hard disk drive is in-
stalled.

% Unit of Measure
You can specify the unit of measurement in “mm” or “inch” for the custom pa-
per size.

* mm
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¢ inch

O Default value is destination dependant.

< B&W Page Delete
Specify whether to recognize black-and-white images. Use the black-and-
white recognition function to print all monochrome pages in monochrome
mode even if color printing is specified.

e On
o Off

O Default: On

% Spool Printing
You can select whether all of the print data is spooled to the hard disk drive
before printing.

* Off

e On

O Default: Off

O Spooling stores a sent print job temporarily in the printer, and then prints it.
3 This menu appears only when the hard disk is installed.

% Letterhead Mode
You can select the letterhead printing mode.

o Off
¢ Auto Detect
e On (Always)

O Default: Off

++ Bypass Priority
When the different paper size or type is specified from the driver, you can
specify which setting is given priority to, machine setting or command.

e Machine
¢ Driver/Command

O Default: Driver/Command
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Tray Switching
Specify the printer to change printing to the suitable tray, when printer driver
specifies different paper size or type from the current tray.

o Off
¢ On

O Default: Off

RAM Disk

If the hard disk is not installed for PDF Direct Print, select a value of 2 MB or
higher.

This menu appears only when the hard disk is not installed.

« OMB

2 MB

4 MB

8 MB

16 MB

O Default: 4 MB

b d | mportant

3 When the amount of SDRAM is small and RAM Disk is set to 16 MB, print-
ing may not be possible depending on the print job and duplex printing may

be canceled. If this happens, increase the amount of SDRAM, or set RAM
Disk to 8 MB or less.

=l Feference
For details about the optional SDRAM module, see Setup Guide.

Notify by E-mail
You can specify whether or not to send an error message to a preset e-mail
address when an error occurs in the printer.

o Off
On
b d | mportant

O After changing the setting, turn off the power of the printer briefly, and then
turn it on again.

3 Default: On
=l Reference
For information, see Web Image Monitor Help.
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Host Interface Menu

You can set configurations about network connections and communication when
using parallel connection between the printer and the computer. The changed
configuration holds even if the printer is turned off.

Changing the Host Interface menu

Follow the procedure below to change the 1/0O Timeout

ﬂ Press the [Menu] key.
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The [Menu] screen appears.

B Press the [A] or [ Y] key to display [Host Interface], and then press the [#
Enter] key.

B Press the [A] or [ V] key to display [I/O Buffer], and then press the [# En-
ter] key.

ﬂ Press the [A] or [ V] key to display the [256KB], and then press the [# En-
ter] key.

Wait for two seconds. The [Host Interface] menu appears.

B Press the [Online) key.
The initial screen appears.

Host Interface menu parameters
This section explains parameters that can be set on the Host Interface menu.

« /0 Buffer
You can select the size of I/0 Buffer. Normally it is not necessary to change
this setting.

* 128 KB
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* 256 KB

O Default: 128 KB

+ 1/0 Timeout
You can set how many seconds the printer should wait before ending a print
job. If printing operation is frequently interrupted by data from other ports, you
can increase the timeout period.

e 10 seconds
e 15 seconds
e 20 seconds
e 25 seconds
* 60 seconds

O Default: 15 seconds

<+ Network Setup
You can make network-related settings.

=l Feference
For details, see “Configuration”, Setup Guide.

< DHCP 1394
You can select [On] or [Off] to use DHCP with TCP/IP.

* On
o Off

O Default: On

% IP Address
You can specify the IP address.
e d | mportant
 When DHCP is set to on, the IP address cannot be changed. To change

it, set DHCP to off. Contact your network administrator for information
about the network configuration.

0 Default: 011.022.033.044

« Subnet Mask
You can specify the subnet mask.
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b d | mportant

[ When DHCP is set to on, the subnet mask cannot be changed. To
change it, set DHCP to off. Contact your network administrator for infor-
mation about the network configuration.

i

O Default: 000.000.000.000

Gateway Address
You can specify the gateway address.

b d | mportant

O When DHCP is set to on, the gateway address cannot be changed. To
change it, set DHCP to off. Contact your network administrator for infor-
mation about the network configuration.

i

O Default: 000.000.000.000

Frame Type (NW)
You can select the frame type for NetWare.

Auto Select
Ethernet |l
Ethernet 802.2
Ethernet 802.3
Ethernet SNAP

i

O Default: Auto Select

Active Protocol
You can select the active protocol.

TCP/IP
* NetWare
e SMB

* AppleTalk

A
O Default: All Active

Ethernet Speed
You can select the network speed to operate the printer.

* Auto Select
* 10Mbps Half D.
¢ 10Mbps Full D.
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* 100Mbps Half D.
* 100Mbps Full D.

O Default: Auto Select

% LAN Type
You can select Ethernet or IEEE 802.11b for LAN Type.
This menu appears only when the optional 802.11 interface unit is in-
stalled.

e Ethernet
e |EEE 802.11b

O Default: Ethernet

% |EEE 1394 Setup
You can make settings for IEEE 1394. This menu appears only when the op-
tional IEEE 1394 board is installed.

=l Feference
For details about IEEE 1394 Setup, see Setup Guide.

% DHCP 1394
You can select [On] or [Off] to use TCP/IP with DHCP.

¢ On
o Off

O Default: On

% IP Address1394
You can specify the IP address for IEEE 1394 (IP over 1394).

3 Default: 0.0.0.0
O When using both Ethernet and IP over 1394 simultaneously, do not
specify the IP address used for Ethernet.

+ Subnet Mask1394
You can specify the subnet mask for IEEE 1394 (IP over 1394).

O Default: 0.0.0.0

O When using both Ethernet and IP over 1394 simultaneously, do not
specify the subnet mask used for Ethernet.
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% IP over 1394
You can specify whether or not to activate IP over 1394.

e Active
¢ Not Active

O Default: Active
% SCSI print
You can specify whether or not to activate SCSI print.
* Active
* Not Active

O Default: Active

« Bidi-SCSI print
You can specify whether or not to activate bidirectional communication for
SCSI print.

¢ On
o Off

O Default: On

+ |IEEE 802.11b
You can make settings for wireless LAN. This menu appears only when the
optional 802.11b interface unit is installed.

«» Comm. Mode
You can select the transmission mode for IEEE 802.11b.

e 802.11 Ad hoc

¢ Infrastructure

e Adhoc

O Default: 802.11 Ad hoc

O Comm. Mode can also be set using a Web Image Monitor. For details,
see Web Image Monitor Help.

% Channel
You can select channels: 1-11 (inch version)/1-13 (metric version).

3 Default: 11 (inch version)/13 (metric version)
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Trans. Speed
You can select the transmission speed for IEEE 802.11b.

* Auto

* 11 Mbps
e 5.5 Mbps
e 2 Mbps
* 1 Mbps

O Default: Auto

SSID

You can set an SSID in the infrastructure mode and the 802.11 Ad hoc
mode.

Select [View] to check the SSID. Select [Enter ID] to set SSID.

e View
e EnterID
e d | mportant

3 Select [?] to enter [/] for the SSID. Also, [¥] appears when printing the
configuration page, read it as [/].

O Default: blank (ASSID)
3 Characters used are ASCII 0x20-0x7e (32 bytes).

3 An SSID is set automatically to the nearest access point if no SSID has
been set.

O If no SSID has been set for the 802.11 ad hoc mode, an SSID is set au-
tomatically and the same SSID is used for the 802.11 ad hoc mode and
the infrastructure mode.

3 If blank is specified in SSID for 802.11b adhoc mode or adhoc mode,
“ASSID” appears.

3 An SSID can also be set using Web Image Monitor. For details, see
Web Image Monitor Help.

WEP Setting
You can specify whether or not to activate WEP settings.

¢ Active
¢ Not Active
O Default: Not Active

O The WEP key can be entered using a hexadecimal number or an ASCII
character sequence.
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O When using 64 bit WEP, up to 10 hexadecimal or 5 ASCII characters
can be entered. When using 128 bit WEP, up to 26 hexadecimal or 13
ASCII characters can be entered.

O The WEP key can also be set using Web Image Monitor. For details, see
Web Image Monitor Help.
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PCL Menu

You can set conditions when using PCL for printing.

Changing the PCL menu

Follow the procedure below to change the setting for Orientation.

[I Press the [Menu] key.

i Form e Dl i
£0__JO%%
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The [Menu] screen appears.

EI Press the [A] or [ Y] key to display [PCL Menu], and then press the [# En-
ter] key.

8 Press the [A] or [ V] key to display [Orientation] screen, and then press
the [# Enter] key.

ﬂ Press the [A ) or [ V] key to select the orientation, and then press the [#
Enter) key.

Wait for two seconds. The [PCL Menu] screen appears.

B Press the [Online] key.
The initial screen appears.

PCL Menu parameters

This section explains about parameters that can be set on the PCL menu.
+ Orientation

You can select the page orientation.

e Portrait

* Landscape
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(O Default: Portrait

% Form Lines
You can specify the number of lines per page between 5 and 128.

O Default:
e Metric version: 64
¢ |nch version: 60

+ Font Source
You can set the location of the default font.

¢ Resident

* RAM

e HDD

e SD

O Default: Resident

 When you select [RAM], you can select only fonts downloaded to the printer
RAM.

3 When you select [HDD], you can select only fonts downloaded to the hard
disk.

% Font Number
You can specify the ID of the default font you want to use.

e 0to 63 (Internal)
* 1 to 63 (Download)
% Point Size

You can specify the point size you want to use for the default font between 4
and 999.75 in 0.25 increments.

3 Default: 12.00 points
O This setting is effective only for a variable-space font.
« Font Pitch

You can specify the number of characters per inch you want to use for the de-
fault font between 0.44 and 99.99 in 0.01 increments.

O Default: 10.00 pitch

O This setting is effective only for fixed-space fonts.
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% Symbol Set
You can specify the character set for the default font. Available sets are as
follows:
Roman-8, ISO L1, ISO L2, ISO L5, PC-8, PC-8 D/N, PC-850, PC-852, PC8-
TK, Win L1, Win L2, Win L5, Desktop, PS Text, VN Intl, VN US, MS Publ,
Math-8, PS Math, VN Math, Pifont, Legal, ISO 4, ISO 6, ISO 11, ISO 15, ISO
17,1S0 21, 1SO 60, ISO 69, Win 3.0

O Default: PC-8

% Courier Font
You can select a courier-type font.

* Regular
* Dark

O Default: Regular

% Ext. Ad Width
You can extend the width of the printable area of A4 sheets reducing side
margin width.

o Off
¢ On

O Default: Off

% Append CR to LF
You can specify whether or not to append a CR code to each LF code to print
text data clearly.

o Off
e On

O Default: Off

+ Resolution
You can specify the print resolution in dots per inch.

* 300 dpi
* 600 dpi

O Default: 600 dpi
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PS Menu

You can set conditions when using Postscript for printing.

Changing the PS menu

Follow the procedure below to change the setting for date format.

[I Press the [Menu] key.

e Fom fem Db i
O Ik
e JobRen Monu Of_\
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The [Menu] screen appears.

EI Press the[4A ] or [ ¥ ] key to display [PS Menu], and then press the [ # Enter)
key.

8 Press the [A] or [ V] key to display [Data Format], and then press the [#
Enter) key.

ﬂ Press the [A] or [ V] key to select [TBCP], and then press the [# Enter)
key.
Wait for two seconds. The [PS Menu] screen appears.

B Press the [Online] key.
The initial screen appears.

PS Menu parameters

This section explains about parameters that can be set on the Postscript menu.

«» Data Format
You can select the data format.
* Binary Data

e TBCP
This setting is not effective when using a parallel or EtherTalk connection.
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When you use a parallel or USB connection, the print job is canceled if binary
data is sent from the printer driver.
When you use an Ethernet connection, the print job is canceled if:

e The printer driver data format is TBCP and the data format selected using
the control panel is Binary Data.

* The printer driver data format is binary and the data format selected using
the control panel is TBCP.

e )
0 Default: TBCP

Resolution
You can select the resolution.

* 600dpi Fast
e 600dpi Std.
* 1200dpi

e )
O Default: 600dpi Fast

Color Setting
You can select the RGB Color adjustment quality.

* None
* Fine
e Super Fine

fricte ]

3 Default: Super Fine

Color Profile
You can select the color profile.

* Auto

e Solid Color
* Presentation
* Photographic
e User Setting

fricte ]

O Default: Auto
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PDF Menu

You can set conditions when using PDF printing.

Changing the PDF menu

Follow the procedure below to change the resolution setting.

[I Press [Menu] key.

i Form e Dl
e JobRen Monu O
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The [Menu] screen appears.

EI Press [A] or [ V] key to display [PDF Menu], and then press the [# Enter)
key.

8 Press [A] or [ V] key to display [Resolution], and then press the [# Enter)
key.

ﬂ Press [A] or [ V] key to select the resolution, and then press the [# En-
ter] key.
Wait for two seconds. The [PDF Menu] screen appears.

B Press the [Online] key.
The initial screen appears.

PDF Menu parameters

This section explains about parameters that can be set on the PDF menu.

% PDF: Change PW
You can specify the password for the PDF file executing PDF Direct Print.
b d | mportant

O The password can be set using Web Image Monitor, but must be sent
through the network. For increased security, use this menu on the control
panel to set the password directly.
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| [EE

O Default: no password set

< PDF Group PW
You can set a group password specified using DeskTopBinder Lite.

e Current PW
b d | mportant

O The password can be set using Web Image Monitor, but must be sent
through the network. For increased security, use this menu on the control
panel to set the password directly.

fricte ]

O Default: no password set

+ Resolution
You can select the resolution for the PDF file executing PDF Direct Print.

« 600dpi Fast
« 600dpi Std.
* 1200dpi

it ]
O Default: 600dpi Fast

+ Color Setting
You can select the RGB Color adjustment quality.

* None
e Fine
e Super Fine

| [N

O Default: Super Fine

« Color Profile
You can select the color profile.

e Auto

e Solid Color

* Presentation
* Photographic
e User Setting

| [N

O Default: Auto
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Language Menu

You can set language displayed on the menu.

Changing the language menu

Follow the procedure below to change the language.

[I Press the [Menu] key.

i Form e Dl i
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The [Menu] screen appears.

EI Press the [A] or [ ¥] key to display [Language], and then press the [# En-
ter] key.

8 Press the [A] or [ V] key to select the language, and then press the [#
Enter) key.
Wait for two seconds. The [Menu] screen appears.

ﬂ Press the [Online] key.
The initial screen appears.

Language menu parameters

You can select the language you use. Available languages are as follows:

English, German, French, ltalian, Dutch, Swedish, Norwegian, Danish, Spanish,
Finnish, Portuguese, Czech, Polish, and Hungarian.

O Default: English
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Using Web Image Monitor

Using Web Image Monitor, you can check the printer status and change settings.

% Available operations
The following operations can be remotely performed using Web Image Moni-
tor from a client computer.

* Displaying printer status or settings
e Checking the print job status or history
* Interrupting currently printing jobs
* Resetting the printer
* Managing the Address Book
* Making printer settings
* Making e-mail notification settings
* Making network protocol settings
¢ Making security settings
% Configuring the printer
To perform the operations from Web Image Monitor, TCP/IP is required. After

the printer is configured to use TCP/IP, operations from Web Image Monitor
become available.

< Recommended Web browser

* Windows:
Internet Explorer 5.5 or higher
Netscape Navigator 7.0 or higher

* Mac OS 8.1 or higher:
Netscape Navigator 7.0 or higher
Safari 1.0 or higher

O To use Netscape Navigator with Secured Sockets Layer (SSL: an encryption
protocol), use Netscape Navigator 7.0 or higher.

O If the previous versions of the Web browser above are used or JavaScript and
cookies are not enabled with the Web browser used, display and operation
problems may occur.

O If you are using a proxy server, change the Web browser settings. Contact
your network administrator for information about the settings.

O The previous page may not appear even after the back button of a Web
browser is clicked. If this happens, click the refresh button of a Web browser.

O Updating the printer information is not automatically performed. Click [Refresh]
in the display area to update the printer information.
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Displaying Top Page
This section explains the Top Page and how to display Web Image Monitor.
ﬂ Start your Web browser.

ﬂ Enter “http: //(printer's address)/” in the address bar of a Web browser.
Top Page of Web Image Monitor appears.

3 If the printer's host name has been registered on the DNS or WINS server,
you can enter it. For details, see p.319 “Using DHCP”.

O When setting SSL, a protocol for encrypted communication, under environ-
ment which server authentification is issued , enter “https://(printer's ad-
dress)/“.

Every Web Image Monitor page is divided into the following areas:

SR S — — A

1_ e . — 4
= =

—3

1. Header area
The link to help and dialog box for keyword search appears.

2. Menu area
The dialog box for switching to the user mode and administrator mode appears, and
each mode's menu will be displayed.
If you select menu, it's content will be shown on the work area, or the sub area.

3. Display area
Displays the contents of the item selected in the menu area.

Printer information in the display area is not automatically updated. Click [Refresh] at
the upper right in the display area to update the printer information. Click the Web
browser's [Refresh] button to refresh the entire browser screen.

Printer status, network interface board names, and comments are displayed.

4. Help
Use Help to view or download Help file contents.
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About Menu and Mode

There are two modes available with Web Image Monitor: user mode and admin-
istrator mode.

Displayed items may differ depending on the printers.

% About User Mode
In the user mode, printer status, settings, and print job status can be viewed,
but the printer settings cannot be changed.

1. Status
Printer status, including the amount of remaining paper in paper trays and the amount
of remaining toner, is displayed.

2. Job
Allows you to display list of Spooled Print Job, Job History, Error Log, Locked Print
and Sample Print jobs. This also perform or delete Locked Print and Sample Print

jobs.
3. Configuration
Display current printer and network settings, and download help files.

+«+ Administrator Mode
In the administrator mode, you can configure various printer settings.

1. Status
Printer status, including the amount of remaining paper in paper trays and the amount
of remaining toner, is displayed.
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2. Job

Allows you to display list of Spooled Print Job, Job History, Error Log, Sample Print
and Locked Print. This also allows you to delete Spooled Print Job, Locked Print and
Sample Print Jobs.

3. Address Book
User information can be registered, displayed, changed, and deleted.

4. Configuration
Make system settings for the printer, interface settings, and security.

5. Reset Printer Job

Click to reset current print jobs and print jobs in queue. This button is located on Top
Page.

6. Reset Device

Click to reset the printer. If a print job is being processed, the printer will be reset after
the print job is completed. This button is located on Top Page.

Access in the Administrator Mode

Follow the procedure below to access Web Image Monitor in the administrator
mode.

ﬂ On Top Page, click [Login].
The dialog box for entering the user name and password appears.

ﬂ Enter your user name and password, and then click [OK].
You can select the color profile.

Displaying Web Image Monitor Help

When using Help for the first time, clicking either [Help] in the header area or the
icon marked “?” in the display area makes the following screen appear, in which
you can view Help in two different ways, as shown below:

+ Viewing Help on our Web site
Downloading Help to your computer

% Downloading and Checking Help
You can download Help to your computer. As the Help URL, you can specify
the path to the local file to view the Help without connecting to the Internet.

3 By clicking [Help] in the header area, the contents of Help appear.

3 By clicking “?”, the Help icon in the display area, Help for the setting items in
the display area appears.
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Downloading Help

I] In the [0S] list, select the operating system.

ﬂ In the [Language] list, select the language.

B Click [Download].

ﬂ Download Help by following the instructions on the screen.

B Store the downloaded compressed file in a location, and then decom-
press the file.

To view the downloaded Web Image Monitor Help, set the path to the location
of the decompressed file.

Linking the URL of the Help File to the [Help] Button.

You can link the URL of the help file on a computer or Web server to the [Help]
button.

ﬂ Log on to Web Image Monitor in the administrator mode.
ﬂ In the menu area, click [Configuration].
E click [webpage].

ﬂ In the [Help URL] box, enter the URL of the help file.

If you saved the help file to “C:\\HELP\EN”, enter “file://C:/HELP/”. For exam-
ple, if you saved the file to a Web server, and the URL of the index file is “ht-
tp:// a.b.c.d/HELP/EN/index.html”, enter “http://a.b.c.d/HELP/”".

B Click [Apply]-
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Using SmartDeviceMonitor for Admin

Using SmartDeviceMonitor for Admin, you can monitor the network printers. Al-
S0, you can change the configuration of the network interface board using
TCP/IP or IPX/SPX.

« Protocol stack provided with Operating System

Windows 95/98/Me

TCP/IP

IPX/SPX

NetWare

NetWare Client32 for Windows 95
IntraNetWare Client for Windows 95
Novell Client for Windows 95/98/Me

Windows 2000

TCP/IP

IPX/SPX

NetWare

Novell Client for Windows NT/2000/XP

Windows Server 2003
TCP/IP
IPX/SPX

Windows XP

TCP/IP

IPX/SPX

Novell Client for Windows NT/2000/XP

Windows NT 4.0

TCP/IP

IPX/SPX

Client Service for NetWare

NetWare Client32 for Windows NT
IntraNetWare Client for Windows NT
Novell Client for Windows NT/2000/XP

Available operations
The following functions are available:

Printer Information function

* Display the network settings and detailed information of the printer.
* Display the number of pages printed under each user code.

¢ Display the status of print jobs sent from computers.

* Change the printer network settings.

Device Settings function
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* Lock some of the setting items on the control panel so that they cannot
be changed using the control panel.

* Select type of paper loaded in the paper trays.
* Energy Saver function

e Enable or disable the Energy Saver mode.
e System Status function

* Display the information such as when paper is depleted during printing
on a computer .

e Groups function

* Monitor multiple printers at the same time. When there are multiple print-
ers to manage, you can create groups and classify the printers to facili-
tate management.

* You can customize printer status according to groups, and send status
notification e-mail to a computer.

Installing SmartDeviceMonitor for Admin
Follow the procedure below to install SmartDeviceMonitor for Admin.
I] Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

O Auto Run may not work under certain operating system settings. In this
case, launch “Setup.exe” located on the CD-ROM root directory.

8 Select an interface language, and then click [OK].
The default interface language is English.

E] Click [SmartDeviceMonitor for Client/Admin] installation, and then click [Next].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading through its contents, click [l accept the agreement] if you agree,
and then click [Next >].

B Follow the instructions on the screen.
A message appears when the installation is complete.

U click [ox).
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3 If you are required to restart the computer after installing SmartDeviceMon-
itor for Admin, restart the computer and continue the configuration.

O SmartDeviceMonitor for Admin supports the following languages: Czech,
Danish, German, English, Spanish, French, Italian, Hungarian, Dutch, Nor-
wegian, Polish, Portuguese, Finnish, Swedish, Chinese Simple and Chi-
nese Traditional.

Changing the Network Interface Board Configuration

Follow the procedure below to change the network interface board configuration
using SmartDeviceMonitor for Admin.

I] Start SmartDeviceMonitor for Admin.

BOn the [Group] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP(SNMPv3)]. A list of printers using the selected protocol
appears.

O Select the protocol of the printer whose configuration you want to change.
B In the list, select a printer whose configuration you want to change.

O on the [Tools] menu, click [NIB Setup Tool].

A Web browser opens and the dialog box for entering the user name and
password for the Web Image Monitor administrator appears.

To use the default account, enter “admin” as the user name, and leave the
password blank.

NIB Setup Tool starts when the network interface board is default. Follow the
instruction on the screen.

B Enter required setting items.

Configure settings using Web Image Monitor. For details, see p.194 “Using
Web Image Monitor”.

B Quit Web Image Monitor.

ﬂ Quit SmartDeviceMonitor for Admin.

Locking the Menus on the Printer's Control Panel

Follow the procedure below to lock the menus on the printer's control panel.

ﬂ Start SmartDeviceMonitor for Admin.
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ﬂOn the [Group] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP(SNMPv3)].

A list of printers using the selected protocol appears.

O Select the protocol of the printer whose configuration you want to change.
B Select a printer.

ﬂ On the [Tools] menu, point to [Device Settings], and then click [Lock Operation
Panel Menu].

A Web browser opens and the dialog box for entering the password for the
Web Image Monitor administrator appears.

B Enter the user name and password, and then click [OK].
For details about the password, consult your network administrator.
The [System] page of Web Image Monitor appears.

B Select [Level 1] or [Level 2] in the [Protect Printer Operation Panel] list.
ﬂ Click [Apply]-

8 Quit Web Image Monitor.

=l Reference

For details about setting items, see Help in the [General Settings] on [Config-
uration] page.

Changing the Paper Type
Follow the procedure below to change the paper type.
ﬂ Start SmartDeviceMonitor for Admin.

ﬂOn the [Group] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP(SNMPv3)].

A list of printers using the selected protocol appears.

O Select the protocol of the printer whose configuration you want to change.
B In the list, select a printer whose configuration you want to change.

ﬂ On the [Tools] menu, point to [Device Settings], and then click [Select Paper
Type].
A Web browser opens and the dialog box for entering the password for the
Web Image Monitor administrator appears.
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B Enter the user name and password, and then click [OK].
For details about the password, consult your network administrator.
The [Paper] page appears.

B Select a paper type in the [Paper Type] list for each tray.
ﬂ Click [Apply]-

B Quit Web Image Monitor.
=l Feference

For details about setting items, see Help in the [General Settings] on [Config-
uration] page.

Managing User Information

Follow the procedure below to manage the user's information using SmartDe-
viceMonitor for Admin.

Prints jobs can be managed and functions restricted by user codes.
Starting User Management Tool

Follow the procedure below to start User Management Tool.

ﬂ Start SmartDeviceMonitor for Admin.

ﬂOn the [Group] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP(SNMPv3)].

A list of printers using the selected protocol appears.

O Select the protocol of the printer whose configuration you want to change.
B In the list, select a printer you want to manage.

ﬂ On the [Tools] menu, click [User Management Tool].
The dialog box for entering the user name and password appears.

B Enter the user name and password, and then click [OK].
For details about the password, consult your network administrator.
User Management Tool starts.
=l Feference

For details about User Management Tool, see SmartDeviceMonitor for Ad-
min Help.
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Displaying the Number of Sheets Printed

Follow the procedure below to display the number of sheets printed under each
user code.

I] Start SmartDeviceMonitor for Admin.

B Click the [User Page Count] tab of User Management Tool.
The number of pages printed under each user code appears.

B Click [Finish] on the [File] menu to quit User Management Tool.
Exporting the information about the number of pages printed

Follow the procedure below to export the information of the number of pages
printed under each user code as a “.csv” file.

ﬂ Start SmartDeviceMonitor for Admin.

ﬂ Click the [User Page Count] tab of User Management Tool.

B On the [File] menu, click [Export User Statistics List].

ﬂ Specify the save location and file name, and then click [Save].
B Click [Finish] on the [File] menu to quit User Management Tool.
Resetting the number of pages printed to 0.

Follow the procedure below to reset the number of pages printed under each
user code to 0.

ﬂ Start SmartDeviceMonitor for Admin .

EI Click the [User Page Count] tab of User Management Tool.
B Click the user whose information you want to reset.

ﬂ On the [Edit] menu, click [Reset User Counters].

B Select the check box of the items you want to reset, and then click [OK].
A confirmation message appears.

( click [ves).
The number of pages printed is reset to 0.

ﬂ On the [Edit] menu, click [Apply Settings].
Changes are applied to information on the [User Page Count] tab.

B Click [Finish] on the [File] menu to quit User Management Tool.
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Restricting Functions
Follow the procedure below to restrict use of individual functions.
ﬂ Start SmartDeviceMonitor for Admin.

ﬂ On the [Edit] menu of User Management Tool, click [Restrict Access To De-
vice].

B Select the check box of the functions you want to restrict.

A click [ox;.
A confirmation message appears.

B ciick ves).
The settings are applied.

Setting Applicable Functions to New Users

Follow the procedure below to add new users and set functions applicable to
them.

ﬂ Start SmartDeviceMonitor for Admin.

8 Click the [Access Control List:] tab of User Management Tool.
E] on the [Edit] menu, click [Add New User].

ﬂ Enter the user code and user name.

B Select the check box of the functions applicable to the new user.

O If the check boxes are unavailable, there is no restriction to use that func-
tion. For details, see SmartDeviceMonitor for Admin Help.

B Click [OK].
The new user is added.

ﬂ On the [Edit] menu, click [Apply Settings].
The settings are applied.

8 Click [Finish] on the [File] menu to quit User Management Tool.

= Reference

For details about setting restrictions, see SmartDeviceMonitor for Admin
Help.
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Configuring the Energy Saver Mode

Follow the procedure below to configure Energy Saver mode.
I] Start SmartDeviceMonitor for Admin.

ﬂOn the [Group] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP(SNMPv3)].
A list of printers using the selected protocol appears.

O Select the protocol of the printer whose configuration you want to change.

B Select the printer whose settings you want to make.

To make settings for all printers in the selected group, select no printer.

ﬂ On the [Group] menu, point to [Energy Save Mode], point to [Set Individually] to
make the settings for only the selected printer or point to [Set By Group]
to make the settings for all printers in the selected group, and then click
[On] or [Off].

B Quit SmartDeviceMonitor for Admin.

=l Feference

For details about the setting value for Energy Saver mode, see SmartDe-
viceMonitor for Admin Help.

Setting a Password
Follow the procedure below to set a password.
ﬂ Start SmartDeviceMonitor for Admin.

ﬂOn the [Group] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP(SNMPv3)].

A list of printers using the selected protocol appears.
8 In the list, select a printer whose configuration you want to change.

O on the [Tools] menu, click [NIB Setup Tool].

A Web browser opens and the dialog box for entering the password for the
Web Image Monitor administrator appears.

NIB Setup Tool starts when the network interface board is default. Follow the
instructions on the screen.

B Enter the user name and password, and then click [OK].
For details about the password, consult your network administrator.
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Top Page of Web Image Monitor appears.
B Click [Configuration].
 Click [Device Settings].
8 Click [Program/Change Administrator].
B click [change].

[[D On the [New Password], enter a password.
Enter the same password in [Confirm Password] .

@ click [ox;.
[EJ Quit Web Image Monitor.
[B Quit SmartDeviceMonitor for Admin.

Checking the Printer Status

Follow the procedure below to check printer status.
I] Start SmartDeviceMonitor for Admin.

BOn the [Group] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP(SNMPv3)].

The status of printers is indicated by icons in the list.

O For details about status icons, see SmartDeviceMonitor for Admin Help.

8 To obtain status details, click the printer in the list, and then click [Open]
on the [Device] menu.

The printer status appears in the dialog box.

E] Quit SmartDeviceMonitor for Admin.

O For details about items in the dialog box, see SmartDeviceMonitor for Ad-
min Help.
Changing Names and Comments

Follow the procedure below to change the names and comments of the printer.

ﬂ Start SmartDeviceMonitor for Admin.
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ﬂOn the [Group] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP(SNMPv3)]. A list of printers using the selected protocol
appears.

O Select the protocol of the printer whose configuration you want to change.
8 Select a printer in the list.

O on the [Tools] menu, click [NIB Setup Tool].

A Web browser opens and the dialog box for entering the password for the
Web Image Monitor administrator appears.

NIB Setup Tool starts when the network interface board is default. Follow the
instructions on the screen.

B Enter the user name and password, and then click [OK].
Top Page of Web Image Monitor appears.
For details about the password, consult your network administrator.

ﬂ Click [Configuration].
 Click [Device Settings].

8 On the [System] page, enter the device name in the [Device Name] box and
a comment in the [Comment] box, and click [Apply].

* In the [Device Name] box, enter a device name on the machine using up to
31 characters.

¢ In the [Comment] box, enter a comment on the printer using up to 31 char-
acters.

ﬂ Click [OK].
[[D Quit Web Image Monitor.

[i] Quit SmartDeviceMonitor for Admin.
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Using SmartDeviceMonitor for Client

To view the status of printers using SmartDeviceMonitor for Client, configure
SmartDeviceMonitor for Client beforehand.

Monitoring Printers

Follow the procedure below to monitor the printer using SmartDeviceMonitor for
Client.

I] Start SmartDeviceMonitor for Client.
The SmartDeviceMonitor for Client icon appears in the task tray.

EI Right-click the SmartDeviceMonitor for Client icon, and check that the
printer appears on the pop-up menu.

8 Click [Options...] on the pop-up menu if the printer does not appear on the
pop-up menu.
The [SmartDeviceMonitor for Client - Options] dialog box appears.

ﬂ Click the printer you want to monitor, and then select the [To Be Monitored]
check box in the [Monitoring Information Settings] area.

3 To display the printer status in the task tray using the SmartDeviceMonitor
for Client icon, select the [Displayed on Task Bar] check box.

O For details about status icons, see SmartDeviceMonitor for Client Help.

A ciick [ox;.
The dialog box closes and the configured printer is monitored.

Checking the Printer Status

Follow the procedure below to check printer status using SmartDeviceMonitor
for Client.

I] Start SmartDeviceMonitor for Client.

ﬂ For status details, right-click the SmartDeviceMonitor for Client icon,
and then click the printer.
The printer status appears in the dialog box.

O For details about items in the dialog box, see SmartDeviceMonitor for Cli-
ent Help.
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When Using IPP with SmartDeviceMonitor for Client

When using IPP with SmartDeviceMonitor for Client, note the following:

The network printer can only receive one print job from SmartDeviceMonitor
for Client at a time. While the network printer is printing, another user cannot
access it until the job is finished. In this case, SmartDeviceMonitor for Client
tries to access the network printer until the retry interval expires.

If SmartDeviceMonitor for Client cannot access the network printer and times
out, it will stop sending the print job. In this case, you should cancel the
paused status from the print queue window. SmartDeviceMonitor for Client
will resume access to the network printer. You can delete the print job from
the print queue window, but canceling a print job printed by the network printer
might cause the next job sent from another user to be incorrectly printed.

If a print job sent from SmartDeviceMonitor for Client is interrupted and the
network printer cancels the job because something went wrong, send the print
job again.

Print jobs sent from another computer do not appear in the print queue win-
dow, regardless of protocol.

If various users send print jobs using SmartDeviceMonitor for Client to net-
work printers, the printing order might not be the same as that in which the
jobs were sent.

An IP address cannot be used for the IPP port name because the IP address
is used for the SmartDeviceMonitor for Client port name.

When setting SSL, a protocol for encrypted communication, under environ-
ment which server authentification is issued, enter “https://(printer's ad-
dress)/”. Internet Explorer must be installed on your computer. Use the
highest version. Internet Explorer 6.0 or higher is recommended.

If the [Security Alert] dialog box appears when accessing the printer using IPP
to create or configure an IPP port, or when printing, install the certificate. To
select the certificate store location when using Certificate Import Wizard, click
[Place all certificates in the following store], and then click [Local Computer] under
[Trusted Root Certification Authorities].
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Printer Status Notification by E-Mail

Whenever a paper tray becomes empty or paper is jammed, an e-mail alert is
issued to the registered addresses to notify the printer status.

For this notification, you can make the e-mail notification settings.
Notification timing and e-mail content can be set.
You can be notified of the following events:
* Service call.
e Toner cartridge is empty.
e Toner cartridge is nearly empty.
* Photoconductor unit needs replacing.
* Photoconductor unit will need replacing soon.
* Waste toner bottle is full.
* Waste toner bottle is nearly full.
e Stapler has no staples.
¢ Fusing unit needs replacing.
¢ Fusing unit will need replacing soon.
¢ Maintenance kit needs replacing.
* Paper has jammed.
¢ Open door is detected.
* Paper tray is empty.
e Paper tray error.
e OQutput paper tray is full.
¢ Unit connection error.
e Duplex unit error.
* Hard disk drive is full.
* Development Unit needs replacing.
* Development Unit will need replacing soon.
* Transfer Unit needs replacing.
I] Set [Notify by E-mail] under the [System] menu to [On] using the control pan-
el.
The default is [On].
=l Feference
For details, see p.171 “System Menu”.

ﬂ Open a Web browser, and then enter “http: //(printer's address)/” in the
address bar.
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Top Page of Web Image Monitor appears.

When setting SSL, a protocol for encrypted communication, under environ-
ment which server authentification is issued , enter “https://(printer's ad-
dress)/”.

B Click [Login] on Top Page of Web Image Monitor.
The dialog box for entering the user name and password appears.

ﬂ Enter the user name and password, and then click [OK].
For details about the password, consult your network administrator.

B In the menu area, click [Configuration].
B Click [Device Settings], and then click [E-mail].

ﬂ Make the following settings:

* Items in the Reception column: Make the necessary settings for sending
and receiving e-mail.

e Items in the SMTP column: Configure the SMTP server. Check your mail-
ing environment, and then specify the necessary items. You can also per-
form mail authentication for the SMTP server.

See p.213 “SMTP Authentication”.

¢ Itemsinthe POP before SMTP column: Items in the POP before SMTP col-
umn: Configure the POP server. Check your mailing environment, and then
specify the necessary items. You can also perform mail authentication for
the POP server.
See p.214 “POP before SMTP Authentication”.

¢ Items in the POP3/IMAP4 column: Items in the POP3/IMAP4 column: Con-
figure the POP3 or IMAP4 server. Check your mailing environment, and
then specify the necessary items.

* Items in the E-mail Reception Port column: Items in the E-Mail Reception
Port column: Configure the port to be used for access to the mail server.

* Items in the E-mail Notification column: Items in the E-Mail Notification Ac-
count column: Specify these items to use on-demand e-mail notification.

B click [appiy1.

Auto E-mail Notification

ﬂ In the menu area, click [Auto E-mail Notification].
The dialog box for making notification settings appears.

EI Make the following settings:

* Notification Message: You can set this according to your needs, for exam-
ple, the machine's location, service representative contact information.

212



Monitoring and Configuring the Printer

e Items in the Groups to Notify column: E-mail notification addresses can be
grouped as required.

e Items in the Select Groups/Items to Notify column: Select groups for each
notification type, such as machine status and error.
To make detailed settings for these items, click [Edit] next to [Details of E-
mail Notification Settings].

B Click [Apply]-
ﬂ Quit Web Image Monitor.

On-demand E-mail Notification

ﬂ In the menu area, click [On-demand E-mail Notification].
The dialog box for making notification settings appears.

ﬂ Make the following settings:

* Notification Subject: Enter a text string to be added to the subject line of
return e-mails.

e Items in the Access Restriction to Information column: Select whether to
restrict accesses based on a specific category of information.

* |tems in the Receivable E-mail Address/Domain Name Settings column:
Enter an e-mail address or domain name to use for requesting information
by e-mail and to receive its return e-mail.

E click [Appiy].
ﬂ Quit Web Image Monitor.

E-Mail authentication
You can configure mail authentication to prevent illegal use of the mail server.

< SMTP Authentication
Specify SMTP authentication (PLAN, LOGIN, CRAM-MD5, and DIGEST-
MD5).
When mail is sent to the SMTP server, authentication is performed using the
SMTP AUTH protocol by prompting the mail originator to enter the user name
and password. This prevents illegal use of the SMTP server.

@ In the menu area, click [E-mail]
@ Make the following settings:
e SMTP Auth. E-mail Address: Enter the e-mail address.
e SMTP Auth. User Name: Enter the SMTP account name.
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e SMTP Auth. Password: To set or change the password for SMTP AU-
TH.

e SMTP Auth. Encryption: Select whether to encrypt the password or not.
® Click [Apply]
@ Quit Web Image Monitor.

% POP before SMTP Authentication
Select whether to log on to the POP3 server before sending e-mail.

@ In the menu area, click [E-mail].
@ Make the following settings:
e POP E-mail Address: Enter the e-mail address.
* POP User Name: Enter the POP account name.
e POP Password: To set or change the POP password.

* Timeout setting after POP Auth.: Enter the time available before con-
necting to the SMTP server after logging on to the POP server.

® Click [Apply].
@ Quit Web Image Monitor.

On-demand E-mail Notification

To use on-demand e-mail notification, perform the following configuration tasks
in Web Image Monitor.

[I In the menu area, click [E-mail].

EI Make the following settings:

¢ Mail Notification Address: Enter the address using alphanumeric charac-
ters.

e Mail Notification Reception: Specify whether to use on-demand e-mail no-
tification.

¢ Mail Notification User Name: Enter the administrator's user name as the
mail originator name.

¢ Mail Notification Password: Enter the password of the mail notification us-
er.
B Click [Apply]-

ﬂ Quit Web Image Monitor.

I] Format of on-demand e-mail messages
To use mail notification, you must send an on-demand e-mail message to
this machine.
Using your mail software, enter the following:
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Item Description

Subject Enter a request regarding the device. For
details, see the table below.

From Specify a valid mail address. The device in-
formation will be sent to the address speci-
fied here.

O The mail message must be cannot be more than 10 KB.
O E-mail may be incomplete if sent immediately after power on.

% Subiject field

Format: devicestatus?parameter-name=parameter[&=parameter[&=pa-

rameter]]...

O The Subject field is not case-sensitive.
(O Parameter names can be written in any order.

« Subject field coding examples

Coding example

Action

devicestatus?request=sysconfig&for-
mat=text&lang=en

The device's system configuration informa-
tion is sent in an English text format.

devicestatus?request=sysconfig

The device's system configuration informa-
tion is sent in a preset format and lan-
guage.

< Parameters

Parameter Meaning Default

request Information to be obtained | Mandatory

format Mail format Mail is sent in the format
preset for each mail ad-
dress.

lang Language for mail body Mail is sent in the language
preset for each mail ad-
dress.

+« Parameters that specify the information to be obtained

Information to be obtained Parameter
System configuration sysconfig
Network configuration netconfig
Printer configuration prtconfig
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Information to be obtained Parameter
Supplies supply
Device status status

% Parameters that specify the mail format

Mail format Parameter
Text text

HTML html

XML xml

% Parameters that specify the language for mail bodies

Language Parameter
Japanese ja
English en
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Remote Maintenance by telnet

b d | mportant
O Remote Maintenance should be password-protected so that access is al-
lowed to administrators only.

O The password is the same as the one of Web Image Monitor administrator.
When the password is changed using “mshell”, other passwords change also.

0 Some commands cannot be used depending on your printer.

Using telnet

Follow the procedure below to use telnet.

S @ | mportant
3 Only one user at a time can log on to perform remote maintenance.

ﬂ Use the IP address or the host name of the printer to start telnet.

% telnetIP_ address

ﬂ Enter your user name and password.

To use default account, enter “admin” as user name, and leave the password
blank.

B Enter a command.

ﬂ Quit telnet.
msh> logout
The configuration message about saving the changes appears.

B Enter “yes” to save the changes, and then press the [# Enter] key.

If you do not want to save the changes, enter “no”, and then press the [# En-
ter] key. To make further changes, enter “return” at the command line, and
then press the [# Enter] key.

3 If the message “Can not write NVRAM information” appears, the changes
are not saved. Repeat the procedure above.

O When the changes are saved, the network interface board is reset auto-
matically with that changes.

0 When the network interface board resets, the print job in print process will
be printed. However, print jobs in queue will be canceled.
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access

Use the “access” command to view and configure access control. You can also
specify two or more access ranges.

% View settings

msh> access

% Configuration
msh> access 3 range “start-address end-address”

* +r represents a target number between 1 and 5. (Up to five access ranges
can be registered and selected.)

Example: to specify accessible IP addresses between 192.168.0.10 and

192.168.0.20:

msh> access 1 range 192.168.0.10 192.168.0.20

< Access control initialization
msh> access flush

* Use the “flush” command to restore the default settings so that all access
ranges become “0.0.0.0”.

O The access range restricts computers from use of the printer by IP address.
If you do not need to restrict printing, make the setting “0.0.0.0”.

3 Valid ranges must be from lower (start address) to higher (end address).

O Up to five access ranges can be specified. The entry is invalid if the target
number is omitted.

3 You cannot access Web Image Monitor from a restricted IP address.

appletalk
Use the “appletalk” command to view and configure Appletalk parameters.

% View settings
msh> appletalk
* [2] means “active” and [0] means “inactive”.
e The default is [2].

% Changing PAP timeout configuration
msh> appletalk ptimeout value > 0
¢ Timeout value becomes effective.

msh> appletalk ptimeout value = 0
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¢ Timeout value becomes ineffective.

autonet

Use the “autonet” command to configure AutoNet parameters.
+« View settings
The following command displays the current AutoNet settings:
msh> autonet
« Configuration
You can configure AutoNet settings.
msh> autonet {on|off}
¢ {on} means “active” and {off} means “inactive”.

« Current interface priority configuration display

msh> autonet priority

% Interface priority configuration
msh> autonet priority “interface_ name”
* You can give interface's AutoNet parameter priority.
* Priority settings are available when multiple interfaces are installed.
* ip1394 can be specified only when the IEEE 1394 interface is installed.
* wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured
ether Ethernet interface
ip1394 IEEE 1394 interface
wlan IEEE 802.11b interface

O If an interface is not selected, the current interface connection settings remain
in effect.

=l Feference
For details about AutoNet, refer to autonet parameters.

btconfig

Use the “btconfig” command to make Bluetooth settings.

% View settings
Bluetooth settings are displayed.
msh> btconfig
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% Mode settings
You can set the Bluetooth operation mode to {private} or {public}.

msh. btconfig mode {private | public}
* The default is {public}.

devicename

Use the “devicename” command to display and change the printer name.

+« View settings

msh> devicename

«+ Printer name configuration

msh> devicename name “string”

¢ Enter a printer name using up to 31 alphanumeric characters.
e Set single names for each printer.

«» Printer name initialization
msh> devicename clear name
* Reset the printer name to its default.

dhcp

Use the “dhcp” command to configure DHCP settings.
% View settings
The following command displays the current DHCP settings.
msh> dhcp
% Configuration
You can configure DHCP.
msh> dhcp “interface_ name” {on|off}
¢ Click {on} to enable DHCP. Click {off} to disable DHCP.

¢ |f the DNS server address and domain name are obtained from DHCP, be
sure to click {on}.

* ip1394 can be specified only when the IEEE 1394 interface is installed.
* wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured
ether Ethernet interface
ip1394 IEEE 1394 interface
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Interface name Interface configured

wlan IEEE 802.11b interface

% Current interface priority configuration display
msh> dhcp priority

% Interface priority configuration
msh> dhcp priority “interface_name”
* You can select which interface has DHCP parameter priority.
* Priority settings are available when multiple interfaces are installed.

«» DNS server address selection
msh> dhcp dnsaddr {dhcp | static}

e Specify whether to obtain the DNS server address from the DHCP server
or use the address set by a user.

* To obtain the DNS server address from the DHCP server, specify “dhcp”.
To use the address set by a user, specify “static”.
< Domain name selection
msh> dhcp domainname {dhcp | static}

e Specify whether to obtain the domain name from the DNS server or use the
domain name set by a user.

* To obtain the domain name from the DHCP server, specify “dhcp”. To use
the domain name set by a user, specify “static”.

=l Feference
For details about DHCP functions, see p.319 “Using DHCP”.
For details about setting the DNS server address, see p.222 “dns”.
For details about setting the domain name, see p.224 “domainname”.

diprint
The direct printing port enables direct printing from a network-connected com-
puter.
Use the “diprint” command to change direct printing port settings.
+« View settings
The following command displays the current direct printing port settings:

msh> diprint
Example output:
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Y
°o

2
*»*

port 9100
timeout=300 (sec)
bidirect on
conn multi

apl async

* The “port” specifies the port number of the direct printing port.

e The “bidirect” setting indicates whether the direct printing port is bidirec-
tional or not.

Setting timeout
msh> diprint timeout [30~65535]

* You can specify the timeout interval to use when the printer is expecting
data from the network.

¢ The default is 300 seconds.

Setting bidirect
msh> diprint bidirect {on | off}
* You can specify whether the direct printing port is bidirectional or not.

Specifying the number of concurrent connections

msh> diprint conn [multi | single]
The above command specifies the number of concurrent diprint connections.
Specify “multi” for multiple connections or “single” for a single connection.

Specifying synchronization

msh> diprint apl [async | sync]

The above command specifies whether to synchronize disconnection and ap-
plication termination. Specify “sync” if you want to perform synchronization, or
“async” otherwise.

dns

Use the “dns” command to configure or display DNS (Domain Name System)
settings.

R
%

R
%

View settings
The following command displays current DNS settings:

msh> dns

DNS server configuration
The following command enables or disables the DNS server address:

msh> dns “number” server “server address”
The following command displays a configuration using the IP address
192.168.15.16 on a DNS 1 server:
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msh> dns 1 server 192.168.15.16
* You can register up to three DNS server numbers.

* Applicable address numbers are 1 to 3. You can register up to three ad-
dresses.

¢ You cannot use “255.255.255.255” as the DNS server address.

< Dynamic DNS function setting
msh> dns “interface_name” ddns {on|off}
¢ You can set the dynamic DNS function “active” or “inactive”.
¢ {on} means “active” and {off} means “inactive”.
* ip1394 can be specified only when the IEEE 1394 interface is installed.
* wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured
ether Ethernet interface
ip1394 IEEE 1394 interface
wlan IEEE 802.11b interface

% Specifying the record overlap operation
msh> dns overlap {update|add}
* You can specify operations performed when records overlap.

e update
To delete old records and register new records.

e add
To add new records and store the old records.

* When CNAME overlaps, it is always changed, irrespective of settings.

< CNAME registration
msh> dns cname {on|off}
* You can specify whether to register CNAME.
¢ {on} means “active” and {off} means “inactive”.

* The CNAME registered is the default name beginning with rnp. CNAME
cannot be changed.

% A records registration

msh> dns arecord {dhcp|own}

* {dhcp}
You can specify the method of registering an A record when the dynamic
DNS function is enabled and DHCP is used.

e {own}
To register an A record using the printer as the DNS client.
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The DNS server address and the domain name already designated are
used for the registration.
% Record updating interval settings
msh> dns interval “time”

* You can specify the interval after which records are updated when using
the dynamic DNS function.

* The updating interval is specified hourly. It can be entered between 1 and
255 hours.

¢ The default is 24 hours.

domainname

Use the “domainname” command to display or configure the domain name set-
tings.

You can configure the Ethernet interface, IEEE 1394 interface, or IEEE 802.11b
interface.
« View settings

The following command displays the current domain name:

msh> domainname

% Interface domain configuration

msh> domainname “interface_ name”

+ Setting the Domain Name
msh> domainname “interface_name” name “domain name”
* A domain name can be entered using up to 63 alphanumeric characters.

¢ The Ethernet interface and IEEE 802.11b interface will have the same do-
main name.

* ip1394 can be specified only when the IEEE 1394 interface is installed.
* wlan can be specified only when the IEEE 802.11b interface is installed.

Interface Interface set

ether Ethernet interface
ip1394 IEEE 1394 interface
wlan IEEE 802.11b interface

+ Deleting the Domain Name

msh> domainname “interface name” clear name
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hel

P

Use the “help” command to display the available command list and the proce-

dures for using those commands.

% Command list display

msh> help

+ Display of procedure for using commands

msh> help “command name”

hostname

Use the “hostname” command to change the printer name.

% View settings

msh> hostname

« Configuration

msh> hostname “interface_name” “printer name”

Enter the printer name using up to 63 alphanumeric characters.

You cannot use a printer name starting with “RNP” or “rnp”.

The Ethernet interface and IEEE 802.11b interface will have the same

printer name.

ip1394 can be specified only when the IEEE 1394 interface is installed.
wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name

Interface configured

ether Ethernet interface
ip1394 IEEE 1394 interface
wlan IEEE 802.11b interface

+ Initializing the printer name for each interface

msh>hostname “interface name” clear name

ifconfig

Use the “ifconfig” command to configure TCP/IP (IP address, subnet mask,
broadcast address, default gateway address) for the printer.

% View settings

msh> ifconfig
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% Configuration
msh> ifconfig “interface_name” “parameter” “address”

* [f you did not enter an interface name, it is automatically set to the Ethernet
interface.

* ip1394 can be specified only when the IEEE 1394 interface is installed.
* wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured
ether Ethernet Interface
ip1394 IEEE 1394 Interface
wlan IEEE 802.11b Interface

% Netmask configuration

msh> ifconfig “interface_name” netmask “address”

+« Broadcast address configuration

msh> ifconfig “interface_name” broadcast “address”

% Changing the Interface
msh> ifconfig “interface” up

* You can specify either the Ethernet interface or IEEE 802.11b interface
when using the optional IEEE 802.11b interface unit.
You cannot specify the IEEE 1394 interface.
The following explains how to configure an IP address 192.168.15.16 on
Ethernet interface.

msh> ifconfig ether 192.168.15.16
The following explains how to configure a subnet mask 255.255.255.0 on
Ethernet interface.

msh> ifconfig ether netmask 255.255.255.0
O To get the above addresses, contact your network administrator.
O Use the default configuration if you cannot obtain setting addresses.

O The IP address, subnet mask and broadcast address are the same as that for
the ethernet interface and IEEE 802.11b interface.

O When installing the optional 1394 Interface board, set the IP address and sub-
net mask so that it does not overlap with the ethernet interface or the IEEE
1394 interface.

O TCP/IP configuration is the same for both Ethernet and IEEE 802.11b inter-
face. If interfaces are changed, the new interface inherits the configuration.

O Use “0Ox” as the initial two letters of a hexadecimal address.
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info

Use the “info” command to display printer information such as paper tray, output
tray, and printer language.

R
%

Printer information display

msh> info

=l Reference

For details about displayed contents, see p.248 “Getting Printer Information
over the Network”.

ipp

Use the “ipp” command to configure IPP settings.

R
L X4

Viewing settings
The following command displays the current IPP settings:

msh> ipp
Example output:

timeout=900 (sec)
auth basic

* The “timeout” setting specifies how many seconds the computer tries to
send print jobs when no connection can be made to the network printer.

* The “auth” setting indicates the user authorization mode.

IPP timeout configuration
Specify how many seconds the computer waits before canceling an interrupt-
ed print job. The time can be entered between 30 to 65535 seconds.

msh> ipp timeout [30 - 65535]

IPP user authorization configuration
Use IPP user authorization to restrict users to print with IPP. The default is
“Off”_

msh> ipp auth {basic|digest|off}
¢ User authorization settings are “basic” and “digest”.
* Use “off” to remove a user's authorization.

* If user authorization is specified, register a user name. You can register up
to 10 users.

IPP user configuration
Use the following command:

msh> ipp user
The following message appears:
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msh> Input user number (1 to 10):
Enter the number, user name, and password.

msh> IPP user name:userl
msh> IPP password:****x*x*
After configuring the settings, the following message appears:

User configuration changed.

netware

Use the “netware” command to configure the NetWare settings such as the print

server name or file server name.

R
%

2
*»*

Y
°o

Y
°o

Y
°o

Netware Printer Server Names
msh> netware pname
* Enter the NetWare print server name using up to 47 characters.

Netware File Server Names
msh> netware fname
* Enter the NetWare file server name using up to 47 characters.

Encap type
msh> netware encap [802.3/802.2/snap/ethernet2/auto]

Remote Printer Number

msh> netware rnum

Timeout

msh> netware timeout

Printer server mode

msh> netware mode pserver
msh> netware mode ps

Remote printer mode

msh> netware mode rprinter
msh> netware mode rp

NDS context name

msh> netware context

SAP interval

msh> netware “sap_interval”
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% Setting login mode for file server

msh> netware login server

« Setting login mode for NDS tree

msh> netware login tree

+ Setting login mode for NDS tree name

msh> netware tree “NDS name”

% Displaying the current file transfer protocol

msh> netware trans

Setting Display

TCP/IP + IPX (TCP/IP priority) “TCP/IP + IPX(TCP/IP priority)”
TCP/IP + IPX (IPX priority) “TCP/IP + IPX(IPX priority)”
TCP/IP “TCP/IP”

IPX “IPX”

« Specifying the file transfer protocol

msh> netware trans tcppri

e The above command specifies TCP/IP and IPX(TCP/IP priority) as the file
transfer protocol.

msh> netware trans ipxpri

e The above command specifies TCP/IP and IPX (IPX priority) as the file
transfer protocol.

msh> netware trans tcp

* The above command specifies TCP/IP as the file transfer protocol.
msh> netware trans ipx

* The above command specifies IPX as the file transfer protocol.

passwd
Use the “passwd” command to change the remote maintenance password.

+« Changing the Password
msh> passwd
e Enter the current password.
e Enter the new password.
* Enter the new password once again.
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% Changing the administrator's password
msh> passwd adminID
* When [New password:] appears, enter the new password.
* When [Retype new password:] appears, re-enter the new password.
S @ | mportant

3 This operation can only be performed by users who have supervisor per-
mission.

O When changing the password via telnet, take adequate security measures
to prevent information leakage.

 Be sure not to forget or lose the password.
O The password can be entered using up to 32 alphanumeric characters. Pass-

words are case-sensitive. For example, “R” is not the same as “r".

prnlog
Use the “prnlog” command to obtain printer log information.

+ Print logs display
msh> prnlog
* Displays 16 previous print jobs.
msh> prnlog ID Number

* Specify the ID number of the displayed print log information to display ad-
ditional details about a print job.

O For details about displayed contents, see p.248 “Getting Printer Information
over the Network”.

rendezvous

Use the “rendezvous” command to display rendezvous-related settings.

% View settings
Rendezvous settings are displayed.

msh> rendezvous

+ Current computer name display

msh> rendezvous cname

% Display information about the current printer location

msh> rendezvous location
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+ Rendezvous computer name setting
You can specify the rendezvous computer name.

msh> rendezvous cname “computer name”

* The computer name can be entered using up to 63 alphanumeric charac-
ters.

+ rendezvous Installation location information setting
You can enter information about the location where the printer is installed.

msh> rendezvous location “location”
* Information about location can be entered using up to 32 alphanumeric
characters.

% Setting order of priority for each protocol

e diprint

msh> rendezvous diprint [0-99]
e lpr

msh> rendezvous lpr [0-99]
* ipp

msh> rendezvous ipp [0-99]
You can specify the order of priority for “diprint”, “Ipr”, and “ipp”. Smaller num-
bers indicate higher priority.

% IP TTL setting

msh> rendezvous ipttl {1-255}

You can specify the IP TTL (the number of routers a packet can pass
through).

3 The default is 255.

% Resetting the computer name and location information
You can reset the computer name and location information.

msh> rendezvous clear {cname | location}

* chame
Reset the computer name. The default computer name will be displayed
when the computer is restarted.

* |ocation
Reset the location information. The previous location information will be
deleted.

% Interface configuration

msh> rendezvous linklocal “interface_ name”

* If many types of interface are installed, configure the interface that commu-
nicates with linklocal address.
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If you do not specify an interface, the Ethernet interface is automatically se-
lected.

* ip1394 can be specified only when the IEEE 1394 interface is installed.
* wlan can be specified only when the IEEE 802.11b interface is installed.

Interface Interface configured

ether Ethernet interface

ip1394 IEEE 1394 interface

wlan IEEE 802.11b interface
route

Use the “route” command to control the routing table.

+ All route information display

msh> route get

% Specified route information display
msh> route “destination”
* Specify the IP address to destination.

< Enabling/disabling Specified Destination
msh> route active {host|net} “destination” {on | off}
* You can turn the specified destination on or off. Host becomes the default
setting.
% Adding Routing Table
msh> route add {host|net} “destination” “gateway”

* Adds a host or network route to “destination”, and a gateway address to
“gateway” in the table.

* Specify the IP address to destination and gateway.
* Host becomes the default setting.

% Setting Default Gateway

msh> route add default gateway

% Deleting Specified destination from Routing Table
msh> route delete {host|net} “destination”
* Host becomes the default setting.
e |P address of destination can be specified.
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< Route Flush

msh> route flush
(3 The maximum number of routing tables is 16.
O Set a gateway address when communicating with devices on an external net-

work.

O The same gateway address is shared by all interfaces.

set

Use the “set” command to set the protocol information display “active” or “inac-

tive”.

% View settings
The following command displays protocol information (active/inactive).

msh>
msh>
msh>
msh>

msh>

set
set
set
set

set

tcpip
appletalk
netware
smb

scsiprint

* scsiprint is available when the optional IEEE 1394 interface board is in-
stalled.

msh> set ipl394
* ip1394 can be specified only when the IEEE 1394 interface is installed.

msh> set pictbridge
* pictbridge can be specified only when the pictbridge is installed.
msh> set protocol

* When protocol is specified, information about TCP/IP, AppleTalk, Netware,
and SMB appears.

msh>
msh>
msh>
msh>
msh>
msh>
msh>
msh>
msh>

msh>

set
set
set
set
set
set
set
set
set

set

lpr

ftp
rsh
diprint
web
snmp
ssl

nrs

rfu

ipp

233



Monitoring and Configuring the Printer

msh> set http

msh> set rendezvous
msh> set nbt

msh> set ssdp

msh> set parallel
msh> set bluetooth
msh> set usb

msh> set device

Configuration

e Enter “up”to enable protocol, and enter “down” to disable protocol.
You can set the protocol to “active” or “inactive”.

msh> set tcpip {up | down}

* If you disable TCP/IP, you cannot use remote access after logging off. If
you did this by mistake, you can use the control panel to enable remote ac-
cess via TCP/IP.

e Disabling TCP/IP also disables ip1394, Ipr, ftp, rsh, diprint, web, snmp, ssl,
ipp, http, and rendezvous

msh> set appletalk {up | down}
msh> set netware {up | down}
msh> set smb {up | down}

msh> set scsiprint {up | down}

* scsiprint is available when the optional IEEE 1394 interface board is in-
stalled.

msh> set pictbridge {up | down}

* pictbridge can be specified only when the pictbridge is installed.
msh> set ipl1394 {up | down}

* ip1394 can be specified only when the IEEE 1394 interface is installed.
msh> set lpr {up | down}

msh> set ftp {up | down}

msh> set rsh {up | down}

msh> set diprint {up | down}

msh> set web {up | down}

msh> set snmp {up | down}

msh> set ssl {up | down}

* |If Secured Sockets Layer (SSL, an encryption protocol) function is not
available for the printer, you cannot use the function by enabling it.

msh> set nrs {up | down}

msh> set rfu {up | down}
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msh> set ipp {up | down}

msh> set http {up | down}

msh> set rendezvous {up | down}
msh> set nbt {up | down}

msh> set ssdp {up | down}

msh> set parallel {up | down}
msh> set bluetooth {up | down}
msh> set usb {up | down}

msh> set device {up | down}

show

Use the “show” command to display network interface board configuration set-
tings.
+« View settings
msh> show
* |f “p” is added, you can view settings one by one.
=l Feference

For details about the information displayed, see p.257 “Configuring the Net-
work Interface Board”.

slp

Use “slp” command to configure SLP settings.
msh> slp ttl “ttl_val”

* You can search the NetWare server using SLP in the PurelP environment of
NetWare 5/5.1 and Netware 6/6.5. Using the “slp” command, you can config-
ure the value of TTL which can be used by SLP multicast packet.

e The default value of TTL is 1. A search is executed only within a local seg-
ment. If the router does not support multicast, the settings are not available
even if the TTL value is increased.

* The acceptable TTL value is between 1 and 255.

smb

Use the “smb” command to configure or delete the computer or workgroup name
for SMB.

< Computer Name settings

msh> smb comp
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e Set computer name using up to 15 characters. Names beginning with
“RNP” or “rnp” cannot be entered.
% Working Group Name settings
msh> smb group
e Set workgroup name using up to 15 characters

< Comment settings
msh> smb comment
e Set comment using up to 31 characters

% Notify print job completion
msh> smb notif {on | off}
* To notify print job completion, specify “on”. Otherwise, specify “off’

% Deleting Computer Name

msh> smb clear comp

+ Deleting Group Name

msh> smb clear group

+ Deleting Comment

msh> smb clear comment

% Protocol settings
msh> smb protocol [tcpip {up | down}]
e Enable or disable TCP/IP. Specify “up” to enable, and “down” to disable.

+ Display

msh> smb protocol

snmp

Use the “snmp” command to display and edit SNMP configuration settings such
as the community name.

% View settings
msh> snmp
e Default access settings 1 is as follows:
Community name:public

IP address:0.0.0.0
Access type:read-only / trap off

* Default access settings 2 is as follows:
Community name:admin
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IP address:0.0.0.0
Access type:read-write / trap off

If “-p” is added, you can view settings one by one.
To display the current community, specify its registration number.

% Display

msh> snmp ?

< Community name configuration

msh> snmp “number” name “community name”

You can configure ten SNMP access settings numbered 1-10.

The printer cannot be accessed from SmartDeviceMonitor for Admin or
SmartDeviceMonitor for Client if “public” is not registered in numbers 1-10.
When changing the community name, use SmartDeviceMonitor for Admin
and SNMP Setup Tool to correspond with printer settings.

The community name can be entered using up to 15 characters.

% Deleting community name

msh> snmp “number” clear name

% Access type configuration

msh> snmp “number” type “access_type”

Access type Type of access permission

no not accessible

read read only

write read and write

trap user is notified of trap messages

% Protocol configuration
msh> snmp {ip | ipx} {on | off}

M.

Use the following command to set protocols “active” or “inactive”: If you set
a protocol “inactive”, all access settings for that protocol are disabled.

Specify “ip” for TCP/IP, or “ipx” for IPX/SPX.
{on} means “active” and {off} means “inactive”.
IEEE 1394 interface is available for TCP/IP only.

« Configuration of protocol for each registration number

msh> snmp “number” active {ip | ipx} {on | off}

To change the protocol of access settings, use the following command.
However, if you have disabled a protocol with the above command, activat-
ing it here has no effect.
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% Access configuration
msh> snmp “number” {ip/addr | ipx} “address”
* You can configure a host address according to the protocol used.

* The network interface board accepts requests only from hosts that have
addresses with access types of “read-only” or “read-write”. Enter “0” to
have network interface board accept requests from any host without requir-
ing a specific type of access.

* Enter a host address to deliver “trap” access type information to.
* To specify TCP/IP, enter “ip” followed by a space, and then the IP address.

e To specify IPX/SPX, enter “ipx” followed by a space, the IPX address fol-
lowed by a decimal, and then the MAC address of the network interface
board.

+ sysLocation configuration

msh> snmp location

+ Deleting sysLocation

msh> snmp clear location

+ sysContact setting

msh> snmp contact

+ Deleting sysContact

msh> snmp clear contact

% SNMP v1v2 function configuration
msh> snmp vlv2 {on | off}
* Specify “on” to enable, and “off” to disable.

«+ SNMP v3 function configuration
msh> snmp v3 {on | off}
e Specify “on” to enable, and “off” to disable.

<+ SNMP TRAP configuration
msh> snmp trap {vl | v2 | v3} {on | off}
¢ Specify “on” to enable, and “off” to disable.

% Remote Configuration Authorization configuration
msh> snmp remote {on | off}
* Specify “on” to enable, and “off” to disable.

« SNMP v3 TRAP configuration display

msh> snmp v3trap
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msh> snmp v3trap {1- 5}
* Ifanumberfrom 1-5is entered, settings are displayed for that number only.

% Configuring a sending address for SNMP v3 TRAP
msh> snmp v3trap {1-5} {ip| ipx} address

% Configuring a sending protocol for SNMP v3 TRAP
msh> snmp v3trap {1-5} active {ip/addr | ipx} {on | off}

% Configuring a user account for SNMP v3 TRAP
msh> snmp v3trap {1-5} account account_name
* Enter an account name using up to 32 alphanumeric characters.

+ Deleting an SNMP v3 TRAP user account

msh> snmp v3trap {1-5} clear account

« Configuring an SNMP v3 encryption algorithm
msh> snmp v3auth {md5 | shal}

% Configuring SNMP v3 encryption
msh> snmp v3priv {auto | on}

¢ If you select “auto”, the print job will be encrypted when encryption is pos-
sible.

¢ Ifyou select “on”, Clear Text communication is not possible, and encryption
password must be set before encryption communication can be used.

O Encryption is possible when the security option is installed correctly and
the password is specified.

sntp

The printer clock can be synchronized with a NTP server clock using Simple Net-
work Time Protocol (SNTP). Use the “sntp” command to change SNTP settings.

% View settings
msh> sntp

% NTP server address configuration
You can specify the IP address of the NTP server.

msh> sntp server “IP_ address”

+ Interval configuration

msh> sntp interval “polling time”
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* You can specify the interval at which the printer synchronizes with the op-
erator-specified NTP server. The default is 60 minutes.

¢ The interval can be entered between 16 and 16,384 minutes.

* If you set 0, the printer synchronizes with the NTP server only when you
turn the printer on. After that, the printer does not synchronize with the NTP
server.

Time-zone configuration

msh> sntp timezone “+/-hour_ time”

* You can specify the time difference between the printer clock and NTP
server clock. Time is in 24-hour format.

spoolsw

Use the “spoolsw” command to configure Job Spool settings.
You can only specify diprint, Ipr, ipp, ftp and smb protocol.

2
*»*

2
*»*

The “spoolsw” command for configuring Job Spool settings is available only
when the hard disk is installed.

View settings
The Job Spool setting appears.

msh> spoolsw

Job Spool setting
msh> spoolsw spool {on | off}

3 Specify “on” to enable Job Spool, or “off’ to disable it.

Resetting Job spool setting
msh> spoolsw clear job {on | off}

* When the printer power is cut during job spooling, this determines whether
to reprint the spooled job.

Protocol configuration

msh> spoolsw diprint {on | off}
msh> spoolsw lpr {on | off}
msh> spoolsw ipp {on | off}
msh> spoolsw smb {on | off}
msh> spoolsw ftp {on | off}

* You can specify the settings for diprint, Ipr, ipp, and smb.
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sprint
Use the “sprint” command to make settings for IEEE 1394 (SCSI print).

% View settings
IEEE 1394 (SCSI print) settings are displayed.
msh> sprint

% Bidirectional configuration for IEEE 1394 (SCSI print)

Use this setting to set IEEE 1394 (SCSI print) bidirectional.
The default is “on”.

msh> sprint bidi {on | off}

ssdp
Use the “ssdp” command to view and configue ssdp parameters.

% View settings

msh> ssdp

% Setting the effective time
msh> ssdp profile [1801 | 86400]
The default is 10800 seconds.

% Setting the advertise packet TTL

msh> ssdp ttl [1 | 225]
The default is 4.

status
The printer status can be checked using the following command:

% Messages
msh> status
=l Referencs
For details, see p.248 “Current Printer Status”.

syslog

Use the “syslog” command to display the information stored in the printer's sys-
tem log.
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% View message
msh> syslog

| [EEN

O For details about the information displayed, see p.263 “System Log Informa-

tion”.

upnp
Use the “upnp” command to display and configure the universal plug and play.

«+ Public URL display

msh> upnp url

+ Public URL configuration
msh> upnp url “string”
* Enter the URL string in the character string.

web

Use the “web” command to display and configure parameters on Web Image
Monitor.

% View Settings

msh> web

% URL Configuration
You can set URLs linked by clicking [URL] on Web Image Monitor.
Specify “1” or “2” for x as the number corresponding to the URL. Up to two
URLSs can be registered and specified.

msh> web url http://”The URL or IP address you want to
register”/
+ Deleting URLSs registered as link destinations

msh> web x clear url
Specify “1” or “2” for x as the corresponding number to the URL.

« Link name configuration
You can enter the name for [URL] that appears on Web Image Monitor.
Specify “1” or “2” for x as the corresponding number to the link name.

msh> web name “Name you want to display”

+ Deleting URL names registered as link destinations

msh> web x clear name
Specify “1” or “2” for x as the number corresponding to the link name.
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% Help URL Configuration

You can set URLs linked by clicking [Help] or [?] on Web Image Monitor.
msh> web help http://”Help URL or IP address”/help/

+ Deleting Help URL

msh> web clear help

wiconfig

Use the “wiconfig” command to make settings for IEEE 802.11b.

+« View settings
msh> wiconfig

+« View IEEE 802.11b settings

msh> wiconfig cardinfo

e If IEEE 802.11b is not working correctly, its information is not displayed.

% Configuration

msh> wiconfig “parameter”

Parameter

Value configured

mode [apladhoc|802.11adhoc]

You can set the infrastructure mode (ap) , the
802.11 Ad hoc mode (802.11 adhoc), or the
ad hoc mode (adhoc).

The default is ad hoc mode.

ssid ID value

You can make settings for the SSID in the in-
frastructure mode.

Usable characters are ASCIl 0x20-0x7e (32
bytes).

An SSID value is set automatically to the
nearest access point if no setting is made.

If no setting is made for the ad hoc mode, the
same value as for the infrastructure mode or
an ASSID value is automatically set.

channel frequency channel no.

You can enable or disable the WEP function.
To enable the WEP function, specify [on]; to
disable it, specify [off].

To start the WEP function, enter the correct
WEP key.

enc [onloff]

You can enable or disable the WEP function.
To enable the WEP function, specify [on]; to
disable it, specify [off].

To start the WEP function, enter the correct
WEP key.
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Parameter

Value configured

key [ key value ] val [112[314]

You can specify the WEP key when entering
in hexadecimal.

With a 64-bit WEP, you can use 10 digit
hexadecimals. With a 128-bit WEP, you can
use 26 digit hexadecimals.

Up to four WEP keys can be registered.
Specify the number to be registered with
“val”.

When a WEP is specified by key, the WEP
specified by key phrase is overwritten.

To use this function, set the same key num-
ber and WEP key for all ports that transmit
data to each other.

You can omit the numbers with “val”. The key
number is set to 1 when making these omis-
sions.

keyphrase [ phrase ] val [112/314]

You can specify the WEP key when entering
in ASCII.

With a 64-bit WEP, you can use 10 digit
hexadecimals. With a 128-bit WEP, you can
use 26 digit hexadecimals.

Up to four WEP keys can be registered.
Specify the number to be registered with
“val”.

When a WEP is specified by key phrase, the
WEP specified by key is overwritten.

To use this function, set the same key num-
ber and WEP key for all ports that transmit
data to each other.

You can omit the numbers with “val”. The key
number is set to 1 when making these omis-
sions.

encval [1121314]

You can specify which of the four WEP keys
is used for packet encoding. “1” is set if a
number is not specified.

auth [openlshared]

You can set an authorization mode when us-
ing WEP. The specified value and authorized
mode are as follows:

open: open system authorized (default)
shared: shared key authorized rate
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Parameter

Value configured

rate [autol11mI|5.5mI2m|1m]

You can set the IEEE 802.11b transmitting
speed.

The speed you specify here is the speed at
which data is sent. You can receive data at
any speed.

auto: automatically set (default)
11m: 11 Mbps fixed

5.5m: 5.5 Mbps fixed

2m: 2 Mbps fixed

1m: 1 Mbps fixed

wins

Use the “wins” command to configure WINS server settings.

+ Viewing settings

msh> wins

If the IP address obtained from DHCP differs from the WINS IP address,
the DHCP address is the valid address.

« Configuration

msh> wins “interface_name” {on | off}

{on} means “active” and {off} means “inactive”.

Be sure to specify the interface.

ip1394 can be specified only when the IEEE 1394 interface is installed.
wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured
ether Ethernet interface
ip1394 IEEE 1394 interface
wlan IEEE 802.11b interface

% Address configuration
Use the following command to configure a WINS server IP address:

msh> wins “interface_ name” {primary|secondary} “IP ad-
dress”

Use the “primary” command to configure a primary WINS server IP ad-

dress.

Use the “secondary” command to configure a secondary WINS server IP

address.

Do not use “255.255.255.255” as the IP address.
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% NBT (NetBIOS over TCP/IP) Scope ID Selection
You can specify the NBT scope ID.

msh> wins “interface_name” scope “scope ID”

The scope ID can be entered using up to 31 alphanumeric characters.
Be sure to specify the interface.
ip1394 can be specified only when the IEEE 1394 interface is installed.

wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured
ether Ethernet interface
ip1394 IEEE 1394 interface
wlan IEEE 802.11b interface
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SNMP

The SNMP agent operating on UDP and IPX is incorporated into the built-in
Ethernet board and optional IEEE 802.11b interface unit of this printer. Also, the
SNMP agent operating on UDP is incorporated in the optional IEEE 1394 inter-

face board.

Using the SNMP manager, you can get information about the printer.

b d | mportant

3 If you changed the printer's community name, change the configuration of the
connected computer accordingly, using SNMP Setup Tool. For details, see

SNMP Setup Tool Help.

The default community names are [public] and [admin]. You can get MIB informa-

tion using these community names.

«+ Start SNMP Setup Tool

Windows 95/98/Me, Windows 2000, Windows NT 4.0:

Click the [Start] button.

Point to [SmartDeviceMonitor for Admin] on the [Programs] menu.

Click [SNMP Setup Tool].

Windows XP:

Click the [Start] button.

Point to [SmartDeviceMonitor for Admin] on the [All Programs] menu.

Click [SNMP Setup Tool].

% Supported MIBs (SNMPv1/v2)

MIB-II

PrinterMIB
HostResourceMIB
RicohPrivateMIB

« Supported MIBs (SNMPv3)

MIB-II

PrinterMIB

HostResourceMIB
RicohPrivateMIB
SNMP-FRAMEWORK-MIB
SNMP-TARGET-MIB
SNMP-NOTIFICATION-MIB
SNMP-USER-BASED-SM-MIB
SNMP-VIEW-BASED-ACM-MIB
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Getting Printer Information over the

Network

This section explains details of each item displayed in the printer status and in-

formation.

Current Printer Status

The printer status can be checked using the following commands:
e UNIX: Use the “Ipg” command and “rsh”, “rcp”, and “ftp” parameters.

¢ mshell: Use the “status” command.

Messages

Description

Access Restricted

The job was canceled because user have no
authority.

Add staples (Booklet: Back)

The staple of booklet finisher (back) is ex-
hausted.

Add staples (Booklet: Both)

The staple of booklet finisher is exhausted.

Add staples (Booklet: Front)

The staple of booklet finisher (front) is exhaust-
ed.

Adjusting...

The machine is initializing or calibrating.

Call Service Center

There is a malfunction in the machine.

Canceled

The job is reset.

Canceling Job...

The job is being reset.

Card/Counter not inserted

The machine is waiting for prepaid card or key.

Coin or amount not inserted

The machine is waiting for coin to be inserted.

Coin/Key Counter not inserted

The machine is waiting for coin or key counter.

Configuring...

Setting is being changed.

Cover Open: ADF

The document feeder is open.

Cover Open: Duplex Unit

The cover of the duplex unit is open.

Cover Open: Finisher

The cover of Finisher is open.

Cover Open: Front

The front cover is open.

Cover Open: Front/Left

The front cover or left cover is open.

Cover Open: Paper Exit / Rear

The paper exit cover or rear cover is open.

Cover Open: Right

The right cover is open.

Cover Open: Top

The top cover is open.

Data Size Error

The data size error occurred.
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Messages

Description

Empty: Black Toner

The black toner cartridge is almost empty.

Empty: Cyan Toner

The cyan toner cartridge is almost empty.

Empty: Magenta Toner

The magenta toner cartridge is almost empty.

Empty: Yellow Toner

The yellow toner cartridge is almost empty.

Energy Saver Mode

The machine is in Energy Saver Mode.

Error

An error has occurred.

Error at Printer: Red LED

An error has occurred.

Error in Printer

An error has occurred.

Error: Address Book

An error has occurred in the data of the ad-
dress book.

Error: Command Transmission

An error has occurred in the machine.

Error: DIMM Value

A memory error occurred.

Error: Ethernet Board

An Ethernet board error has occurred.

Error: HDD Board

A hard disk drive board error has occurred.

Error: IEEE1394 Board

An IEEE 1394 interface board error has oc-
curred.

Error: Memory Switch

A memory switch error has occurred.

Error: Optional Font

An error has occurred in the font file of the ma-
chine.

Error: Optional RAM

An error has occurred in the optional memory
unit.

Error: Parallel I/F Board

An error has occurred in the parallel interface.

Error: PDL

An error has occurred in the page description
language.

Error: USB Interface

An error has occurred in the USB interface.

Error: Wireless Card

Wireless card is not inserted during start up, or
the IEEE 802.11b interface unit or the wireless
card is taken out after start up.

Error: Wireless Card or Board

An error has occurred in the IEEE 802.11b in-
terface unit.

Exceed Booklet Stapling Limit

The printing has exceeded the stapling limit of
the booklet finisher.

Full: Copy Tray

The output paper tray is full.

Full: Finisher

Finisher tray is full.

Full: Finisher Shift Tray

Shift tray of Finisher is full.

Full: Finisher Shift Tray 1, 2

The shift tray 1 and 2 of Finisher are full.

Full: Finisher Upper Tray

The upper tray of Finisher is full.
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Messages

Description

Full: Hole Punch Receptacle

Punch Chip receptacle for hole punch is full.

Full: Standard Tray

The output paper tray is full.

Full: Waste Toner

Waste toner is full.

Full: Waste Toner Bottle

Waste toner bottle is full.

Hex Dump Mode

It is a hex dump mode.

Immed. Trans. not connected

It did not connect directly with the other party
of the transmission.

Immediate Transmission Failed

An error has occurred while transmitting direct-
ly.

In Use: Copier

The copier is being used.

In Use: Fax

The fax is being used.

In Use: Finisher

Other functions is using Finisher.

In Use: Input Tray

Other functions is using the input tray.

In Use: Staple Unit

Other functions is using the staple unit.

Independent-supplier Toner

Toner that is not recommended is set.

Key Card not inserted

The machine is waiting for key card to be in-
serted.

Key Card/Counter not inserted

The machine is waiting for key card or key
counter to be inserted.

Key Counter not inserted

The machine is waiting for key counter to be
left in it.

Loading Toner...

Toner is being supplied.

Low: Black Toner

The black toner cartridge is not set correctly, or
toner is almost running out.

Low: Cyan Toner

The cyan toner cartridge is not set correctly, or
toner is almost running out.

Low: Magenta Toner

The magenta toner cartridge is not set correct-
ly, or toner is almost running out.

Low: Toner

The black toner cartridge is not set correctly, or
toner is almost running out.

Low: Yellow Toner

The yellow toner cartridge is not set correctly,
or toner is almost running out.

Malfunction: Booklet Processor

There is a problem with booklet finisher.

Malfunction: Ext. Charge Unit

There is a problem with external charge unit.

Malfunction: Finisher

There is a problem with Finisher.

Malfunction: Interposer

There is a problem with Interposer.

Malfunction: LargeCapacity Tray

There is a problem with LargeCapacity tray.

Malfunction: Output Tray

There is a problem with output tray.
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Messages

Description

Malfunction: Staple Unit

There is a problem with the staple unit.

Malfunction: Tray 1

There is a problem with tray 1.

Malfunction: Tray 2

There is a problem with tray 2.

Malfunction: Tray 3

There is a problem with tray 3.

Malfunction: Tray 4

There is a problem with tray 4.

Malfunction: Z-folding unit

There is a problem with the Z fold unit.

Memory Low: Copy

Memory shortage has occurred while the copy
was operating.

Memory Low: Data Storage

Memory shortage has occurred while the doc-
ument was being accumulated.

Memory Low: Fax Scanning

Memory shortage has occurred while transmit-
ting the fax.

Memory Low: Scanning

Memory shortage has occurred while the
scanner was working.

Miscellaneous Error

Other error has occurred.

Mismatch: Paper Size

Indicated paper tray does not contain paper of
selected size.

Mismatch: Paper Size and Type

Indicated paper tray does not contain paper of
selected size and type.

Mismatch: Paper Type

Indicated paper tray does not contain paper of
selected type.

Near Replacing:

Black PCU

Prepare the new black photoconductor unit.

Near Replacing:

Color PCU

Prepare the new color photoconductor unit.

Near Replacing:

Develop. Unit C

Prepare the new development unit (cyan).

Near Replacing:

Develop. Unit K

Prepare the new development unit (black).

Near Replacing:

Develop. Unit M

Near Replacing:

Develop. Unit Y

(
Prepare the new development unit (magenta).
(

Prepare the new development unit (yellow).

Near Replacing:

Fusing Unit

Prepare the new fusing unit.

Near Replacing:

Maintenance Kit

Prepare the new maintenance Kkit.

Near Replacing:

Transfer Unit

Prepare the new transfer unit.

Nearly Full: Waste Toner

Waste toner bottle is nearly full.

Need more Staples

Stapler has almost run out of staples.

No Paper: Interposer Tray

There is no paper in interposer unit.

No Paper: LCT

There is no paper in Large Capacity tray.

No Paper: Selected Tray

There is no paper in specified tray.

No Paper: Tray 1

There is no paper in tray 1.

No Paper: Tray 2

There is no paper in tray 2.
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Messages

Description

No Paper: Tray 3

There is no paper in tray 3.

No Paper: Tray 4

There is no paper in tray 4.

Not Detected: B2 Lever B2 lever is not correctly set.
Not Detected: Black Toner Black toner is not correctly set.
Not Detected: Cyan Toner Cyan toner is not correctly set.

Not Detected:

Develop. Unit (C)

The development unit (cyan) is not correctly
set.

Not Detected:

Develop. Unit (K)

The development unit (black) is not correctly
set.

Not Detected:

Develop. Unit (M)

The development unit (magenta) is not cor-
rectly set.

Not Detected:

Develop. Unit (Y)

The development unit (yellow) is not correctly
set.

Not Detected:

Duplex Feed Unit

The duplex feed unit is not correctly set.

Not Detected: Finisher Finisher is not correctly set.

Not Detected: Fusing Unit The fusing unit is not correctly set.

Not Detected: Input Tray The paper feed tray is not correctly set.

Not Detected: Interposer Interposer unit is not correctly set.

Not Detected: LCT A large amount of paper feed tray is not cor-

rectly set.

Not Detected:

Magenta Toner

Magenta toner is not correctly set.

Not Detected: PCU (C) The photoconductor unit (cyan) is not correctly
set.

Not Detected: PCU (K) The photoconductor unit (black) is not correct-
ly set.

Not Detected: PCU (M) The photoconductor unit (magenta) is not cor-
rectly set.

Not Detected: PCU (Y) The photoconductor unit (yellow) is not cor-

rectly set.

Not Detected:

Toner Magazine

The toner cartridge is not correctly set.

Not Detected:

Transfer Roller

The transfer roller is not correctly set.

Not Detected:

Transfer Unit

The transfer unit is not correctly set.

Not Detected: Tray 1 Tray 1 is not correctly set.
Not Detected: Tray 2 Tray 2 is not correctly set.
Not Detected: Tray 3 Tray 3 is not correctly set.
Not Detected: Tray 4 Tray 4 is not correctly set.

Not Detected:

WasteToner Bottle

Woaste toner bottle is not correctly set.
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Messages

Description

Not Detected: Yellow Toner

Yellow toner is not correctly set.

Not Detected: Z-fold’g Internal

The Z-fold unit is not correctly set.

Not Reached, Data Deleted

Unreached job is deleted.

Not Reached, Data Removed

Unreached job is deleted.

Not Reached, Data Stored

Unreached job is preserved.

Offline

Printer is offline.

Original on Exposure Glass

The original remains on the exposure glass.

Panel Off Mode

The machine is in Panel-Off mode.

Panel Off Mode>>Printing ava.

The machine is in Control Panel-Off mode.

Paper in Duplex Unit

The paper remains in the duplex unit.

Paper in Finisher

The paper remains in Finisher.

Paper Misfeed: ADF

The paper has jammed in Document Feeder.

Paper Misfeed: Duplex Unit

The paper has jammed in the duplex unit.

Paper Misfeed: Input Tray

The paper has jammed in the input tray.

Paper Misfeed: Internal/Output

The paper has jammed inside the machine.

Paper Misfeed: Output Tray

The paper has jammed in output tray.

Paper on Finisher Shift Tray 2

The paper remains in Finisher Shift Tray 2.

Paper on FinisherShiftTray1, 2

The paper remains in Finisher Shift Tray 1 and
2.

Prepaid Card not inserted

The machine is waiting for prepaid card to be
inserted.

Print Complete

The print was completed.

Printing

Printing is in progress.

Processing

Data is being processed.

RC Gate Connection Error

Failed connection with RC Gate.

Ready

The machine is ready to print.

Replace Black PCU

It is time to replace the black photoconductor
unit.

Replace Charger

It is time to replace the charger kit.

Replace Cleaning Web

It is time to replace the Cleaning Web.

Replace Color PCU

It is time to replace the photoconductor unit
(color).

Replace Develop. Unit

It is time to replace the development unit.

Replace Develop. Unit (Black)

It is time to replace the development unit
(black).
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Messages

Description

Replace Develop. Unit (Color)

It is time to replace the development unit (col-
or).

Replace Develop. Unit (Cyan)

It is time to replace the development unit (cy-
an).

Replace Develop. Unit (Magenta)

It is time to replace the development unit (ma-
genta).

Replace Develop. Unit (Yellow)

It is exchange time of the development unit
(yellow).

Replace Fusing Unit

It is time to replace the fusing unit.

Replace Maintenance Kit

It is time to replace the maintenance kit.

Replace PCU

It is time to replace the photoconductor unit.

Replace Transfer Belt

It is time to replace the transfer belt.

SD Card Authentication failed

SD card authentication failed.

Setting Remotely

The RDS setting is being processed.

Skipped due to Error

Skipped the error.

Storage Complete

The storage is complete.

Storage Failed

The storage has failed.

Supplies Order Call failed

The supply order call has failed.

Suspend / Resume Key Error

Finisher stop button was pressed.

Transmission Aborted

The transmission was interrupted.

Transmission Complete

The transmission completion was completed.

Transmission Failed

The transmission has failed.

Tray Error: Chaptering

The paper feed tray specification error has oc-
curred because chaptering as well as the nor-
mal paper use the same tray for printing.

Tray Error: Duplex Printing

Selected paper tray cannot be used for duplex
printing.

Unit Left Open: ADF

Document feeder is opened.

Warming Up...

The machine is warming up.

O For details about UNIX commands, see UNIX Supplement.

O Check the error contents that may be printed in the configuration page. For
details about printing a configuration page, see p.161 “Printing a Configura-

tion Page”.

Printer configuration

You can check the printer configuration using telnet.




Monitoring and Configuring the Printer

This section explains the checking procedure for input/output tray and printer

language.

* UNIX: Use the “info” command and “rsh”, “rcp”, and “ftp” parameters.

* mshell: Use the “info” command.

+ Input Tray

ltem Description

No. ID number of the paper tray

Name Name of the paper tray

PaperSize Size of paper loaded in the paper tray
Status Current status of the paper tray

¢ Normal:Normal
e NolnputTray: No tray
e PaperEnd:No paper

% Output Tray

ltem Description

No. ID number of the output tray
Name Name of the output tray

Status Current status of the output tray

¢ Normal:Normal

e PaperExist:Paper exist
¢ OverFlow:Paper is full
e Error:Other errors

« Emulation

ltem Description

No. ID number of the printer language used by the
printer

Name Name of the printer language used in the print-
er

Version Version of the printer language

3 For details about UNIX commands and parameters, see UNIX Supplement.
3 For details about mshell “info” commands, see p.227 “info”.
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Understanding the Displayed Information

This section explains how to read status information returned by the network in-
terface board.

Print Job Information

Use the following command to display print job information:
¢ UNIX: Use the “info” command and “rsh®, “rcp”, and “ftp” parameters.
¢ mshell: Use the “info” command.

ltem Description
Rank Print job status.
e Active

Printing or preparing for printing.
e 1st, 2nd, 3rd, 4th,...
Waiting to be transferred to the printer.

Owner Print request user name.
Job Print request number.

Files The name of the document.
Total Size The size of the data. -

"I When number of files are set in the single print job, the foremost file is displayed.
O For details about UNIX commands and parameters, see UNIX Supplement.
O For details about mshell “info” commands, see p.227 “info”.

Print Log Information

This is a record of the most recent 16 jobs printed.

Use the following command to display print log information:

* UNIX: Use the “prnlog” command and “rsh”, “rcp”, and “ftp” parameters.
e telnet : Use the “prnlog” command. See p.230 “prnlog”

ltem Description

ID Print request ID.

User Print request user name.
Page Number of pages printed
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ltem Description

Result Print Request Result
Communication Result
e OK

Print was completed normally. However, the print result may
not be as required due to printer problems.

* NG
Printing was not completed normally.

e Canceled
An “rcp”, “rsh”, or “Ipr’ command print request was canceled,

possibly due to the printing application. Not applicable to the
“ftp” or “rprinter’ command.

Time Time the print requested was received.
Time of print request reception

User ID Printer driver-configured User ID.
Appears when the print request ID is specified.

JobName Name of the document for printing
Appears when the print request ID is specified.

3 For details about UNIX commands and parameters, see UNIX Supplement.

”

3 For details about mshell prnlog commands, see p.230 “prnlog

Configuring the Network Interface Board

Use the following command to display network interface board settings:
¢ telnet : Use the “show” command.

ltem Description

Common
Mode
Protocol Up/Down [up] means “active” and [down] means “inactive”.

AppleTalk
TCP/IP
Netware
SMB
IP over 1394
SCSiI print
PictBridge
Device Up/Down

Centro
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Iltem

Description

Soft

USB
Bluetooth

Ethernet interface
Syslog priority
NVRAM version
Device name
Comment

Location

Contact

switch

Internal version number

Internal version number
Printer name
Comment

Location of the printer in the SNMP and Rendezvous in-
formation

Administrator information for the printer and contact in-
formation in the SNMP information

AppleTalk
Mode
Net
Object
Type
Zone

AppleTalk protocol in selection
Network number

Macintosh printer name

Type of printer

Name of the zone that the printer belongs to

TCP/IP
Mode

ftp

Ipr

rsh
telnet
diprint
web
http
ftpc
snmp
ipp
autonet
rendezvous
ssl

rfu

nbt

[up] means “active” and [down] means “inactive”.
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ltem Description
ssdp
EncapType Frame type
DHCP Dynamic Host Configuration Protocol (on/off)
Host name
Address IP address
Netmask Subnet mask
Broadcast Broadcast address
DNS Domain DNS domain type
Gateway Default gateway address

Access Range [+f]
Time server

Time Zone

Time server polling time
SYSLOG server

Home page URL

Home page link name

Access control range
NTP server address
NTP server time difference

NTP server interval

URL of homepage.
URL of home page

Netware
EncapType
RPRINTER number
Print server name
File server name
Context name
Switch
Mode
NDS/Bindery
Packet negotiation
Login Mode
Print job timeout
Protocol
SAP interval time
NDS Tree Name

Frame type

Remote printer number

Print server name

Name of the connect file server

Context of print server

Active mode

(this value is fixed)
Login mode
Packet timeout

Protocol used

NDS tree name

Transfer Protocol

SMB
Switch
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Workgroup name
Computer name
Comment

Share name[1]

ltem Description
Mode (this value is fixed)
Direct print (this value is fixed)
Notification Notification of print job completion

Name of the workgroup
Name of the computer
Comment

Share name (model of the printer)

Channel range
Channel

Communication mode

Protocol

IEEE 802.11b
Device name Printer name
DHCP DHCP (on/off)
Address IP address
Netmask Subnet mask
Broadcast Broadcast address
DNS Domain DNS domaintype
SSID SSID used

Channels available for use

Channel used

IEEE 802.11b interface transmitting mode

Server Name

Port Number

Authentication
TX Rate IEEE 802.11b interface speed
WEP encryption WEP enabled or disabled
Encryption key WEP key
IP over 1394
Host name
DHCP DHCP (on/off)
Address IP address
Netmask Subnet mask
Broadcast Broadcast address
DNS Domain
SMTP

SCSiI print

260



Monitoring and Configuring the Printer

ltem Description
Bidi. Bidirectional setting (on/off)
Bluetooth

Bluetooth mode

Bluetooth connection mode

UPnP
URL

Dns
Server[X]:
Selected DNS Server

IP address of the DNS server

Selected DNS server

Domain Name

ether Domain name on an Ethernet connection
wlan Domain name on a wireless LAN connection
ip1394

Rendezvous

Computer Name(cname)

Local Hostname(ether)

Local Hostname(ip1394)
Local Hostname(wlan)

Location

Priority (diprint)

Priority (Ipr)

Priority (ipp)

IPTTL

LinkLocal Route for Multi I/F:
Ethernet (ether)

Computer name

Rendezvous name on an Ethernet connection
Rendezvous name on a wireless LAN connection
Rendezvous name on an IP over 1394 connection
Location of the printer

diprint priority number

Ipr priority number

ipp priority number

IP TTL value

[IEEE 802.11b (wlan)] appears when IEEE 802.11b is
selected. [IP over 1394 (ip1394)] appears when
IEEE1394 is selected.

DDNS
ether Dynamic DNS function on an Ethernet connection
(on/off)
wlan Dynamic DNS function on a wireless LAN connection
(on/off)
ip1394 Dynamic DNS function on an IP over 1394 connection
(on/off)
WINS
ether
Primary WINS IP address of the primary WINS server on an Ethernet

connection
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Iltem

Description

Secondary WINS

wlan
Primary WINS
Secondary WINS
ip1394
Primary WINS

Secondary WINS

IP address of the secondary WINS server on an Ether-
net connection

IP address of the primary WINS server on an IP over
1394 connection

IP address of the secondary WINS server on an IP over
1394 connection

SSDP
Ad_Mode
uuiD
Profile
TTL

SNMP
SNMPv1v2
SNMPv3
protocol
viTrap
v2Trap
v3Trap
SNMPv1v2Remoto Setting
SNMPv3 Privacy

AuthFree
AccessRange[X]
Centro
UsB

Shell mode

Mode of the remote maintenance tool
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Message List

This is a list of messages that appear in the printer's system log. The system log

can be viewed using the “syslog” command.

System Log Information

Use the following command to display the system log information:
* UNIX: Use the “syslog” command and “rsh”, “rcp”, and “ftp” parameters.

¢ telnet : Use the “syslog” command.

Message

Problem and solutions

Access to NetWare server <file server name>
denied. Either there is no account for this print
server on the NetWare server or the password
was incorrect.

(In the print server mode) Login to the file serv-
er failed. Make sure that the print server is reg-
istered on the file server. If a password is
specified for the print server, delete it.

add_sess: bad trap addr:<IpAddress>, com-
munity:<community name>

The IP address (0.0.0.0.) is unavailable when
the community access type is TRAP. Specify
the host IP address for the TRAP destination.

add_sess: community<community name> al-
ready defined.

The same community name already exists.
Use another community name.

add_sess_ipx: bad trap addr: <IPXaddress>,
community:<community name>

The IPX address (00:00:00:00:00:00) is un-
available when the community access type is
TRAP. Specify the host IPX address for the
TRAP destination.

add_sess_ipx: community <community name>
already defined.

The same community name already exists.
Use another community name.

Attach FileServer= <file server name>

Connection to the file server as the nearest
server has been established.

Attach to print queue <print queue name>

(In the print server mode) Attached to the print
queue.

Cannot create service connection

(In the remote printer mode) Connection to the
file server has not been established. The num-
ber of file server users may have exceeded the
maximum capacity of the file server.

Cannot find rprinter (<print server
name>/<printer number>)

The printer with the number displayed on the
print server does not exist. Make sure that the
printer number is registered on the print server.

Change IP address from DHCP Server.

The IP address changes when DHCP lease is
renewed. To always assign the same IP ad-
dress, set a static IP address to the DHCP
server.
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Message

Problem and solutions

btd is disabled.

Communication via Bluetooth is unavailable
because btd is disabled in the security mode.

Enable the btd in the security mode.

centrod is disabled.

Communication via parallel connection is un-
available because centrod is disabled in the
security mode.

Enable centrod in the security mode.

child process exec error! (process name)

The network service failed to start. Turn the
printer off and then on. If this does not work,
contact your service or sales representative.

Connected DHCP Server(<DHCP server ad-
dress>).

The IP address was successfully received
from the DHCP server.

connection from <IP address>

Login was from the host IP address.

Could not attach to FileServer<error number>

(In the remote printer mode) Connection to the
file server has not been established. The file
server has refused the connection. Check the
file server configuration.

Could not attach to PServer<print server>

(In the remote printer mode) Connection to the
print server has not been established. The
print server has refused the connection. Check
the print server configuration.

Current Interface Speed:xxxMbps

Speed of the network (10 Mbps or 100 Mbps)

Current IP address <current IP address>

The IP address <current IP address> was re-
ceived from the dhcp server.

Current IPX address<IPX address>

Current ipx address

DHCP lease time expired.

DHCP lease time has expired. The printer tries
to discover the DHCP server again. The IP ad-
dress until now becomes invalid.

DHCP server not found.

The DHCP server was not found. Make sure
that the DHCP is on the network.

dhcpced start.

The DHCPCD service (dhcp client service)
has started.

dpsd is disabled.

PictBridge cannot be used when connected to
the digital camera because Pictbridge is dis-
abled in the security mode.

Enable PictBridge in the security mode.

Duplicate IP=<IP address>(from <MAC ad-
dress>).

The same IP address is used. Each IP address
must be unique. Check the address of the de-
vice indicated in [MAC address].

Established SPX Connection with PServ-
er,(RPSocket=<socket number>, con-
nID=<connection ID>)

(In the remote printer mode) Connection to the
print server has been established.
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Message Problem and solutions

exiting The Ipd service has ended and the system is
exiting the process.

Exit pserver (In the print server mode) The print server

function is disabled because the necessary
print server settings have not been made.

Frametype =<frame type name>

The frame type name is configured to be used
on NetWare.

httpd start.

The httpd service has started.

inetd start.

The inetd service has started.

IPP cancel-job: permission denied.

The printer could not authenticate the name of
the user attempting to cancel a job.

ipp disable.

Printing with ipp is disabled.

ipp enable.

Printing with ipp is enabled.

IPP job canceled. jobid=%d.

The spooled job was canceled due to error or
user request.

LeaseTime=<lease time>(sec), Renew-
Time=<renew time>(sec).

The resource lease time received from the
DHCP server is displayed in [lease time] in
seconds. The renewal time is displayed in [re-
new time] in seconds.

Login to fileserver <file server name>
(<IPXIIP>,<NDSIBINDERY>)

(In the print server mode) Login to the file serv-
eris in the NDS or BINDERY mode.

Memory allocate error.

Data cannot be obtained.

Disconnect the USB cable, and then connect
it.

Name registration success. WINS Serv-
er=<WINS server sddress> NetBIOS
Name=<NetBIOS name>

Name registration of <WINS server sddress>
was successful.

Name registration success in Broadcast
name=<NetBIOS name>

Name registration by Broadcast name of <Net-
BIOS name> was successful.

Name registration failed. name=<NetBIOS
name>

Name registration of <NetBIOS name> failed.
Set unique NetBIOS name.

nbtd start.

The nbtd service has started.

npriter start. (NetWare)

(In the remote printer mode) The NetWare ser-
vice has started.

nwstart start. (NetWare)

The service for NetWare protocol stack setting
has started.

Open log file <file name>

(In the print server mode) The specified log file
has been opened.

papd start. (AppleTalk)

The AppleTalk print service has started.
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Message

Problem and solutions

phy release file open failed.

Replacing the network interface board is re-
quired. Contact your sales or service repre-
sentative.

Print queue <print queue name> cannot be
serviced by printer 0, <print server name>

(In the print server mode) The print queue can-
not be established. Make sure that print queue
exists on the specified file server.

Print server <print server name>has no printer.

(In the print server mode) The printer is not as-
signed to the print server. Using NWadmin, as-
sign the printer, and then restart it.

print sessions full

No more print jobs can be accepted.

Printer <printer name> has no queue

(In the print server mode) The print queue is
not assigned to the printer. Using NWadmin,
assign the print queue to the printer, and then
restart it.

pserver start. (NetWare)

(In the print server mode) The NetWare ser-
vice has started.

Required file server (<file server name>) not
found

The required file server is not found.

restarted.

The Ipd service has started.

sap enable, saptype=<SAP type>, sap-
name=<SAP name>

The SAP function has started. The SAP packet
is issued to advertise the service on the SAP
table on the NetWare server.

session <community name> already defined.

The requested community name is not de-
fined.

session_ipx <community name> not defined.

The requested community name is not de-
fined.

Set context to <NDS context name>

An NDS context name has been set.

shutdown signal received. network service re-
booting...

The network service is rebooting.

smbd started. (NetBIOS)

smbd (Aerver Message Block Daemon) has
started.

SMTPC: failed to get smtp server ip-address.

The SMTP server IP address could not be ob-
tained. This could be because:

¢ The specified DNS server could not be
found.

¢ No connection to the network has been es-
tablished.

e The specified DNS server could not be
found.

e Anincorrect DNS server is specified.

e The specified SMTP server IP address
could not be found in the DNS server.
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Message

Problem and solutions

SMTPC: failed to connect smtp server. time-
out.

Connection to the SMTP server failed due to
timeout. This could be because:

* The specified SMTP server name is incor-
rect.

¢ No connection to the network has been es-
tablished.

e The network configuration is incorrect, so
there is no response from the SMTP serv-
er.

SMTPC: refused connect by smtp server.

Connection to the SMTP server is denied. This
could be because:

¢ A server other than the SMTP server has
been specified.

e The specified SMTP server port number is
incorrect.

SMTPC: no smtp server. connection close.

Connection to the SMTP server failed due to
no response from SMTP. This could be be-
cause:

¢ A server other than the SMTP server has
been specified.

e The specified SMTP server port number is
incorrect.

SMTPC: failed to connect smtp server.

Connection to the SMTP server failed. This
could be because:

¢ No connection to the network has been es-
tablished.

* The network configuration is incorrect, so
there is no response from the SMTP serv-
er.

* The specified SMTP server name is incor-
rect.

e Anincorrect SMTP server is specified.

e The specified SMTP server IP address
could not be found in the DNS server.

¢ A server other than the SMTP server has
been specified.

e The specified SMTP server port number is
incorrect.

SMTPC: username or password wasn’t cor-
rect. [response code] (information)

Connection to the SMTP server failed. This
could be because:

¢ The specified SMTP user name is incor-
rect.

* The specified SMTP password is incorrect.
Check the SMTP user name and password.
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Message

Problem and solutions

Snmp over ip is ready.

Communication over TCP/IP with snmp is
available.

Snmp over IP over 1394 is ready.

Communication over IP over 1394 with snmp
is available.

Snmp over ipx is ready.

Communication over IPX with snmp is avail-
able.

account is unavailable:
Same account name be used.

User account is disabled. This could be be-
cause it use the same account name as the
administrator account.

account is unavailable:
The authentication password is not set up.

User account is disabled. This could be be-
cause the authentication password is not set,
and only the encryption account is set.

account is unavailable:
encryption is impossible.

Encryption is not possible and account is dis-
abled. This could be because:

e Security option is not installed.

e Encryption password has not been speci-
fied.

trap account is unavailable.

v3Trap cannot be sent. This could be because
the Trap destination account is different from
the account specified by the printer.

snmpd start. The snmpd service has started.
started. The direct print service has started.
Started. The rendezvous function is enabled.
Terminated. The rendezvous function is disabled.

The print server received error <error number>
during attempt to log in to the network. Access
to the network was denied. Verify that the print
server name and password are correct.

Login to the file server failed. The print server
is not registered or a password is specified.
Register the print server without specifying a
password.

usbd is disabled.

Plug and Play function and printing is disabled
because usbd is disabled in the security mode.

Enable usbd in the security mode.

WINS wrong scopelD=<scope ID>

The scope ID is incorrect.
Specify the correct scope ID.

WINS name registration: No response to serv-
er(WINS server sddress)

There was no response to the registration re-
quest from the server. Check that the WINS
server address is correct and the WINS server
is working properly.

3 For details about UNIX commands and parameters, see UNIX Supplement.
O For details about “syslog” command, see p.241 “syslog”.
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Preparing Printer Server

This section explains how to configure the printer as a Windows network printer.
The printer is configured to enabling network clients to use it. When the network
printer is connected via SmartDeviceMonitor for Client, you can set the printing
notification function to notify clients of the results of their print jobs.

b d | mportant

3 Under Windows 2000, Windows XP Professional, or Windows Server 2003,
to change printer properties in the [Printer] folder, you need Printer Manage-
ment access authentication; under Windows NT 4.0, Full Control access au-
thentication. Log on to the file server as an Administrator or member of the
PowerUsers group.

ﬂ Open the [Printers] window from the [Start] menu.
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use. On the [File] menu, click
[Properties]. The printer properties appear.

B On the [Sharing] tab, click [Shared as:].

ﬂ To share the printer with users using a different version of Windows,
click [Additional Drivers...].

3 If you have installed an alternative driver by selecting [Shared as:] during the
printer driver installation, this step can be ignored.

B Click [OK]. Close the printer properties.

Printing notification via SmartDeviceMonitor for Client

Follow the procedure below to configure the printer to use the printing notification
function of SmartDeviceMonitor for Client.

Setting the print server

® @ | mportant

3 Under Windows 2000, Windows XP Professional, or Windows Server 2000,
to change printer properties in the [Printer] folder, you need Printer Manage-
ment access authentication; under Windows NT 4.0, Full Control access au-
thentication. Log on to the file server as an Administrator or member of the
PowerUsers group.

I] From the [Start] button on the task bar, point to [Program], point to [Smart-
DeviceMonitor for Client], and then click [Print Server Setting].

G1307502_1.00 Copyright © 2005
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The print server setting dialog box appears.

EI Select the [Notify Client of Printing] check box, and click [OK].

After print server setting is made, a dialog box appears. Confirm the dialog
box content, and click [OK].

Click [Cancel] to interrupt the procedure.

B A dialog box appears for client setting. Click [OK].

The print server setting is complete. Each client must be set to receive print
notification.

3 Current printing jobs restart from the beginning after the spooler pauses
briefly.

O When the expansion function is not used, the function is automatically set
as available.

Setting a Client

I] From the [Start] button on the task bar, point to [Program], point to [Smart-
DeviceMonitor for Client], and then click [Setting Expansion Function].

A dialog box for setting the expansion function appears.
8 Select the [Use the expansion function] check box in [Notify Printing].
B Select the [Notify when using the print server] check box.

A click [ok].

The dialog box for setting the expansion function closes. The client setting is
completed.

O Set the printing notification function on the printer driver as well as on
SmartDeviceMonitor for Client.
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Using NetWare

This section describes the setting procedure for network printers in the NetWare
environment. In the NetWare environment, you can connect the printer as a
“print server” or “remote printer”.

« Setting procedure

* When using the printer as a print server
@ Installing SmartDeviceMonitor for Admin
@ Setting the network interface board.
® Turning the printer off and then back on.

* When using the printer as a remote printer
@ Installing SmartDeviceMonitor for Admin.
@ Setting the network interface board.
® Setting NetWare.
@ Starting the print server.

% Using SmartDeviceMonitor for Admin
To use the printer in a NetWare environment, use SmartDeviceMonitor for Ad-
min to set the NetWare printing environment.

O The NetWare Client provided by Novell is required to set the printing envi-
ronment using SmartDeviceMonitor for Admin under the following environ-
ments:

e NDS mode in Windows 95/98/Me
* NDS or Bindery mode in Windows 2000/XP, Windows NT 4.0

=l Reference

For details about installing SmartDeviceMonitor for Admin, see p.200 “In-
stalling SmartDeviceMonitor for Admin”.

% Printers listed by SmartDeviceMonitor for Admin
SmartDeviceMonitor for Admin lists printers connected to the network. If you
cannot identify the printer you want to configure, print configuration page, and
then check the printer name.

Setting Up as a Print Server (NetWare 3.x)

Follow the procedure below to connect the printer as a print server using Net-
Ware 3.x.

ﬂ Log on to the file server as a supervisor or supervisor equivalent.
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ﬂ Start NIB Setup Tool from the [Start] menu.
8 Click [Wizard], and then click [OK].

ﬂ Select the printer you want to configure, and then click [Finish].

A dialog box prompting you will need to perform the remaining configuration
tasks in the Web browser appears. Click [OK], and then wait until Web Image
Monitor starts automatically.

B The dialog box for entering the user name and password appears.
Enter the user name and password, and then click OK.

O For details about the password, consult your network administrator.

E Click [Configuration] in the left area, click [Network], and then click [NetWare].
The following items are displayed:

Print Server Name: Enter the NetWare print server name. If you want to
use the interface board as a print server, enter the name of a print server
that is not active on the file server. 1 to 47 characters can be used.

Logon Mode: Specify whether you will designate a file server or NDS tree
when logging on to NetWare.

File Server Name: When a file server name is entered here, only the spec-
ified file server is searched for. This item is mandatory. Up to 47 characters
can be used.

NDS Tree: If you want to enable the NDS mode, enter the name of the NDS
tree you want to log on to using up to 32 one-byte alphanumeric characters.

NDS Context Name: If you want to enable the NDS mode, enter the print
server context using up to 127 characters.

Operation mode: Specify whether to use the interface board as a print serv-
er or a remote printer.

Remote printer number: This item is effective when you have specified that
the interface board be used as a remote printer. Enter the same number as
the number of the printer to be created on the print server, using 0 to 254
one-byte characters.

Job Timeout: When the interface board is running as a NetWare remote
printer, the printer cannot judge when a print job ends. Therefore, the print-
er terminates printing when a certain period of time has elapsed since the
last time it has received print data (i.e., when it has not received print data
for a certain period of time). Specify here this period of time (3 to 255 sec-
onds) using one-byte characters. The initial value is 15 (seconds).

Frame Type: Select the frame type to be used from the drop-down menu.

Print Server Protocol: Select the protocol to be used for NetWare from the
drop-down menu.
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* NCP Distribution Protocol: Select the protocol to be used for NCP distribu-
tion.

ﬂ Confirm the settings, and then click [Apply].

Configuration is now complete. Wait for several minutes if you want to restart
Web Image Monitor.

¥ [N
] To check that the configuration is made correctly, enter the following from
the command prompt.

F:> USERLIST

3 If the printer works as configured, the name of the print server appears as
a connected user.

3 If you cannot identify the printer you want to configure, check the printer
name with the configuration page printed from the printer. For details about
printing a configuration page, see p.161 “Printing a Configuration Page”.

3 If no printer names appear in the list, match the frame types of IPX/SPXs
for the computer and printer. Use the [Network] dialog box of Windows to
change the frame type of the computer.

= Reference

For details about changing the printer's frame type (“NW Frame Type”),
see “Configuring the Printer”, Setup Guide.

Setting Up as a Print Server (NetWare 4.x, 5/5.1, 6/6.5)
Follow the procedure below to connect the printer as a print server using Net-
Ware 4.x, NetWare 5/5.1, or NetWare 6.0.

b d | mportant

[ When using the printer as a print server in NetWare 4.x, NetWare 5/5.1, or
NetWare 6.0, set it to the NDS mode.

3 When using NetWare 5/5.1 or NetWare 6.0, set the printer as a print server.
I] Log on to the file server as a supervisor or supervisor equivalent.

B Start NIB Setup Tool on the [Start] menu.

B Click [Wizard], and then click [OK].

ﬂ Select the printer you want to configure, and then click [Finish].
A dialog box prompting you to perform the remaining configuration tasks in the
Web browser appears. Click [OK], and then wait until Web Image Monitor
starts automatically.

B A dialog box for entering the user name and password appears.
Enter the user name and password, and then click OK.
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O For details about passwords, consult your network administrator.

B Click [Configuration] in the left area, click [Network], and then click [NetWare].
The following items are displayed:

Print Server Name: Enter the NetWare print server name. To use the inter-
face board as a print server, enter the name of a print server that is not ac-
tive on the file server. Use up to 47 single byte characters.

Logon Mode: Specify whether to designate a file server or NDS tree when
logging on to NetWare.

File Server Name: When a file server name is entered here, only the spec-
ified file server is searched for. This item is mandatory. Use up to 47 single
byte characters.

NDS Tree: If you want to enable NDS mode, enter the name of the NDS
tree you want to log on to. Use up to 32 single byte alphanumeric charac-
ters.

NDS Context Name: If you want to enable NDS mode, enter the print serv-
er context using up to 127 characters.

Operation mode: Specify whether to use the interface board as a print serv-
er or a remote printer.

Remote printer number: This item is effective when you have specified that
the interface board be used as a remote printer. Enter the same number as
the number of the printer to be created on the print server, using 0 to 254
one-byte characters.

Job Timeout: When the interface board is running as a NetWare remote
printer, the printer cannot judge when a print job ends. Therefore, the print-
er terminates printing when a certain period of time has elapsed since it re-
ceived print data (i.e., when it has not received print data for a certain
period of time). Specify this period of time (3 to 255 seconds) using single
byte characters. The default value is 15 (seconds).

Frame Type: Select the frame type from the drop-down menu.

Print Server Protocol: Select the protocol for NetWare from the drop-down
menu.

NCP Distribution Protocol: Select the protocol for NCP distribution.

ﬂ Confirm the settings, and then click [Apply].

Configuration is now complete. Wait for several minutes if you want to restart
Web Image Monitor.

+ [EE

t] To check that the configuration is made correctly, enter the following from

the command prompt.
F:> NLIST USER /A/B
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3 If the printer works as configured, the name of the print server appears as
a connected user.

3 If you cannot identify the printer you want to configure, check the printer
name with the configuration page printed from the printer. For details about
printing a configuration page, see p.161 “Printing a Configuration Page”.

3 If no printer names appear in the list, match the frame types of IPX/SPXs
for the computer and printer. Use the [Network] dialog box of Windows to
change the frame type of the computer.

=l Reference

For details about changing the printer's frame type (“NW Frame Type”),
see “Configuring the Printer”, Setup Guide.

When using the printer in a pure IP environment of NetWare 5/5.1 or Net-
Ware 6.0/6.5, see p.275 “Using Pure IP in the NetWare 5/5.1 or 6/6.5 En-
vironment”.

Using Pure IP in the NetWare 5/5.1 or 6/6.5 Environment

Follow the procedure below to connect the printer as a print server in a pure IP
environment of NetWare 5/5.1.

b d | mportant

 When creating a queued print server in a pure IP environment of NetWare
5/5.1 or NetWare 6.0, create a print queue on the file server using NetWare
Administrator.

O This printer is not available as a remote printer for use in a pure IP environ-
ment.

3 To use the printer in a pure IP environment, set it to TCP/IP.

Setting up using NIB Setup Tool

ﬂ Log on to the file server as an administrator or administrator equivalent.
ﬂ Start NIB Setup Tool on the [Start] menu.
B Click [Property Sheet], and then click [OK].

ﬂ Select the printer you want to configure, and then click [Finish].

A dialog box prompting you to perform the remaining configuration tasks in the
Web browser appears. Click [OK], and then wait until Web Image Monitor
starts automatically.

B A dialog box for entering the user name and password appears.
Enter the user name and password, and then click OK.
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O For details about the passwords, consult your network administrator.

B Click [Configuration] in the left area, click [Network], and then click [NetWare].
The following items are displayed:

Print Server Name: Enter the NetWare print server name. To use the inter-
face board as a print server, enter the name of a print server that is not ac-
tive on the file server. Use up to 47 single byte characters.

Logon Mode: Specify whether to designate a file server or NDS tree when
logging on to NetWare.

File Server Name: When a file server name is entered here, only the spec-
ified file server is searched for. This item is mandatory. Use up to 47 single
byte characters.

NDS Tree: To enable NDS mode, enter the name of the NDS tree you want
to log on to. Use up to 32 single byte alphanumeric characters.

NDS Context Name: To enable NDS mode, enter the print server context.
Use up to 127 single byte characters.

Operation mode: Specify whether to use the interface board as a print serv-
er or a remote printer.

Remote printer number: This item is effective if you have selected to use
the interface board as a remote printer. Enter the same number as the
number of the printer to be created on the print server. Use 0 to 254 single
byte characters.

Job Timeout: When the interface board is running as a NetWare remote
printer, the printer cannot judge when a print job ends. Therefore, the print-
er terminates printing when a certain period of time has elapsed since it re-
ceived print data (i.e., when it has not received print data for a certain
period of time). Specify this period of time (3 to 255 seconds) single byte
characters. The default value is 15 (seconds).

Frame Type: Select the frame type from the drop-down menu.

Print Server Protocol: Select the protocol for NetWare from the drop-down
menu.

NCP Distribution Protocol: Select the protocol for NCP distribution.

ﬂ Confirm the settings, and then click [Apply].

Configuration is now complete. Wait for several minutes if you want to restart
Web Image Monitor.

Setting up using NWadmin

I] From Windows, start NWadmin.
For details about NWadmin, see the NetWare manuals.
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ﬂ Select the object in which the print queue is located in the directory tree,
and then click [Create] on the [Object] menu.

B In the [Class of new object] box, click [Print Queue], and then click [OK].
ﬂ In the [Print Queue Name] box, enter the name of the print queue.
B In the [Print Queue Volume] box, click [Browse].

B In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

ﬂ Check the settings, and then click [Create].

8 Select the object in which the printer is located, and then click [Create]
on the [Object] menu.

g In the [Class of new object] box, click [Printer], and then click [OK]. For Net-
Ware 5, click [Printer (Non NDPS)].

[[D In the [Printer name] box, enter the printer name

[I] Select the [Define additional properties] check box, and then click [Create].
[B Click [Assignments], and then click [Add] in the [Assignments] area.

[B In the [Available objects] box, click the queue you, and then click [OK].

[I] Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

iE Click [Manual load] in the [Communication type] area, and then click [OK].
[E Check the settings, and then click [OK].

[ﬂ Select a context specified using NIB Setup Tool, and then click [Create]
on the [Object] menu.

[B In the [Class of new object] box, click [Print Server], and then click [OK]. For
NetWare 5, click [Print Sever (Non NDPS)].

[E] In the [Print Server Name] box, enter the print server name.
Use the same print server name specified using NIB Setup Tool.

EE Select the [Define additional properties] check box, and then click [Create].
Ei] Click [Assignments], and then click [Add] in the [Assignments] area.

EB In the [Available objects] box, click the queue you created, and then click
[OK].

EB Check the settings, and then click [OK].
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EZ] Start the print server by entering the following from the console of the
NetWare server.

If the print server is in operation, quit and restart it.

< To exit

CAREE: unload pserver

« To start

CAREE: load pserver print server name

Setting Up as a Remote Printer (NetWare 3.x)

Follow the procedure below to use the printer as a remote printer under NetWare
3.X.

Setting up using NIB Setup Tool

[I Log on to the file server as a supervisor or supervisor equivalent.
g Start NIB Setup Tool from [Start] menu.
B Click [Property Sheet], and then click [OK].

ﬂ Select the printer you want to configure, and then click [Finish].

A dialog box prompting you to perform the remaining configuration tasks in the
Web browser appears. Click [OK], and then wait until Web Image Monitor
starts automatically.

B A dialog box for entering the user name and password appears.
Enter the user name and password, and then click OK.

O For details about passwords, consult your network administrator.

B Click [Configuration] in the left area, click [Network], and then click [NetWare].
The following items are displayed:

* Print Server Name: Enter the NetWare print server name. To use the inter-
face board as a print server, enter the name of a print server that is not ac-
tive on the file server. Use up to 47 single byte characters.

* Logon Mode: Specify whether to designate a file server or NDS tree when
logging on to NetWare.

* File Server Name: When a file server name is entered here, only the spec-
ified file server is searched for. This item is mandatory. Use up to 47 single
byte characters.
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e NDS Tree: To enable the NDS mode, enter the name of the NDS tree you
want to log on to. Use up to 32 single byte alphanumeric characters.

e NDS Context Name: To enable the NDS mode, enter the print server con-
text. Use up to 127 single byte characters.

* Operation mode: Specify whether to use the interface board as a print serv-
er or a remote printer.

* Remote printer number: This item is effective if you have selected to use
the interface board as a remote printer. Enter the same number as the
number of the printer to be created on the print server. Use 0 to 254 single
byte characters.

e Job Timeout: When the interface board is running as a NetWare remote
printer, the printer cannot judge when a print job ends. Therefore, the print-
er terminates printing when a certain period of time has elapsed since it re-
ceived print data (i.e., when it has not received print data for a certain
period of time). Specify this period of time (3 to 255 seconds). Use single
byte characters. The default value is 15 (seconds).

* Frame Type: Select the frame type from the drop-down menu.

* Print Server Protocol: Select the protocol for NetWare from the drop-down
menu.

* NCP Distribution Protocol: Select the protocol for NCP distribution.

ﬂ Confirm the settings, and then click [Apply].

Configuration is now complete. Wait for several minutes if you want to restart
Web Image Monitor.

Setting up using PCONSOLE

I] Enter “PCONSOLE” from the command prompt.
F:> PCONSOLE

ﬂ Create a print queue.
When using the existing print queue, go to the procedure for creating a printer.

8 From the [Available Options] menu, select [Print Queue Information], and then
press the [Enter] key.

ﬂ Press [Insert] key, and then enter a print queue name.
B Press [Esc] key to return to the [Available Options] menu.
B Set up the network connection to a printer.

ﬂOn the [Available Options] menu, click [Print Server Information], and then
press the [Enter] key.
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8 To create a new print server, press the [Insert] key, and then enter a print
server name.

For a currently defined print server, select a print server in the [Print Server] list.
Use the same printer name specified using NIB Setup Tool.

ﬂ From the [Print Server Information] menu, select [Print Server Configuration].
[[D From the [Print Server Configuration] menu, select [Printer Configuration].

[i] Select the printer indicated as [Not Installed].

Use the same printer number specified as the remote printer number using
NIB Setup Tool.

[E] To change the printer name, enter a new name.

A name “Printer x” is assigned to the printer. The “x” stands for the number of
the selected printer.

[B As type, select [Remote Parallel, LPT1].

The IRQ, Buffer size, Starting form, and Queue service mode are automati-
cally configured.

[I] Press the [Esc] key, and then click [Yes] on the confirmation message.
iE Press the [Esc] key to return to [Print Server Configuration Menu].

[E Assign print queues to the created printer.

[ﬂ From [Print Server Configuration Menu], select [Queues Serviced By Printer].

[EJ Select the printer created.

[D Press the [Insert] key to select a queue serviced by the printer.
You can select several queues.

EID Follow the instructions on the screen to make other necessary settings.
Following these steps, check that the queues are assigned.

E{l Press the [Esc] key until “Exit?” appears, and then select [Yes] to exit
PCONSOLE.

EB Start the print server by entering the following from the console of the
NetWare server.

If the print server is in operation, quit and restart it.

% To quit

CAREE: unload pserver
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% To start
CAREE: load pserver print_server_name

3 If the printer works as configured, the message “Waiting for job” appears.

Setting Up as a Remote Printer (NetWare 4.x, 5/5.1, 6/6.5)

Follow the procedure below to use the printer as a remote printer under NetWare
4.x, 5/5.1 and 6.
b d | mportant

3 To use the printer as a remote printer under NetWare 4.x/5/5.1, set it to NDS
mode.

O Do not use the printer as a remote printer when Pure IP is used.

Setting up using NIB Setup Tool

ﬂ Log on to the file server as an administrator or administrator equivalent.
ﬂ StartNIB Setup Tool from [Start] menu.
B Click [Property Sheet], and then click [OK].

ﬂ Select the printer you want to configure, and then click [Finish].

A dialog box prompting you to perform the remaining configuration tasks in the
Web browser appears. Click [OK], and then wait until Web Image Monitor
starts automatically.

B A dialog box for entering the user name and password appears.
Enter the user name and password, and then click OK.

O For details about passwords, consult your network administrator.

E Click [Configuration] in the left area, click [Network], and then click [NetWare].
The following items are displayed:

e Print Server Name: Enter the NetWare print server name. To use the inter-
face board as a print server, enter the name of a print server that is not ac-
tive on the file server. Use up to 47 single byte characters.

* Logon Mode: Specify whether to designate a file server or NDS tree when
logging on to NetWare.

* File Server Name: When a file server name is entered here, only the spec-
ified file server is searched for. This item is mandatory. Use up to 47 single
byte characters.
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* NDS Tree: To enable NDS mode, enter the name of the NDS tree you want
to log on to. Use up to 32 single byte alphanumeric characters.

* NDS Context Name: To enable NDS mode, enter the print server context.
Use up to 127 single byte characters.

* Operation mode: Specify whether to use the interface board as a print serv-
er or a remote printer.

* Remote printer number: This item is effective if you have selected to use
the interface board be used as a remote printer. Enter the same number as
the number of the printer to be created on the print server. Use 0 to 254
single byte characters.

e Job Timeout: When the interface board is running as a NetWare remote
printer, the printer cannot judge when a print job ends. Therefore, the print-
er terminates printing when a certain period of time has elapsed since it re-
ceived print data (i.e., when it has not received print data for a certain
period of time). Specify this period of time (3 to 255 seconds). Use single
byte characters. The default value is 15 (seconds).

* Frame Type: Select the frame type from the drop-down menu.

* Print Server Protocol: Select the protocol for NetWare from the drop-down
menu.

* NCP Distribution Protocol: Select the protocol for NCP distribution.

ﬂ Confirm the settings, and then click [Apply].

Configuration is now complete. Wait for several minutes if you want to restart
Web Image Monitor.

Setting up using NWadmin

I] From Windows, start NWadmin.
For details about NWadmin, see the NetWare manuals.

ﬂ Set up the network connection to a print queue. Select the object in
which the print queue is located in the directory tree, and then click [Cre-
ate] on the [Object] menu.

B In the [Class of new object] box, click [Print Queue], and then click [OK].
ﬂ In the [Print Queue Name] box, enter the name of the print queue.
B In the [Print Queue Volume] box, click [Browse].

B In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

ﬂ Check the settings, and then click [Create].
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8 Set up the network connection to a printer. Select the object in which the
printer is located, and then click [Create] on the [Object] menu.

ﬂ In the [Class of new object] box, click [Printer], and then click [OK]. For Net-
Ware 5, click [Printer (Non NDPS)].

[E] In the [Printer name] box, enter the printer name
[I] Select the [Define additional properties] check box, and then click [Create].

[EJ Assign print queues to the created printer. Click [Assignments], and then
click [Add] in the [Assignments] area.

[B In the [Available objects] box, click the queue you created, and then click
[OK].

[I] Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

iE Click [Manual load] in the [Communication type] area, and then click [OK].
Check the settings, and then click [OK].

[E Set up the network connection to a print server. Select a context speci-
fied using NIB Setup Tool, and then click [Create] on the [Object] menu.

[ﬂ In the [Class of new object] box, click [Print Server], and then click [OK]. For
NetWare 5, click [Print Sever (Non NDPS)].

iE In the [Print Server Name] box, enter the print server name.
Use the same print server name specified using NIB Setup Tool.

[E] Select the [Define additional properties] check box, and then click [Create].

Eﬁ] Assign the printer to the created print server. Click [Assignments], and
then click [Add] in the [Assignments] area.

Ei] In the [Available objects] box, click the queue you created, and then click
[OK].

EE In the [Printers] area, click the printer you assigned, and then click [Printer
Number]

EB Enter the printer number, and then click [OK]. Check the settings, and
then click [OK].

Use the same printer number specified as the remote printer number using
NIB Setup Tool.

EZ] Start the print server by entering the following from the console of the
NetWare server.

If the print server is in operation, quit and restart it.
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% To exit
CAREE: unload pserver

% To start

CAREE: load pserver print server name
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Printing Files Directly from Windows

You can print files directly using Windows commands. For example, you can
print PostScript files for PostScript 3.

“ Windows 95/98/Me
You can print files directly using “ftp” command.

«» Windows 2000/XP, Windows Server 2003, Windows NT 4.0

You can print files directly using “lpr”, “rcp” or “ftp” command.

Setup
Follow the procedure below to make network environment settings.

ﬂ Enable TCP/IP with the control panel, and then set up the printer’s net-
work environment about TCP/IP including IP addresses.

TCP/IP of the printer is set as default.

ﬂ Install a TCP/IP in Windows to set up the network environment.
Consult the network administrator for the local setting information.

8 To print under Windows 2000/XP, Windows Server 2003, or Windows NT
4.0, install “Printing service for UNIX” as the network application. To
print under Windows NT 4.0, install “Microsoft TCP/IP printing” as the
network application.

=l Feference
For details about setting up IP address, see Setup Guide.

For details about setting the IP address of the printer using DHCP, see
p.319 “Using DHCP”.

This completes the setup for specifying a printer using an IP address when
printing. When using a host name to specify a printer, proceed to p.285
“Using a Host Name Instead of an |IP Address” and continue the setup.

Using a Host Name Instead of an IP Address

When a host name is defined, you can specify a printer by host name instead of
IP address. The host names vary depending on the network environment.

When using DNS

Use the host name set to the data file on the DNS server.
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When setting the IP address of a printer using DHCP

Use the printer name on the configuration page as the host name.

=l Feference
For details about printing a configuration page, see p.161 “Printing a Config-
uration Page”.

In other cases

Add the IP address and host name of the network printer to the hosts file on the
computer used for printing. Methods of addition vary depending on operating
systems.

Windows 95/98/Me

nCopy \WINDOWS\HOSTS.SAM to the same directory and name it
“HOSTS” with no extension.

8 Open the “\WINDOWS\HOSTS” file created using memo pad files, for in-
stance.

B Add an IP address and host name to the hosts file using the following
format:

192.168.15.16 host # NP

”192.168.15.16” is the IP address, “host” is the printer's host name, and “#NP”
is replaced by comments. Insert a space or tab between “192.168.15.16” and
“host”, between “host” and “#NP” respectively, using one line for this format.

ﬂ Save the file.

Windows 2000/XP, Windows Server 2003, Windows NT 4.0

ﬂ Open the hosts file using memo pad files, for instance.
The hosts file is in the following folder:
\WINNT\SYSTEM32\DRIVERS\ETC\HOSTS

\WINNT” is the directory of the installation destination for Windows 2000/XP,
Windows Server 2003, and Windows NT 4.0.

EI Add an IP address and host name to the hosts file using the following
format:

192.168.15.16 host # NP

”192.168.15.16” is the IP address, “host” is the printer's host name, and “4NP”
is replaced by comments. Insert a space or tab between “192.168.15.16” and
“host”, between “host” and “#NP” respectively, using one line for this format.
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B Save the file.

Printing Commands

) 13

The following explains printing operations using the “Ipr”, “rcp”, and “ftp” com-
mands.

Enter commands using the command prompt window. The location of the com-
mand prompts varies depending on operating systems:

¢ Windows 95/98
[Start] - [Programs] - [MS-DOS Prompt]

¢ Windows Me
[Start] - [Programs] - [Accessories] - [MS-DOS Prompt]

¢ Windows 2000
[Start] - [Programs] - [Accessories] - [Command Prompt]

¢ Windows XP, Windows Server 2003
[Start] - [All Programs] - [Accessories] - [Command Prompt]

¢ Windows NT 4.0
[Start] - [Programs] - [Command Prompt]

O Match the data format of the file to be printed with the emulation mode of the
printer.

3 If the message “print requests full” appears, no print jobs can be accepted. Try
again when sessions end. For each command, the amount of possible ses-
sions is indicated as follows:

* |pr: 5(When the spool printing function is available: 10)
* rcp, rsh: 5
* ftp: 3

O Enter the file name in a format including the path from the directory executing
commands.

=l Reference

The “option” specified in a command is an intrinsic printer option and its syn-
tax is similar to printing from UNIX. For details, see UNIX Supplement.

Ipr

% When specifying a printer by IP address

c:> lpr -Sprinter's IP address [-Poption] [-0l] \pass
name\file name
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 When using a host name instead of an IP address

c:> lpr -Sprinter's host name [-Poption] [-0l] \pass
name\file name

When printing a binary file, add the “-ol” option (lowercase O, and lowercase
L).

When using a printer with the host name “host” to print a PostScript file named
“file 1” located in the “C:\PRINT” directory, the command line is as follows:

c:> lpr -Shost -Pfiletype=RPS -0l C:\PRINT\filel
rcp

First, register the printer's host name in the hosts file.

c:> rcp [-b] \pass name\file name [pass name\file name...]
printer's host name: [option]

3 In file names, “*” and “?” can be used as wild cards.
3 When printing a binary file, add the “-b” option.

When using a printer with the host name “host” to print a PostScript file named
“file 1” or “file 2” located in the “C:\PRINT” directory, the command line is as fol-
lows:

c:> rcp -b C:\PRINT\filel C:\PRINT\file2 host:filetype=RPS
=l Feference
For details about registering the printer's host name in the hosts file, see
p.285 “Using a Host Name Instead of an IP Address”.

ftp

Use the “put” or “mput” command according to the number of files to be printed.

% When one file is printed

ftp> put \pass name\file name [option]

« When multiple files are printed

ftp> mput \pass name\file name [\pass name\file name...]
[option]

Follow the procedure below to print using the “ftp” command.
[I Formulate the printer's IP address or the host name of the hosts file
printer as an argument and use the “ftp” command.

% ftp printer's IP address

8 Enter the user name and password, and then press the [# Enter] key.
There is no default user name while “password” is the default password.
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User:
Password:

B When printing a binary file, set the file mode to binary.
ftp> bin
When printing a binary file in ASCIlI mode, print may not come out correctly.

ﬂ Specify files to be printed.

The following shows the examples of printing a PostScript file named “file 1”
in the “C:\PRINT” directory and printing file 1 and file 2.

ftp> put C:\PRINT\filel filetype=RPS
ftp> mput C:\PRINT\filel C:\PRINT\file2

B Quit ftp.
ftp> bye

O “=" %7, “ 7, and “”cannot be used for filenames. File names will be read as
option strings.

3 For “mput” command, option can not be defined.

O For “mput” command, “*” and “?” can be used as wild cards in file names.

3 When printing a binary file in ASCII mode, print may not come out correctly.
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Mac OS

This section explains how to configure a Mac OS to use EtherTalk and USB.
The following explains how to configure Mac OS 9.1. If you are not using Mac
OS 9.1, see the manual of the Mac OS you are using for details

S @ | mportant

3 For Mac OS 8.6 and higher. (Mac OS X Classic environment is supported.)

O The PostScript 3 printer driver is stored in the following folder on the CD-
ROM.

Mac OS 8 and 9:PS Driver: (language) :Diskl

Installing the PostScript 3 Printer Driver and PPD File

It is necessary to install a printer driver and PPD files to print from a Mac OS.

Follow the procedure below to install a printer driver and a PPD file into a Mac
OS using Mac OS 8.6 and higher.

PostScript 3 Printer Driver

f insert the CD-ROM into the CD-ROM drive.

ﬂ Double-click the CD-ROM drive icon.

B Double-click the [Mac OS 8 and 9] folder.

ﬂ Double-click the [PS Driver] folder.

B Double-click the folder of the language you use.

E Open [DISK1], and then double-click the installer icon.

ﬂ Follow the instructions on the screen.

PPD Files

I] Double-click the CD-ROM drive icon.
B Double-click the [Mac OS 8 and 9] folder.
B Double-click the [Printer Descriptions] folder.

ﬂ Double-click the folder of the language you use.
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B open the [pisk1] folder.

B Drag the PPD file and the plugin file into [Printer Descriptions] in [Extensions]
under [System Folder].

ﬂ Restart the Mac OS.

Setting Up PPD Files

b d | mportant

O Make sure that the printers are connected to an AppleTalk network before
performing the following procedure.

[I On the [Apple] menu, click [Chooser].
g Click the Adobe PS icon.

B In the [Select a PostScript Printer:] list, click the name of the printer you want
to use.

ﬂ Click [Create].

B Click the printer you want to use, and then click [Select].

A PPD file is set up and the Adobe PS icon appears at the left of the printer
name in the list. Follow the procedure on p.292 “Setting Up Options” to make
option settings; otherwise close the [Chooser] dialog box.

Creating a Desktop Printer Icon

S @ | mportant
O Make sure that printers are connected to the USB before performing the fol-
lowing procedure.

To use a printer connected by USB, create a desktop printer icon.
ﬂ Double-click [Desktop Printer Utility] in the [AdobePS Components] folder.

ﬂ Click [AdobePS] in [With:], click [Printer (USB)] in [Create Desktop], and then
click [OK].

B Click [Change] in [USB Printer Selection].

ﬂ Select the model you are using in [Select a USB Printer:], and then click [OK].
B click [Auto Setup] in [PostScript™ Printer Description (PPD) File].

B Click [Create].

ﬂ Enter the printer name, and then click [Save].
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The printer icon appears on the desktop.

8 Quit Desktop Printer Utility.

Setting Up Options

I] On the [Apple] menu, click [Chooser].
B click the Adobe PS icon.

8 In the [Select the PostScript Printer:] list, click the name of the printer you
want to use, and then click [Setup].

ﬂ Click [Configure].
A list of options appears.

B Select the option you want to set up, and then select an appropriate set-
ting for it.

3 ciick (k1.
The list of options closes.

U click [ox;.
The [Chooser] dialog box appears.

8 Close the [Chooser] dialog box.

3 If the option you want to select is not displayed, PPD files may not be set
up correctly. To complete the setup, check the name of the PPD file dis-
played in the dialog box.

Installing the ColorSync Profiles

ColorSync profiles enable a printer to print colors consistent with those on the
computer display. You must install the ColorSync profile to use this function.

Follow the procedure below to install the ColorSync profiles.
I] Start a Mac OS.
8 Double-click the hard disk icon, and then open the appropriate folder for

installing the ColorSync profiles.

The location of the appropriate folder may vary depending on the version of
the Mac OS. The following are examples:

e System: Preferences: ColorSync profiles
e System: ColorSync profiles
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E) insert the CD-ROM into the CD-ROM drive.
The CD-ROM drive icon appears.

O bouble-click the CD-ROM drive icon.
The contents of the CD-ROM appear.

B Double-click the [Mac OS 8 and 9] folder.
(3 pbouble-click the [ColorSync™ Profiles] folder.

ﬂ Drag the file to the [ColorSync™ Profiles] folder on the hard disk.
The ColorSync profiles are installed.

3 The ColorSync profiles are consistent with color characteristics defined by
the International Color Consortium (ICC).

O For some computer displays, particular settings need to be created by Col-
orSync. For details, see the appropriate manuals for your computer dis-

play.

Installing Adobe Type Manager

b d | mportant

3 Quit all applications currently running before installation. Install ATM after you
restart the computer.

ﬂ Start a Mac OS.

B insert the CD-ROM into the CD-ROM drive.
B Double-click the CD-ROM drive con.

ﬂ Double-click the [Mac OS 8 and 9] folder.

B Double-click the [ATM] folder.

E Double-click the ATM 4.6.3 installer icon.
ﬂ Follow the instructions on the screen.

8 When the procedure is complete, restart the computer. ATM will be com-
pletely installed only after restarting.

g On the [Apple] menu, open [Control Panel], and then click [~ATM].

[[D The ATM control panel opens.
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O For details about installation, see the operating instructions in the ATM
folder.

Installing Screen fonts

Follow the procedure below to install screen fonts.

The screen fonts described below can be found in the [Fonts] folder on the CD-
ROM.

I] Start a Mac OS.

B insert the CD-ROM into the CD-ROM drive.
The CD-ROM drive icon appears.

B Double-click the CD-ROM drive icon.
The contents of the CD-ROM appear.

ﬂ Double-click the [Mac OS 8 and 9] folder.
B Double-click the [Fonts] folder.
B Double-click the [Screen font] folder.

ﬂ Double-click the [TrueType] or [Type1] folder.
Select the font type you want to use.

B Copy the fonts you want to install in [Fonts] under [System Folder].
A confirmation message appears.

B click [ox;.
The fonts are installed.

[[D Restart the Mac OS.

Changing to EtherTalk

Follow the procedure below to configure to a Mac OS to use EtherTalk.

I] Open [Control Panel], and then double-click the AppleTalk icon.

8 On the [Connect via:] pop-up menu, click [Ethernet].

B If you change zones, select a name on the [Current zone:] pop-up menu.

ﬂ Close the AppleTalk control panel.
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B Restart the computer.

3 The procedures used to configure Mac OS may vary depending on the Mac
OS version. The following describes how to configure Mac OS 9.1. If you
are using a different version of Mac OS, use the following procedures as a
reference and see the manuals for your Mac OS version.

3 Confirm the Connection to the Printer with TCP/IP

=l Feference

For information about installing applications required for EtherTalk, see the
Mac OS manuals.
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Mac OS X

This section explains how to configure a Mac OS X to use EtherTalk and USB.

Follow the procedure below to configure Mac OS X 10.1. If you are not using Mac
OS X 10.1, see the manual of the Mac OS X you are using for details.

S @ | mportant
3 For Mac OS X 10.1 or higher.

O The PPD files are stored in the following folder on the CD-ROM.

Mac OS X:PPD Installer

Installing the PPD Files

Follow the procedure below to install a PPD file to print from Mac OS X.

b d | mportant

3 You need an administrator name and a password (phrase). For details, con-
sult your network administrator.

) insert the CD-ROM into the CD-ROM drive.
H bouble-click the CD-ROM drive icon.

E] Double-click the [Mac 0 X] folder.

ﬂ Double-click the installer icon.

B Follow the instructions on the screen.

Setting Up the PPD File

ﬂ Start Print Center.

EI Click [Add Printer].
Click [AppleTalk] on the first pop-up menu.
If the zone is set, select the zone from the second pop-up menu.

B Select the PPD file for the model you are using from the [Printer Model:]
pop-up menu, and then click [Add].
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Setting Up Options

® @ | mportant
[ No printer option settings can be made under Mac OS X. No new settings for
options not installed can be made.

Using USB Interface

Follow the procedure below to setup USB connection.
ﬂ Start [Print Setup Utility].

H click [Add].

8 Click [USB] on the pop-up menu.
The connected printer appears.

ﬂ Select the printer, and then select its manufacturer from the [Printer Mod-
el:] pop-up menu.
A list of printer types appears.

B Select the name of the connected printer from the list of printer models,
and then click [Add].

B Close the [Printer List] dialog box, and then quit [Print Setup Utility].

3 When printing via USB using a Macintosh computer, the printer language
does not change automatically. Use the control panel on this printer to
change the printer language to [Auto Detect] or [PS] before printing.

O USB2.0 can be used only with Mac OS X 10.3.3 or higher.

Using Rendezvous

Follow the procedure below to print using Rendezvous under Mac OS X 10.2.3
or higher. Ethernet and wireless LAN connections can also be used.

ﬂ Start Print Center.
H click [Add].

B Click [Rendezvous] on the pop-up menu.
The connected printer appears.

ﬂ Select the printer, and then select its manufacturer from the [Printer Mod-
el:] pop-up menu.
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A list of printer types appears.

B Select the name of the connected printer from the list of printer models,
and then click [Add].

B Close the [Printer List] dialog box, and then quit Print Center.

O When printing with a Rendezvous connection to a Macintosh computer,
printer language does not change automatically. Use the control panel on
this printer to change printer language to [Auto Detect] or [PS] before print-

ing.

Changing to EtherTalk

® @ | mportant
O You need an administrator name and a password (phrase). For details, con-
sult your network administrator

Follow the procedure below to configure a Mac OS X to use EtherTalk.

=l Reference

For information about installing applications required for EtherTalk, see the
Mac OS manuals.

I] Open [System Preference], and then click the Network icon.
] Click the [AppleTalk] tab.
B Select the [Make AppleTalk Active] check box.

ﬂ To change AppleTalk zones, select a name from the [AppleTalk Zone:] pop-
up menu.

B When the settings are made, click [Apple Now].
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Configuring the Printer

Use the control panel to enable AppleTalk. (The default is active.)
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Using PostScript 3

Job Type

You can select the type of print job.

v d |mportant
3 If you use Mac OS X, this function is not available.

% Normal
Select this for normal printing. The print job starts immediately after the print
command is given.

« Sample Print
Use this function to print the first set of a multiple-set print job. After checking
the results, the remaining sets can be printed using the control panel. This
function can protect you from printing a large quantity of misprints.

% Locked Print
Use this function to print confidential documents. Documents will not be print-
ed automatically unless a password is entered using the control panel.

Using Sample Print

y o |mportant
O To use this function, the hard disk must be installed on the printer.

O The number of pages the printer can save varies depending on the contents
of the print images. At most, the printer can save 30 jobs or 1,000 pages for
Sample Print and Locked Print.

3 If you turn off the power, the job saved on the hard disk will be deleted.

O Sample Print files will not appear on the display panel if they have already
been executed or deleted using the Web browser before you select “Sample
Print“ from the control panel.

O Sample Print files printed or deleted using Web Image Monitor after you select
[Sample Print] using the control panel will appear on the display panel. Howev-
er, an error message will appear if you try to print or delete those Sample Print
files.

3 If you use Mac OS X, Sample Print function cannot be used.

O If the application has a collate option, make sure that it is not selected before
sending a print job. By default, sample print jobs are automatically collated by
the printer driver. If the collate option is selected in the application print dialog
box, more prints than intended may be printed.

l] In an application, select the menu command to print.
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The print dialog box appears.
ﬂ On the pop-up menu, click [Job Log].
B In [Job Type:], click [Sample Print], and then select the appropriate setting.

ﬂ In [User ID:], enter the user ID using up to eight alphanumeric (a-z, A-Z, 0-
9) characters.

Set this to identify the user associated with the job.
The user ID can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters.

B After making the necessary settings you want, click [Print].
The Sample Print job is sent to the printer and one set is printed.

E Check the sample print to confirm that the settings are correct.
If the settings are correct, print the remaining sets.
If not, you can delete the saved job.
=l Feference

For details about printing the remaining sets, see p.108 “Printing the Re-
maining Sets”.

For details about deleting a Sample Print file, see p.109 “Deleting a Sample
Print File”.

Using Locked Print

b d | mportant
3 To use this function, the hard disk must be installed on the printer.

O The number of pages the printer can save varies depending on the contents
of the print images. At most, the printer can save 30 jobs or 1,000 pages for
Sample Print and Locked Print.

3 If you turn off the power, the job saved on the hard disk will be deleted.

O Locked Print files will not appear on the display panel if they have already
been printed or deleted using Web Image Monitor before you select [Locked
Print] using the control panel.

O Locked Print files printed or deleted using Web Image Monitor after you have
selected [Locked Print] using the control panel will still appear on the display
panel. However, an error message will appear if you try to print or delete those
Locked Print files.

O If you use Mac OS X, Locked Print function cannot be used.

3 If the application has a collate option, make sure that it is not selected before
sending a print job. By default, locked print jobs are automatically collated by
the printer driver. If the collate option is selected in the application print dialog
box, more prints than intended may be printed.
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3 Print jobs are not saved on the hard disk in the following cases. You can check
the error log for jobs not saved.

* When there are 30 Sample Print and Locked Print jobs saved on the hard
disk.

* When the total number of pages saved on the hard disk exceeds 1,000
pages.
ﬂ In an application, select the menu command to print.
The print dialog box appears.

ﬂ On the pop-up menu, click [Job Log].
B In [Job Type:], click [Locked Print], and then select the appropriate setting.
ﬂ In [User ID:], enter the user ID using up to eight alphanumeric (a-z, A-Z, 0-

9) characters, and then enter a 4-digit password in [Password:].
Set this to identify the user associated with the job.

B After making the necessary settings you want, click [Print].
The Locked Print job is sent to the printer.
E Enter the password using the control panel, and then specify whether to
print or delete the job.
=l Feference
For details about entering the password, see p.113 “Entering a Password”.
For details about deleting the job, see p.114 “Deleting a Locked Print File”.

Duplex Printing

Use this function to select duplex printing.

S @ | mportant

3 To use this function, the optional duplex unit must be installed on the printer.
3 You cannot perform duplex printing when using the bypass tray.

+« None
Disables duplex printing.

+ Flip on Long Edge
Prints so you can open it to the long edge when bound along the long edge.

+ Flip on Short Edge
Prints so you can open it to the short edge when bound along the short edge.
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3 Availability of these items varies depending on the operating system you are
using. Click the button that means [Flip on Long Edge] or [Flip on Short Edge].

Color Mode

Use this function to select whether the document is printed in color or black and
white.

< Color
Prints color documents in full color.

3 Color images are printed using CMYK toner, Cyan, Magenta, Yellow, and
Black. CMYK represents the three primary subtractive colors.

3 If you want to adjust the print color, use the settings in the Advanced dialog
box accessed from the Advanced button on the [Print Quality] tab.

+ Black and White
Prints everything, including color documents, in black and white. Black and
White printing is faster than Color. To stop black and white areas being printed
with CMYK toner, select [Black and White] in the printer driver as well as in the
application.

Gradation
Use this function to select a type of gradation suited to your requirements.

+ Fast
Prints quickly but loses smoothness.

« Standard
Prints with good gradation.

Color Profile
Use this function to select the color profile pattern.

% Auto
Use this setting to automatically configure the best color profile pattern based
on the appearance of the document to be printed.

% Photographic
Use this setting to enhance reproduction of photos and graphics that include
midtones.
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% Presentation
Use this setting to enhance reproduction of documents containing text and
graphics. This CRD is best for printing colored charts, graphs, presentation
materials and so on. If you use this CRD for printing photographs, color and
gradation might not reproduce so well.

% Solid Color
Use this setting to print specific single colors, logos and so on.

« User Setting
Use this setting to print images using a CRD downloaded from your applica-
tion.

% CLP Simulation
Prints the output colors similar to the colors displayed on the computer
screen.

3 Use this function to select a color rendering dictionary (CRD). The CRD is re-
ferred to color matching, so you should select the appropriate CRD for the
document you are printing. The selected CRD is also referred to when [Fine]
or [Super Fine] is selected for “ Color Setting ”. The following items are avail-
able: [Auto], [Photographic], [Presentation], and [Solid Color].

Color Setting

Use this function to select the correction method used for color conversion.

b d | mportant
O The color rendering dictionary selected in the Color Profile setting is used.

“ Off
No modification to the color setting.

% Fine
Select this setting to perform color matching based on the printer's built-in col-
or rendering dictionaries, and to perform CMYK conversion. This setting per-
forms printing at an output target of Monitor y= 1.8.

% Super Fine
Select this setting to use a color rendering dictionary similar to the Fine setting
but is capable of producing output that is more vivid. Use this setting to em-
phasize lighter colors. This setting performs printing at an output target of
Monitor y = 2.2.

304



Mac OS Configuration

O Use this function to select a color rendering dictionary (CRD). The CRD is re-
ferred to color matching, so you should select the appropriate CRD for the
document you are printing. The selected CRD is also referred to when [Fine]
or [Super Fine] is selected for “Color Setting”. The following items are available:
[Auto], [Photographic], [Presentation], and [Solid Color].

CMYK Simulation Profile

You can simulate the color tone of the printing ink.

You can select the printing ink standard from US OffsetPrint, Euroscale, Japan-
Color and PaletteColor.

Dithering
Use this function to set the Image Rendering mode.

% Photographic
Performs dithering in an appropriate form for photographs.

% Text
Performs dithering in an appropriate form for text.

Gray Reproduction
Use this function to select Black Color mode for text and line art.

« Black by K
Select this setting to use a black toner.

% Black/Gray by K
Black portions are printed in gray.

% CMY+K
Select this setting to use all toners.

Color Matching

Use this function to select whether or not you want the colors in the documents
to be adjusted before printing, so that the printed page matches the colors on the
screen closer.

+« Image Color Control
Open the [Image Color Matching] dialog box, and then click this button to specify
exactly how you want the colors on your screen adjusted before printing.
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Printer Utility for Mac

By using Printer Utility for Mac, you can download fonts, change the name of the
printer and so on.

b d | mportant

3 If a Macintosh and printer are connected by USB, you cannot use Printer Util-
ity for Mac.

3 Printer Utility for Mac is included on the CD-ROM labeled “Printer Drivers and
Utilities”.

3 Printer Utility for Mac requires Mac OS 7.6.1-9.x, or Mac OS X 10.1.x or
10.2.1. Mac OS X 10.0.x and 10.2 are not supported.

Installing Printer Utility for Mac
Follow these steps to install Printer Utility for Mac on the machine.
ﬂ Start the Macintosh.

B Insert the CD-ROM into the CD-ROM drive.
The CD-ROM icon appears.

8 Double-click the hard disk icon to open it.

O bouble-click the CD-ROM icon.
The contents of the CD-ROM appear.

B Double-click the [Mac OS 8 and 9] folder.

3 Under Mac OS X, double-click the [Mac OS X] folder.

B Double-click the [PS Utility] folder on the CD-ROM.
ﬂ Double-click the [Printer Utility for Mac] folder.
8 Double-click the folder of the language you use.

ﬂ Move the “Printer Utility for Mac” file to the Macintosh hard disk using a
drag-and-drop operation.

[[D Drag the CD-ROM icon to the Trash to eject the CD-ROM.
Printer Utility for Mac is installed.
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Starting Printer Utility for Mac

Mac OS

S @ | mportant
O Before starting Printer Utility for Mac, make sure the printer is selected in
[Chooser] on the Apple menu.

ﬂ Double-click the Printer Utility for Mac icon.
The [Printer Utility for Mac] dialog box appears.

H click [ox;.
Printer Utility for Mac will take a few seconds to start.

Mac OS X

ﬂ Double-click the Printer Utility for Mac icon.
The [Printer Utility for Mac] dialog box appears.

H ciick [ok).

B In the [Available Printers:] box, select the printer you want to use.
3 If you change zones, select a name from [Available Network Zones:].
3 Click [Choose Printer...] on the Printer Utility for Mac menu if you want to
change the printer.
ﬂ Select the printer you want to use.
Printer Utility for Mac will take a few seconds to start.

B Click [Choose].

Printer Utility for Mac Functions

Downloading PS Fonts

You can download the PS fonts to the printer memory or hard disk drive.

b d | mportant

 The following procedure to download the fonts assume that you are a system
administrator. If you are not, be sure to consult your system administrator.

3 During the download, do not turn off the power switch, operate the panel or
open or close the cover.

3 If the printer restarts, all the printer settings return to the defaults.
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3 Confirm that a Macintosh and the printer are connected with Appletalk.

[I Select [Download PS Fonts...] on the [File] menu.

B click [Add to list].
The dialog box to select fonts appears.

B Select the desired font files, and then click [Open].
The list of selectable font names appears.

ﬂ After adding all the fonts you want to download, click [OK].
The dialog box of selected fonts to download appears.

B Click [Download].

The fonts begin to download, and the download status is shown.

B When the completion message appears, click [OK].

 click [cancel].

O Some fonts cannot be downloaded.

O Before downloading, read the documentation about the fonts you want to

use.

Displaying Printer Fonts

You can display the available fonts currently downloaded to the printer. Fonts in

the printer memory and hard disk drive can be displayed.

ﬂ Select [Display Printer's Fonts...] on the [File] menu.
A dialog box appears.

EI Select [Printer's memory] or [Printer's disk].
8 Click [OK].

O The fonts displayed in italics are the default fonts.
Deleting Fonts

You can delete fonts from the printer memory or hard disk drive.
S @ | mportant
3 You cannot delete the fonts displayed in italic.

ﬂ Select [Display Printer's fonts] on the [File] menu.
A dialog box appears.
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ﬂ Select [Printer's memory] or [Printer's disk].
8 Select the fonts you want to delete.

ﬂ Click [Delete].
A confirmation message appears.

B Confirm the fonts you want to delete and the printer name from which
you want to delete the fonts.

[3 click [Continue], and then click [OK].
t click [ok).
Initializing the Printer Disk

When initializing the printer hard disk, all the fonts downloaded to the printer hard
disk drive are deleted. Before initializing, be sure to check the fonts on the hard
disk drive.

b d | mportant

O When initializing the printer hard disk drive from the control panel, all of the
data on the printer hard disk drive is deleted. Before initializing, be sure to
check the data on the hard disk drive.

3 Do not turn off the power switch until initializing is completed, otherwise the
hard disk drive might be damaged.

I] Select [Initialize Printer's Disk...] on the [File] menu.
The confirmation message appears. To cancel initialization, click [Cancel].

B Click [Execute].
Initializing starts.

B When the completion message appears, click [OK].
Page Setup

You can set the paper size on which to print “Print Fonts Catalogue” and “Prints
Fonts Sample”.

ﬂ Select [Page Setup...] on the [File] menu.

ﬂ Select the paper size.

Printing Font Catalog

You can print the names of fonts available on the printer.

ﬂ Select [Print Fonts Catalogue] on the [File] menu.
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H click [print.
O The paper selected under [Page Setup] is used.
Printing Font Sample
You can print samples of fonts downloaded to the hard disk drive or memory.
ﬂ Select [Print Fonts Sample...] on the [File] menu.
ﬂ Click [Print].
3 Print by using the paper selected on [Page Setup].

Renaming the Printer

You can change the printer name displayed under Appletalk. If you connect sev-
eral printers on the network, assign different names so you can identify them. If
several printers have the same name, a digit appears next to the printer name in
[Chooser].

b d | mportant

O You can enter up to 31 digits and letters.

3 Do not use symbols, for example “*”, “”, “=", “@”, “~”.

Mac OS

ﬂ On the [File] menu, click [Rename Printer...].
ﬂ In the [New Name:] filed enter a new name.

8 Click [Rename].
The printer name is changed.

O ciick [ok].
B On the Apple menu, click [Chooser].
B Click the [AdobePS] icon.

ﬂ Select the printer whose name you changed, and then close the [Chooser]
dialog box.

3 If there are several Appletalk zones, select the zone the machine belongs
to.
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Mac OS X

I] On the [File] menu, click [Rename Printer...].
EI In the [New Name:] filed enter a new name.

B Click [Rename].
The printer name is changed.

O click [ok].
B On the [Printer Utility for Mac] menu, click [Choose Printer...].

E In the [Available Network Zones:] list, select the zone for the Macintosh in
use.

ﬂ In the [Available Printers:] list, select the printer whose name you changed,
and then click [Choose].

Restarting the Printer
You can restart the printer.
ﬂ Select [Restart Printer] on the [File] menu.

ﬂ Confirm the message that appears on the screen, and then click [Restart].
The printer restarts.

3 The fonts downloaded in the printer memory will be deleted.
3 If the printer restarts, all the printer settings return to the defaults.

Downloading PostScript Files
You can download a Postscript file to the printer.
I] Select [Download PostScript File...] on the [Utility] menu.

B Select the file name to download, click the file nhame, and then click
[Open].

B Type the log file name, and then click [Save].
The selected file is downloaded.

3 Errors are recorded in the log file.
Selecting the Zone

You can change the zone to which the printer belongs under Appletalk.
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b d | mportant
3 Confirm that a Macintosh and printer are connected with Appletalk.

Mac OS

I] On the [Utility] menu, click [Select Zone...].
The zone to which the printer belongs and the available zone list appear.

g Select the zone in which you want to locate the printer, and then click
[Change].

A confirmation message appears.

B Click [Continue].
A confirmation message appears.

ﬂ Click [OK].

B On the Apple menu, click [Chooser].

B Click the [AdobePS] icon.

ﬂ In the [Appletalk zone:] list, select the zone you changed.

8 In the [Select a PostScript Printer:] list, select the printer you want to use.

ﬂ Close the [Chooser] dialog box.

Mac OS X

I] On the [Utility] menu, click [Select Zone...].
The zone to which the printer belongs and the available zone list appear.

g Select the zone which you want to locate the printer in, and then click
[Change].
A confirmation message appears.

B Click [Continue].
A confirmation message appears.

ﬂ Click [OK].
B On the [Printer Utility for Mac] menu, click [Choose Printer...].
B In the [Available Network Zones:] list, select the zone you changed.

ﬂ In the [Available Printers:] list, select the model of printer in use, and then
click [Choose].
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Displaying the Printer Status
You can display and confirm the current status of the printer.

ﬂ Select [Display Printer Status...] on the [Utility] menu.
The current status of the printer appears.

ﬂ Confirm the current status of the printer.

You can confirm the memory capacity, the VM (Virtual Memory) space, the
hard disk drive status and available space on the hard disk drive. You can also
confirm the zone to which the printer belongs.

E click [ox;.
Launching the Dialogue Console

You can create and edit a PostScript file for printing, and then download it to the

printer.

® @ | mportant

O “Launch Dialogue Console” is recommended for users with an understanding
of PostScript.

3 Do not download any file other than PostScript files to the printer.
3 “Launch Dialogue Console” must be used at your own responsibility.

[I Select [Launch Dialogue Console...] on the [Utility] menu.
Open the editing screen. The Dialogue Console menu bar appears.

B Type the PostScript command in the editor screen.
To edit a PostScript file, select [Open] on the [File] menu to open it.
You can search or replace a character string by using the [Search] menu.

B After editing the PostScript file, select [Download Top Window] on [Console]
menu to start printing.

The PostScript file is sent to the printer.
The [Reply from Printer] box opens, depending on the PostScript file you sent.

ﬂ Select [Return To Main Menu] on the [Console] menu to close the PostScript
file.
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Software and Utilities Included on the CD-
ROM

The following softwares and utilities are included in the CD-ROMs that come with
the printer.

% Font Manager 2000
For installing new screen fonts, or organizing and managing fonts already in
the system. For details about Font Manager 2000, see the manual on the CD-
ROM labeled “Printer Drivers and Utilities”.

« SmartDeviceMonitor for Admin
For the system administrator to manage network printers.
=l Feference
SmartDeviceMonitor for Admin Help

% SmartDeviceMonitor for Client
For users to manage their network print status.

=l Feference
SmartDeviceMonitor for Client Help
“ 1394 Utility

For the optional IEEE 1394 interface unit. For details, see the Readme file or
the manual provided with the optional IEEE 1394 interface unit.

«+ USB Printing Support
For connection to Windows 98 SE/Me computers via USB.

Viewing the contents of the CD-ROM

Follow the procedure below to view the contents of the CD-ROM.

) insert the CD-ROM into the CD-ROM drive.
The installer starts.

H click [Browse This CD-ROM].
Explorer starts and displays the contents of the CD-ROM.

Printer Drivers for This Printer

Printing requires installing a printer driver appropriate to your operating system.
The following drivers are included on the CD-ROM provided with this printer.
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PCL 6/5e printer driver

This printer driver allows the computer to communicate with the printer via a

printer language.

The following operating system is supported.

* Windows 95/98/Me, Windows 2000/XP, Windows Server 2003, and Win-
dows NT 4.0

3 For Windows NT 4.0, Service Pack 6 or higher is required.

3 You can only print in black and white with PCL 5c driver.

RPCS printer driver

This printer driver allows the computer to communicate with the printer using
a printer language. In addition to the conventional user interface, another pre-
set user interface is provided.

The following operating system is supported.

¢ Windows 95/98/Me, Windows 2000/XP, Windows Server 2003, and Win-
dows NT 4.0

O For Windows NT 4.0, Service Pack 6 or higher is required.

PostScript Printer Drivers and PPD files

PostScript printer drivers and the PPD files are included on the CD-ROM pro-
vided with this printer. PostScript printer drivers allow the computer to com-
municate with the printer using a printer language. PPD files allow the printer
driver to enable specific printer functions.

The following operating system is supported.

¢ Windows 95/98/Me, Windows 2000/XP, Windows Server 2003, Windows
NT 4.0, Mac OS, and Mac OS X

O The PostScript printer drivers and PostScript Printer Description (PPD)
files are included on the CD-ROM labeled “Printer Drivers and Utilities”.

O For Mac OS, version 8.6 or higher is required. (Mac OS X Classic environ-
ment is supported.)

PPD files
PPD files are included on the CD-ROM provided with this printer. PPD files
allow the printer driver to enable specific printer functions.

SmartDeviceMonitor for Admin

SmartDeviceMonitor for Admin is an application that uses TCP/IP and IPX/SPX
to monitor network printers. It can monitor multiple network printers using IP ad-
dress. We recommend that network administrators use this application.
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+ File path
SmartDeviceMonitor for Admin is stored in the following folder on the CD-
ROM.

NETWORK\DEVMON\admin\DISK1

Operating system Protocol stack

Windows 95/98/Me TCP/IP provided with Windows 95/98/Me
IPX/SPX provided with Windows 95/98/Me
NetWare Client provided with Windows 95/98
Novell Client provided with Windows 95/98

Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000
Novell Client provided with Windows 2000 or Win-
dow NT

Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

NetWare Client provided with Windows XP

Novell Client provided with Windows XP

Windows Server 2003 TCP/IP provided with Windows Server 2003
IPX/SPX provided with Windows Server 2003
NetWare Client provided with Windows Server 2003
Novell Client provided with Windows Server 2003

Windows NT 4.0 TCP/IP provided with Windows NT
IPX/SPX provided with Windows NT

Client Service for NetWare provided with Windows
NT

Novell Client provided with Windows 2000 or Win-
dows NT

% Available functions
SmartDeviceMonitor for Admin has the following functions to check:

e printer supplies such as paper or toner;
e results of print jobs executed from the computer.
=l Feference

For details about using SmartDeviceMonitor for Admin, see SmartDevice-
Monitor for Admin Help.

SmartDeviceMonitor for Client

SmartDeviceMonitor for Client has the following functions. We recommend that
users install this application.
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* Printing in a peer-to-peer network, using TCP/IP, and IPP from Windows

95/98/Me/2000/XP, Windows Server 2003, and Windows NT 4.0.

* Constantly monitoring the status of devices on the network using TCP/IP and

IPX/SPX.
+ File path

SmartDeviceMonitor for Client is stored in the following folder on the CD-

ROM.

NETWORK\DEVMON\CLIENT\DISK1

Operating system

Protocol stack

Windows 95/98/Me

TCP/IP provided with Windows 95/98/Me
IPX/SPX provided with Windows 95/98/Me
NetWare Client provided with Windows 95/98/Me
Novell Client provided with Windows 95/98/Me

Windows 2000

TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000
Novell Client provided with Windows 2000 or NT

Windows XP

TCP/IP provided with Windows XP
IPX/SPX provided with Windows XP
NetWare Client provided with Windows XP
Novell Client provided with Windows XP

Windows Server 2003

TCP/IP provided with Windows Server 2003
IPX/SPX provided with Windows Server 2003
NetWare Client provided with Windows Server 2003
Novell Client provided with Windows Server 2003

Windows NT 4.0

TCP/IP provided with Windows NT
IPX/SPX provided with Windows NT

Client Service for NetWare provided with Windows
NT

Novell Client provided with Windows 2000 or Win-
dows NT

< Available functions

SmartDeviceMonitor for Client has the following functions.

e Peer-to-peer print function
* Prints directly on the network printer without sending any data to a print

server.

* Prints on a substitute printer when there are too many jobs waiting on
the specified printer, or when an error disables printing (Recovery Print-

ing).

e Allocates multiple print jobs to multiple printers (Parallel Printing).
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* Executes prior group registration of printers specified for Recovery
Printing or Parallel Printing.

¢ Notification function

* Displays an error message when there is an error on the specified print-
er while transferring or printing data.

* Notifies a print completion. You can also be notified of the print condi-
tion, such as displaying the notice only when Recovery Printing is exe-
cuted.

* Monitoring function
* Checks printer supplies such as paper or toner.
e Simultaneously monitors multiple printers in use.

* Checks the printer's network settings and detailed information of print-
ers.

* Enables you to check the print job log using the user ID
S @ | mportant

O For Recovery Printing or Parallel Printing, the options on the printers must
be the same. If a necessary option is not installed, a printer cannot be used
for Recovery Printing or Parallel Printing.

O For Recovery Printing or Parallel Printing, the paper loaded in the printers
must be the same. When a tray is selected for printing, load the same pa-
per in that tray in all printers.

3 For Recovery Printing or Parallel Printing, the print results may be different
if the printers are not the same model or have exactly the same options.

3 If you select Sample Print or Locked Print, you cannot select Recovery
Printing or Parallel Printing.

=l Reference

For details about SmartDeviceMonitor for Client, See SmartDeviceMonitor
for Client Help.
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Cautions to Take When Using in a network

Connecting a Dial-up Router to a Network

When the NetWare file server and printer are on opposite sides of a router, pack-
ets are sent back and forth, causing communication charges to be incurred. Be-
cause packet transmission is a specification of NetWare, you need to change the
configuration of the router. If the network you are using does not allow you to
configure the router, configure the printer instead.

Configuring the router

Filter packets so that they do not pass over the dial-up router.

O The MAC address of the printer doing the filtering is printed on the printer con-

figuration page. For details about printing a configuration page, see p.161
“Printing a Configuration Page”.

O For details about configuring the printer if the router cannot be configured, see
the instructions below.

[I Display Web Image Monitor.
8 On the Web Image Monitor top page, click [Login].

B Enter the user name and passwords, and then click [OK].

3 For details about the password, consult your network administrator.
ﬂ Click [Configuration] in the left area, click [Network], and then click [NetWare].
B In the right area, select the [Frame Type] you are using.
B Click [Apply].
ﬂ Close the Web browser.

Using DHCP

This printer can be used in a DHCP environment. In a WINS server environment,
the printer name can simultaneously be registered with a WINS server.

Note the following points when an Ethernet interface and an IEEE 1394 (IP over
1394) interface are simultaneously installed.
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«» When static IP addresses are set for each interface

IP address: When set at the same value, the Ethernet interface is pre-
ferred.

Subnet mask: When a value overlaps, the Ethernet interface is preferred.

Gateway address: The value set is used. For the gateway address, set the
gateway address located in the subnetwork set by the interface. If the value
is outside the subnet range set by the interface, it operates as “0.0.0.0”.

% When each setting is acquired from the DHCP server

IP address, subnet mask: Set for each value leased by the DHCP server
operating on a connected interface. When overlapping IP addresses or
identical IP addresses in the subnetwork are set, only the highest priority
active value is set for the interface.

O The default priority interface is Ethernet.

AutoNet: An automatic private address (169.254. xxx.xxx) is set for high
priority interfaces.

3 The default priority interface is IEEE 1394 (IP over 1394).

Gateway address, DNS server address, domain name: Settings are made
for DHCP-acquired values that have the highest interface priority.

If the gateway address is outside the subnetwork range set by the inter-
face, it operates as “0.0.0.0”".

O The default priority interface is Ethernet.

% When the settings of the static IP addresses and the DHCP acquired value overlap

IP address, subnet mask: When the static IP address and DHCP-acquired
value (IP address) are the same, or the static subnet mask value and
DHCP-acquired subnet mask value overlap, the interface set by the static
IP address is available using its value set. The interface set by DHCP is
reset to the default.

Gateway address: Use the manually set value.

If a gateway address is set outside the interface subnetwork range, it op-
erates as “0.0.0.0".

O When the static IP address is not set, or is set as “0.0.0.0”, the interface
setting the DHCP-acquired value is activated.

O Supported DHCP server operating systems are: Windows 2000 Server, Win-
dows NT 4.0 Server Service Pack 4 or higher, NetWare, and UNIX standard.
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O The IP address acquired from DHCP can be checked on the configuration
page. For information about printing a configuration page, see p.161 “Printing
a Configuration Page”.

O When using WINS server, set the WINS server as shown on p.321 “Configur-
ing the WINS Server”.

O Under the WINS server, host names can be used for remote network printer
ports.

3 If you are not using the WINS server, reserve the printer's IP address in the
DHCP server so the same IP address is assigned every time.

3 When there are multiple DHCP servers, make the same reservation for all.
This printer uses information from the DHCP server that responds first.

O The DHCP relay-agent is not supported. If you are using the DHCP relay-
agent on an ISDN line network, expensive line charges will be incurred. This
is because your computer connects to the ISDN line whenever a packet is
transferred from the printer.

Using AutoNet

If the printer IP address is not assigned by a DHCP server automatically, a tem-
porary IP address starting with 169.254, which is not used on the network, can
be automatically selected by the printer.

You must change this setting to “on” to use AutoNet.
=l Feference
See p.219 “autonet”.

O The DHCP-assigned IP address has priority over that selected by AutoNet.
The printer reboots at this time, and is temporarily unable to print.

3 You can check the current IP address on the configuration page. For details
about printing a configuration page, see p.161 “Printing a Configuration
Page”.

O When AutoNet is running, the printer name is not registered on the WINS
server.

O No communication can take place except between units started up using Au-
toNet. However, communication can take place with Macintosh computers
running Mac OS X 10.2.3 or higher versions.

Configuring the WINS Server

The printer can be configured to register its NetBIOS name with a WINS server
when the power is turned on. This enables the NetBIOS name of the printer to
be specified from SmartDeviceMonitor for Admin even in a DHCP environment.

This section explains configuring the WINS server.
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O The WINS server is supported with Windows NT 4.0 Server Service Pack 4
or higher, and Windows 2000 Servers WINS Manager.

3 For details about the WINS server settings, see Windows Help.

O3 If there is no reply from the WINS server, the NetBIOS name is registered by
broadcast.

O The NetBIOS name can be entered using up to 13 alphanumeric characters.

Using Web Image Monitor

ﬂ Start a Web browser.

EI Enter “http: //(printer's address)/” in the address bar to access the print-
er whose settings you want to change.

Top Page of Web Image Monitor appears.
B Click [Login].
The dialog box for entering the user name and password appears.

ﬂ Enter the user name and password, and then click [OK].
For details about the password, consult your network administrator.

B In the left area, click [Configuration], and then click [Network].
B Click [TCP/IP].

ﬂ Check that [Enable] is selected for [WINS] in the [Ethernet+lEEE 802.11b] col-
umn, and then enter the WINS server IP address in [Primary WINS Server]
and [Secondary WINS Server].

O When installing the optional expansion 1394 board and using IP over 1394
simultaneously, perform the same operations in the [IP over 1394] column.

8 Click [Apply]-
g Quit Web Image Monitor.
Using telnet

See p.217 “Using telnet”.
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Using the Dynamic DNS Function

Dynamic DNS is a function which dynamically updates (registers and deletes)
records (A record and PTR record) managed by the DNS server. When a DNS
server is part of the network environment to which this printer, a DNS client, is
connected, records can be dynamically updated using this function.

Updating

Updating procedure varies depending on whether the printer IP address is static
or acquired by DHCP.

0

0

When the dynamic DNS function is not used, records managed by the DNS
server must be updated manually, if the printer's IP address is changed.

To update the record using the printer, the DNS server has to have one of the
following:

* No security settings made.

 [f security settings are made, an IP-specified client (this printer) permits up-
dating.

For a static IP setting

If the IP address or host name is changed, the A and PTR records are updat-
ed.

If the A record is registered, CNAME is also registered. CNAMEs that can be
registered are as follows:

e Ethernet and IEEE 802.11b
RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the
MAC address)

e |EEE 1394
RNPXXXXXXXXXX (XXXXXXXXXX represents the lower 3-7 bytes of the
MAC Address in hexadecimal)

For DHCP settings
As a substitute for the printer, the DHCP server updates the record, and one
of the following occurs:

* When the printer acquires the IP address from the DHCP server, the DHCP
server updates the A and PTR records.

* When the printer acquires the IP address from the DHCP server, the printer
updates the A record, and the DHCP server updates the PTR record.

If the A record is registered, CNAME is also registered. CNAMEs that can be

registered are as follows:

e Ethernet and IEEE 802.11b

RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the
MAC address)
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e |EEE 1394
RNPXXXXXXXXXX (XXXXXXXXXX represents the lower 3-7 bytes of the
MAC Address in hexadecimal)

® @ | mportant
3 Dynamic update using message authentication (TSIG, SIG(0)) is not support-
ed.

DNS servers targeted for operation

% For static IP setting

¢ Microsoft DNS servers with standard Windows 2000 Server/Windows
Server 2003 features

* BIND 8.2.3 or higher

% For DHCP setup, when the printer updates the A record

¢ Microsoft DNS servers with standard Windows 2000 Server/Windows
Server 2003 features

* BIND 8.2.3 or higher

«+ For DHCP setup, when the DHCP server updates records

¢ Microsoft DNS servers with standard Windows 2000 Server/Windows
Server 2003 features

* BIND 8.2.3 or higher
* DNS servers with standard NetWare 5 (or a higher version) features

DHCP servers targeted for operation

As a substitute for the printer, DHCP servers capable of updating the A record
and PTR record are as follows:

* Microsoft DHCP servers with standard Windows 2000 Server (Service Pack
3 or higher versions)/Windows Server 2003 features

e |SC DHCP 3.0 or higher
e DHCP server with standard NetWare 5 features

Setting the dynamic DNS function

Make settings with telnet using the “dns” command. For details, see p.222 “dns”.
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Configuring SSL Encryption

This section describes how to configure SSL (secure sockets layer) encryption.

SSL (Secure Sockets Layer) Encryption

To protect the communication path and establish encrypted communication, cre-
ate and install the server certificate.

There are two ways of installing a server certificate: create and install a self-cer-
tificate using the machine, or request a certificate from a certificate authority and
install it.

% Configuration flow (self-signed certificate)

@ Creating and installing the server certificate
Install the server certificate using Web Image Monitor.

@ Enabling SSL
Enable the [SSL/TLS] setting using Web Image Monitor.

% Configuration flow (certificate issued by a certificate authority)

@ Creating the server certificate
Create the server certificate using Web Image Monitor.
The application procedure after creating the certificate depends on the cer-
tificate authority. Follow the procedure specified by the certificate authority.

@ Installing the server certificate
Install the server certificate using Web Image Monitor.

® Enabling SSL
Enable the [SSL/TLS] setting using Web Image Monitor.
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To confirm whether SSL configuration is enabled, enter https://(machine’s-
address) in your Web browser’s address bar to access this machine. If the
“The page cannot be displayed” message appears, check the configuration
as the SSL configuration is invalid.

Creating and Installing the Self-Signed Certificate

Create and install the server certificate using Web Image Monitor.
This section explains the use of a self-certificate as the server certificate.

I] Open a Web browser.

ﬂ Enter “http://(printer's-address)/” in the address bar to access the print-
er.
B Select Administrator mode.
=l Feference

For details about selecting Administrator mode in Web Image Monitor, see
p.197 “Access in the Administrator Mode”.

ﬂ Click [Configuration], then click [Security], and then click [Certificates].
B Click [Create].

B Make the necessary settings.

e Common Name: Enter the server certificate common name, using up to 64
characters (required). The common name cannot include any spaces, and
is case sensitive. The default is the IP address of the interface board in use.

¢ Organization: Enter the full name of your company, using up to 64 charac-
ters (optional). The organization name cannot include any spaces, and is
case sensitive.

¢ Organizational Unit: Enter the section of your company that is requesting
the certificate, using up to 64 characters (optional). The organization unit
name cannot include any spaces, and is case sensitive.

» City/Locality: Enter the city/locality in which the device is located, using up
to 128 characters (optional). The city/locality name cannot include any
spaces, and is case sensitive.

» State/Province: Enter the state/province in which the device is located, us-
ing up to 128 characters (optional). The state/province name cannot in-
clude any spaces, and is case sensitive.

e Country Code: Enter the country in which the device is located, using two-
letter ISO 3166 abbreviation of the country (required).

» Validity Period: Enter the period of time for which the server certificate is
valid, in years. The default is one year.
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» Validity Start Date: Enter the start date of the validity of the server certifi-
cate. The default is the current date obtained from the internal clock of the
computer that is accessing Web Image Monitor.

t click [ok].

[Installed] appears under [Certificate Status] to show that a server certificate for
the printer has been installed.

3 Click [Delete] to delete the server certificate from the printer.
Creating the Server Certificate (Certificate Issued by a Certificate Authority)

Create the server certificate using Web Image Monitor.

This section explains the use of a certificate issued by a certificate authority as
the server certificate.

ﬂ Open a Web browser.

EI Enter “http://(printer's-address)/” in the address bar to access the print-
er.
8 Select Administrator mode.

=l Reference

For details about selecting Administrator mode in Web Image Monitor, see
p.197 “Access in the Administrator Mode”.

ﬂ Click [Configuration], then click [Security], and then click [Certificates].
The [Certificate Information] page appears.

B Click [Request].

E Make the necessary settings.

e Common Name: Enter the server certificate common name, using up to 64
characters (required). The common name cannot include any spaces, and
is case sensitive. The default is the IP address of the interface board in use.

* Organization: Enter the full name of your company, using up to 64 charac-
ters (optional). The organization name cannot include any spaces, and is
case sensitive.

e Organizational Unit: Enter the section of your company that is requesting
the certificate, using up to 64 characters (optional). The organization unit
name cannot include any spaces, and is case sensitive.

» City/Locality: Enter the city/locality in which the device is located, using up
to 128 characters (optional). The city/locality name cannot include any
spaces, and is case sensitive.
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e State/Province: Enter the state/province in which the device is located, us-
ing up to 128 characters (optional). The state/province name cannot in-
clude any spaces, and is case sensitive.

e Country Code: Enter the country in which the device is located, using two-
letter ISO 3166 abbreviation of the country (required).

* Validity Period: Enter the period of time for which the server certificate is
valid, in years. The default is one year.

* Validity Start Date: Enter the start date of the validity of the server certifi-
cate. The default is the current date obtained from the internal clock of the
computer that is accessing Web Image Monitor.

U ciick [ok].
[Requesting] appears under [Certificate Status].
Use the data in the [Certificate Request Contents:] dialog box to apply to the cer-
tificate authority.

8 Apply to the certificate authority for the server certificate.

The application procedure depends on the certificate authority. For detalils,
contact the certificate authority.

When applying, use the data created with Web Image Monitor.

O By using Web Image Monitor, you can create the contents of the server
certificate but you cannot send the application.

3 Click [Cancel Request] to cancel the request for the server certificate.
Installing the Server Certificate (Certificate Issued by a Certificate Authority)

Install the server certificate using Web Image Monitor.

This section explains the use of a certificate issued by a certificate authority as
the server certificate.

Enter the server certificate contents issued by the certificate authority.
I] Open a Web browser.

ﬂ Enter “http://(printer's-address)/” in the address bar to access the print-
er.
B Select Administrator mode.
=l Feference

For details about selecting Administrator mode in Web Image Monitor, see
p.197 “Access in the Administrator Mode”.

ﬂ Click [Configuration], then click [Security], and then click [Certificates].
The [SSL Certificate] page appears.

328



Appendix

A click pinstann.

B Enter the contents of the server certificate.

In the displayed field, enter the contents of the server certificate issued by the
certificate authority.

=l Feference
For details about the displayed items and selectable items, see Web Image
Monitor Help.
U ciick [ok].
[Installed] appears under [Certificate Status] to show that a server certificate for
the printer has been installed.
Enabling SSL

After installing the server certificate in the printer, enable the SSL setting.

This procedure is used for a self-signed certificate or a certificate issued by a cer-
tificate authority.

I] Open a Web browser.

8 Enter “http://(printer's-address)/” in the address bar to access the print-
er.
B Select Administrator mode.
=l Feference

For details about selecting Administrator mode in Web Image Monitor, see
p.197 “Access in the Administrator Mode”.

ﬂ Click [Configuration], then click [Security], and then click [SSL/TLS].
The [SSL/TLS Settings] page appears.

B Click [Enable] for [SSL/TLS].
B Click [Apply]-
The SSL setting is enabled.

O When using SSL, enter "http://(machine's-address)/" to access the printer.
For this to work, Internet Explorer 5.5 or later, or Netscape 7.0 or later must
be installed on your computer.

User Settings for SSL (Secure Sockets Layer)

If you have installed a server certificate and enabled SSL (Secure Sockets Lay-
er), you need to install the certificate on the user's computer.
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The administrator must explain the procedure for installing the certificate to us-
ers.

If a warning dialog box appears while accessing the machine using the Web
browser or IPP, start the Certificate Import Wizard and install a certificate.

ﬂ When the [Security Alert] dialog box appears, click [View Certificate].
The [Certificate] dialog box appears.

To be able to respond to inquiries from users about such problems as expiry
of the certificate, check the contents of the certificate.

EI On the [General] tab, click [Install Certificate...].
Certificate Import Wizard starts.

B Install the certificate by following the Certificate Import Wizard instruc-
tions.

O For details about how to install the certificate, see the Web browser Help.

3 If a certificate issued by a certificate authority is installed in the printer, con-
firm the certificate store location with the certificate authority.

Installing the Certificate Using SmartDeviceMonitor for Client

If the [Security Alert] dialog box appears when accessing the printer using IPP to
create or configure an IPP port, or when printing, install the certificate.

® @ | mportant
O To select the certificate store location when using Certificate Import Wizard,

click [Place all certificates in the following store], and then click [Local Computer]
under [Trusted Root Certification Authorities].

O Internet Explorer must be installed on your computer. Use the latest version.
Internet Explorer 6.0 or later is recommended.

ﬂ When [Security Alert] appears, click [View Certificate].
The [Certificate] dialog box appears.

ﬂ On the [General] tab, click [Install Certificate...].
Certificate Import Wizard starts.

B Click [Place all certificates in the following store], and then click [Browse...].
The [Select certificate store] dialog box appears.

ﬂ Click [Next].

B Select the [Show physical stores] check box, and then click [Local Computer]
under [Trusted Root Certification Authorities].
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[ click [ok.
The certificate store location appears under [Certificate store:].

U click [Nexi].
8 Click [Finish].
B click [ok).

The certificate is installed.

3 When you create or change an IPP port using SmartDeviceMonitor for Cli-
ent, enter "http://(machine's-address)/ printer" in [Printer URL] to access the
printer.
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Installing Font Manager 2000

b d | mportant

3O Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, install-
ing applications by Auto Run requires administrator permission. To install a
printer driver by Auto Run, log on using an account that has administrator per-
mission.

ﬂ Quit all applications currently running.

Fd insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Click [Font Manager 2000].

ﬂ Follow the instructions on the screen.
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Using Adobe PageMaker Version 6.0, 6.5,
or7.0

Under Windows 95/98/Me/2000/XP, Windows Server 2003, or Windows NT 4.0
with Adobe PageMaker, you need to copy PPD files to the PageMaker folder.

PPD files have the .ppd extension in the folder “DRIVERS\PS\WIN9X_ME \(Lan-
guage)\DISK1\” on the CD-ROM.

The “WIN9X_ME” folder inside the “PS” folder is for Windows 95/98/Me. Use the
folder at this level that is appropriate for the operating system you are currently
using.

The third folder “(Language)” may be substituted by an appropriate language
name.

Copy the “.ppd” file to the PageMaker folder.

* For PageMaker 6.0 default installation
The directory is “C:\PM6\RSRC\PPD4”.

* For PageMaker 6.5 default installation
The directory is “C:\PM65\RSRC\USENGLISH\PPD4”.
The “USENGLISH” may vary depending on your language selection.

* For PageMaker 7.0 default installation
The directory is “C:\PM7\RSRC\USENGLISH\PPD4".
The “USENGLISH” may vary depending on your language selection.

O If the driver is not set correctly after copying the “.ppd” file, printing may not
be performed properly.

O When using PageMaker, the optional features that can be selected by the
printer driver will not be active. The following procedure describes how to ac-
tivate the optional printer features.

@ On the [File] menu, click [Print].
The [Print Document] dialog box appears.

@ Make the necessary settings in the [Features] box.
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When Using Windows Terminal
Service/MetaFrame

The following explains how to use Windows Terminal Service and Maintenance.

Operating Environment
The following operating systems and MetaFrame versions are supported.

% Windows NT Server 4.0 Terminal Server Edition with SP6 or higher
* MetaFrame 1.8 SP3/FR1 SP3/SP4
* MetaFrame XP 1.0 SP1/SP2/FR1

<+ Windows 2000 Server/Advanced Server
e MetaFrame 1.8 SP3/FR1 SP3/SP4
e MetaFrame XP 1.0 SP1/SP2/SP3/FR1/FR2/FR3
e MetaFrame Presentation Server 3.0

< Windows 2003 Server
e MetaFrame XP 1.0 FR3
¢ MetaFrame Presentation Server 3.0

Supported Printer Drivers

% When Windows Terminal Service is operating
e PCL printer drivers
* PostScript 3

O The RPCS printer driver is not supported.

O Some RPCS printer driver functions do not work if Windows Terminal Service
is installed.

Limitations

The following limitations apply to the Windows Terminal Service environment.
These limitations are built in Windows Terminal Service or MetaFrame.
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R
%

Windows Terminal Service

In an environment where Windows Terminal Service is installed, some printer
driver functions are unavailable, even if no Windows Terminal Service func-
tions are used. Use the install mode to install SmartDeviceMonitor for Client
in an environment where Terminal Service is running on a Windows NT Serv-
er 4.0 Terminal Server Edition or Windows 2000 Server family computer. The
following are the two methods of installation using the install mode:

@® Use [Add/Remove Programs] in [Control Panel] to install SmartDeviceMonitor
for Client.

@ Enter the following command in the MS-DOS command prompt:

CHANGE USER /INSTALL
To quit the install mode, enter the following command in the MS-DOS com-
mand prompt:

CHANGE USER /EXECUTE
=l Feference
For more information, see Windows Help.

MetaFrame's [Auto-creating client printers]

Using [Auto-creating client printers], you can select a logical printer created by
copying the client's local printer data to the MetaFrame server. We strongly
recommend testing this function in your network environment before using it
for your work.

* The settings for optional equipment will not be stored in the server after the
equipment is disconnected. The settings for optional equipment will be re-
stored to its defaults each time the client computer logs on to the server.

* When printing a large number of bitmap images or using the server in a
WAN environment over dial-up lines such as ISDN, printing may not be
possible or errors may occur, depending on data transfer rates.

¢ When using MetaFrame XP 1.0 or higher versions, we recommend making
settings in [Client Printer bandwidth] under [Citrix Management Console] accord-
ing to the environment.

e |f a print error occurs on the server and the print job or a printer created in
[Auto-creating client printers] cannot be deleted, we recommend the follow-
ing:

e MetaFrame 1.8 SP3, MetaFrame XP 1.0 SP1/FR1

Make settings in [Delete unfinished print jobs] in the registry. For details,
see the Readme file provided with MetaFrame.

* MetaFrame XP 1.0 FR2
Make settings in [Delete pending print jobs at logout] under [Printer Proper-
ties Management] of Citrix Management Console.
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% MetaFrame's [Printer driver replication]
Using [Printer driver replication], you can distribute printer drivers across all
servers in a server farm. We strongly recommend testing this function in your
network environment before using it for your work.
* If the printer drivers are not properly copied, install them directly onto each
server.
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Cautions When Using Bluetooth Interface
Unit

The optional Bluetooth interface unit operation mode is set to [Public] as default.

If the setting is changed to [Private], only registered computers can use this print-
er via the Bluetooth interface unit.

Check the operation mode settings using Web Image Monitor or telnet.

= Reference

For details about using Web Image Monitor, see p.194 “Using Web Image
Monitor”. For details about setting items, see Web Image Monitor Help.

For details about making operation mode settings using telnet, see p.219 “bt-
config”.
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Information about Installed Applications

expat

Use of the software installed on this product, including the controller (hereinafter
“software”) and the expat Version 1.95.2 application software (hereinafter “expat
1.95.2”), is subject to the following conditions:

The product manufacturer provides warranty and support to the software of the
product including expat 1.95.2 and the product manufacturer allows the initial de-
veloper of expat 1.95.2 to be free from these obligations.

Copyright © 1998, 1999, 2000 Thai Open Source Software Center Ltd
and Clark Cooper

Permission is hereby granted, free of charge, to any person obtaining a copy of
this software and associated documentation files (the “Software”), to deal in the
Software without restriction, including without limitation the rights to use, copy,
modify, merge, publish, distribute, sublicense, and/or sell copies of the Software,
and to permit persons to whom the Software is furnished to do so, subject to the
following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS 1S”, WITHOUT WARRANTY OF ANY
KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WAR-
RANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PUR-
POSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHER-
WISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFT-
WARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

3 Information on expat 1.95.2 is available at:

http://expat.sourceforge.net/

JPEG LIBRARY

e The software installed on this product is based in part on the work of the In-
dependent JPEG Group.

NetBSD

Copyright Notice of NetBSD
For all users to use this product:
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This product contains NetBSD operating system:

For the most part, the software constituting the NetBSD operating system is not
in the public domain; its authors retain their copyright.

The following text shows the copyright notice used for many of the NetBSD
source code. For exact copyright notice applicable for each of the files/binaries,
the source code tree must be consulted.

A full source code can be found at http://www.netbsd.org/.
Copyright © 1999, 2000 The NetBSD Foundation, Inc.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification,
are permitted provided that the following conditions are met:

@ Redistributions of source code must retain the above copyright notice, this list
of conditions and the following disclaimer.

@ Redistributions in binary form must reproduce the above copyright notice, this
list of conditions and the following disclaimer in the documentation and/or oth-
er materials provided with the distribution.

® All advertising materials mentioning features or use of this software must dis-
play the following acknowledgment:
This product includes software developed by the NetBSD Foundation, Inc.
and its contributors.

@ Neither the name of The NetBSD Foundation nor the names of its contributors
may be used to endorse or promote products derived from this software with-
out specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MER-
CHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DIS-
CLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEM-
PLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF AD-
VISED OF THE POSSIBILITY OF SUCH DAMAGE.

Authors Name List

All product names mentioned herein are trademarks of their respective owners.

The following notices are required to satisfy the license terms of the software that
we have mentioned in this document:

e This product includes software developed by the University of California, Ber-
keley and its contributors.
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* This product includes software developed by Jonathan R. Stone for the Net-
BSD Project.

e This product includes software developed by the NetBSD Foundation, Inc.
and its contributors.

e This product includes software developed by Manuel Bouyer.

e This product includes software developed by Charles Hannum.

e This product includes software developed by Charles M. Hannum.

e This product includes software developed by Christopher G. Demetriou.
e This product includes software developed by TooLs GmbH.

e This product includes software developed by Terrence R. Lambert.

* This product includes software developed by Adam Glass and Charles Han-
num.

e This product includes software developed by Theo de Raadt.

* This product includes software developed by Jonathan Stone and Jason R.
Thorpe for the NetBSD Project.

e This product includes software developed by the University of California,
Lawrence Berkeley Laboratory and its contributors.

e This product includes software developed by Christos Zoulas.

e This product includes software developed by Christopher G. Demetriou for
the NetBSD Project.

* This product includes software developed by Paul Kranenburg.
e This product includes software developed by Adam Glass.
e This product includes software developed by Jonathan Stone.

e This product includes software developed by Jonathan Stone for the NetBSD
Project.

e This product includes software developed by Winning Strategies, Inc.

e This product includes software developed by Frank van der Linden for the
NetBSD Project.

* This product includes software developed for the NetBSD Project by Frank
van der Linden

* This product includes software developed for the NetBSD Project by Jason R.
Thorpe.

* The software was developed by the University of California, Berkeley.

* This product includes software developed by Chris Provenzano, the Universi-
ty of California, Berkeley, and contributors.

Samba(Ver 2.2.2-1.1)
Copyright © Andrew Tridgell 1994-1998
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This program is free software; you can redistribute it and/or modify it under the
terms of the GNU General Public License as published by the Free Software
Foundation; either version 2 of the License, or (at your option) any later version.
This program is distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or FIT-
NESS FOR A PARTICULAR PURPOSE. See the GNU General Public License
for more details. You should have received a copy of the GNU General Public
License along with this program; if not, write to the Free Software Foundation,
Inc., 675 Mass Ave, Cambridge, MA 02139, USA.

RSA BSAFE®

» This product includes RSA BSAFE® cryptographic or security protocol soft-
ware from RSA Security Inc.

* RSA s a registered trademark and BSAFE is a registered trademark of RSA
Security Inc.in the United States and/or other countries.

* RSA Security Inc. All rights reserved.
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